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| Operblick
Lage und Funktion der Teile

Informationen zur Verwendung und Funktion der einzelnen Komponenten finden Sie auf der angegebenen Seite.

Hauptgerat
10
1"
1. Biigel fiir Schulterriemen (9) 10. Motorzoomhebel (24)
2. Taste ASSIGN7/DIRECT MENU (36) 11. WLAN-Antenne

3N (N-Markierung)

¢ Halten Sie zum Herstellen einer
Funkverbindung zwischen Camcorder und
Smartphone ein NFC-kompatibles
Smartphone nahe an diese Markierung.
Niheres dazu finden Sie in der
Bedienungsanleitung zum Smartphone.

¢ NFC (Near Field Communication) ist ein
internationaler Standard fiir
Funkkommunikation iiber kurze Distanz.

4. Taste ASSIGNS/FOCUS MAG
5. Multi-Interface-Schuh (hinten)

S Multi
Y interface Shoe

Nihere Hinweise zu dem Zubehor, das an den
Multi-Interface-Schuh angeschlossen werden
kann, erhalten Sie bei der zustdndigen
Handelsvertretung.

6. Mikrofonfixierbiigel

7. Mikrofonhalter (31)

8. GPS-Antenne

9. Multi-Interface-Schuh (vorn)
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20
21
22
23

LN as

. Internes Mikrofon (31)
. Aufnahme-/Tally-Anzeige (vorn) (98)

Blinkt wenn die verbleibende Speicherkapazitit
auf dem Aufzeichnungsmedium oder die
Batterie zur Neige gehen.

Taste ASSIGN6

Taste FULL AUTO (23)
Schalter ND FILTER

ND FILTER-Modusschalter
Schalter FOCUS (25)

Taste ASSIGN3/VIDEO SIGNAL
MONITOR

. Taste ASSIGN1/ZEBRA

. Taste ASSIGN2/PEAKING
. Schalter INPUT1 (30)

12.
13.
14.
15.
16.
17.
18.
19.

Schalter CH1 (INT/EXT/MI SHOE) (30)
Regler AUDIO LEVEL (CH1) (30)
Regler AUDIO LEVEL (CH2) (30)
Schalter CH2 (INT/EXT/MI SHOE)
Schalter INPUT?2 (30)

Taste ASSIGN5S

Schalter SHUTTER

Taste ASSIGN4

. Taste FOCUS PUSH AUTO/HOLD (25)

. ND-Steuerregler

. Taste WB SET

. Gegenlichtblende mit Objektivschutz (18)
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1. Taste BATT RELEASE (16)

2. Befestigung fiir Akkusatz (16)

3. Multi/Micro USB-Anschluss (64)
4.USB 3.0 (HOST)-Anschluss (Typ A)
5. Anschluss SDI OUT (63)

6. Regler fiir Dioptrien-Einstellung (19)

7. Schalter ON/STANDBY (17)
I: ON
®: STANDBY

8. Ein-/Aus-Anzeige

9. USB2.0 (HOST)-Anschluss (Typ A)
(durch zukiinftiges Upgrade unterstiitzt)

10. Schalter IN/OUT (Eingangs-/

Ausgangswahl)

11. Luftauslass

¢ Die Bereiche um den Luftauslass konnen heifl
werden.
¢ Decken Sie den Luftauslass nicht ab.

12. Zoomhebel am Griff (24)
13. Aufnahmetaste am Griff
‘Wenn der Hebel auf die Position HOLD

eingestellt ist, funktioniert die Aufnahmetaste
am Griff nicht.

14. Anschluss AUDIO INPUT1 (30)
15. Anschluss AUDIO INPUT?2 (30)

16. Kabelhalter
Hier konnen Sie ein Mikrofonkabel o. A.
fixieren.

17. Griffband
18. Wabhlschalter (Tasten 4/%/«/+/SET)

910 11

1213 14 15

2221201918 17 16

19.
20.

21

22.

23.

24.
25.
26.

Aufnahmetaste (23)

Lufteinlass

¢ Decken Sie den Lufteinlass nicht ab.

. Anschluss REMOTE

Der Anschluss REMOTE dient zum Steuern
von Aufnahmestart/-stopp und anderen
Funktionen auf dem Videogerit und den daran
angeschlossenen Peripheriegeriten.

Kabelschelle

¢ Nur zum Sichern von Kabeln verwenden.

Anschluss fiir verkabeltes LAN (durch
zukiinftiges Upgrade unterstiitzt)

Anschluss TC IN/OUT
Anschluss HDMI OUT (63)

UTILITY SD/MS-Einschub/
Zugriffsanzeige

Fiir die Proxy-Aufnahme sowie zum Speichern
und Laden von Einstellungen (File-Funktion).
Wird von einem zukiinftigen Upgrade
(Software-Update) unterstiitzt.



5.
6.
1.

10.
1.
12.
13.
14.
15.
16.
17.

18.
19.

21 2019 1817 16 15 14 13 12

. Zoomring (25)
. Fokussierring (25)
. Schalter Full MF (25)

Sie konnen den manuellen Fokusmodus ein-/
ausschalten, indem Sie den Fokussierring vor-/
zuriickbewegen.

. Hebel fiir den Objektivdeckel (18)

Zum Offnen/SchlieBen des Objektivdeckels.
Biigel fiir Schulterriemen
Blendenring (27)

Buchse ¢} (Kopfhorer)
Fiir Kopfhorer mit Stereoministecker.

. Aufnahme-/Tally-Anzeige (hinten) (98)

Blinkt wenn die verbleibende Speicherkapazitit
auf dem Aufzeichnungsmedium oder die
Batterie zur Neige gehen.

. Taste SLOT SELECT

Speicherkarteneinschub A
Zugriffsanzeige fiir Speicherkarte A (20)
Speicherkarteneinschub B
Zugriffsanzeige fiir Speicherkarte B (20)
Anschluss DC IN

Taste CANCEL/BACK (69)

Regler SEL/SET (69)

Taste MENU (69)

An der Taste befindet sich ein fiihlbarer
Streifen, damit sie leichter gefunden werden
kann.

Schalter WHT BAL (29)
Schalter GAIN (27)

20. Taste IRIS PUSH AUTO
21. Schalter IRIS (27)

So bringen Sie einen Schulterriemen an
Bringen Sie einen Schulterriemen an den Biigeln
fiir den Schulterriemen an.




0O N O Ol & W N =

e S N
SO Ol s W N = O o

17.
18.
19.

7 8 91011

1T 0D 0|0

2 STATIIS _PREV__QTOPCAM  NEXT DISPLAY

DURATION
CANCEL  TCU-BIT

THUMBNAIL  F RV PLAY;/AUSE F ['WD [ LCD |IRIGHT

—0 @ 0 & G-

VOLUME

19 18

. Taste THUMBNAIL (56)
. Taste STOP/CAM (57)

. Taste STATUS CHECK (13)
. Taste PREV (57)

. Tasten 4/¥/«/%/SET (69)
. Taste MENU (69)

. Taste F REV (57)

. Taste PLAY/PAUSE (57)
. Taste F FWD (57)

. Taste NEXT (57)

. Taste LCD BRIGHT (19)
. Taste DISPLAY (11)

. LCD-Bildschirm (19)

. Sucher (19)

. GroBe Augenmuschel

. Lufteinlass

* Decken Sie den Lufteinlass nicht ab.

Tasten VOLUME (26)

12

17

Taste DURATION/TC/U-BIT (33)

Taste CANCEL (69)

Unterseite

1. Offnungen fiir Stativgewinde (1/4 Zoll,
3/8 Zoll)
Kompatibel mit 1/4-20UNC-Schrauben und mit
3/8-16UNC-Schrauben.
Bringen Sie hier ein Stativ an (optional
erhiltlich, Lange der Schraube maximal
5,5 mm).



Bildschirmanzeige

LCD-/Sucherbildschirm

Wiihrend der Aufnahme, im Aufnahmebereitschaftsmodus und bei der Wiedergabe werden
Statusinformationen und Einstellungen des Camcorders auf dem LCD-/Sucherbildschirm eingeblendet.
Die Informationen konnen tiber die Taste DISPLAY ein- bzw. ausgeblendet werden.

Die Informationen konnen auch einzeln ein- und ausgeblendet werden (Seite 87).

Bildschirminformationen wéahrend der Aufnahme

15 16 171819 20 21 22 23
1. Anzeige des Netzwerkstatus (Seite 12) 6. Anzeige fiir den Fokussiermodus

Hier wird der Status der Netzwerkverbindung (Seite 34)

als Symbol angezeigt. Full ME-Modus Eal ME
. Aufnahmemodus/Betriebsstatus fiir MFE-Modus MIE

Einschub A/B AF-Modus AR

O®Rec Aufzeichnung lduft -
Gesichtserk -AF ®,
Stby Aufnahmebereitschaft esie sers enr:)ur:g (AF/@//@/E‘)
ymbo
,.Gesichtserkennung*

. Schiirfentiefenanzeige

. Bildfrequenz fiir Aufzeichnung mit
Zeitlupe/Zeitraffer

. Verbleibende Akkukapazitit/DC IN-
Spannung

Symbol ,,Face Only AF*  Qply

Symbol ,,Registriertes &%
Gesicht*

Symbol ,,Face Only AF 1]

«a)

Autofokus angehalten

a) Wird angezeigt, wenn kein Gesicht registriert
und keine Gesichter erkannt wurden und wenn
ein Gesicht registriert, aber nicht erkannt wurde.

7. Zoomposition

Hier wird die Zoomposition im Bereich

zwischen 0 (Weitwinkel) und 99 (Tele)

angezeigt.

8. GPS-Status



9.

10.

11

14

15.
16.
17.

18
19

22

25.
26.
21.

28.
29.

30.
31.

Anzeige fiir den Bildstabilisierungsmodus
(SteadyShot)

Rec Control-Anzeige fiir SDI-Ausgang/
HDMI-Ausgang

Wird angezeigt, wenn sowohl Display On/Off
>SDI/HDMI Rec Control im LCD/VF-Menii
und SDI/HDMI Rec Control >Setting im Video-
Menii auf On gesetzt sind.

. Anzeige fiir digitales Tele (Seite 97)
12.
13.
. WeiBabgleich-Modus

Fokussierhilfe

Restkapazitit des Speichermediums

ATW
ATW Hold
W:P

W:A

W:B

Automatik

Unterbrechen der Automatik

Voreinstellungsmodus
Memory A-Modus
Memory B-Modus

Timecode (Seite 33)
Anzeige fiir den ND-Filter (Seite 28)

Anzeige fiir Szenendateien (Seite 42)

. Blendenposition

. Warnanzeige zum Videopegel
20.
21.

Verstirkungswert (Seite 27)

Blendenmodus/Belichtungszeit

. AE-Modus/AE-Pegel (Seite 28)
23.
24.

Audiopegel-Messer

Anzeige VIDEO SIGNAL MONITOR
(Wellenformmonitor/Vektorskop/
Histogramm)

Name des Clips
Gamma-Anzeigeassistent (Seite 41)
Gammawert (Seite 80)

Zeigt die Gamma-FEinstellung an.
Proxy-Status

Aufzeichnungsformat (Codec) (Seite 96)
Hier wird das Format angezeigt, in dem auf eine
Speicherkarte aufgezeichnet wird.
Systemfrequenz und Abtastverfahren
Aufzeichnungsformat (BildgroBe)

(Seite 96)

Hier wird die Bildgroe angezeigt, mit der auf
eine Speicherkarte aufgezeichnet wird.

Auf dem Wiedergabebildschirm angezeigte
Informationen

Wihrend der Wiedergabe werden folgende
Informationen auf dem Bild eingeblendet:

10.
1.
12.
13.
Sym

I |
10 11 1213

. Anzeige des Netzwerkstatus

. Clip-Nummer/Gesamtzahl der Clips
. Wiedergabemodus

. Wiedergabeformat (Bildfrequenz)

. Wiedergabeformat (BildgroBe)

. Verbleibende Akkukapazitit/DC IN-

Spannung

. Wiedergabeformat (Codec)
. Medium

Links neben einer schreibgeschiitzten
Speicherkarte wird die Markierung (3}
angezeigt.

. Zeitdaten

Die Zeitdaten werden angezeigt, wenn Display
On/Off >Timecode im LCD/VF-Menii auf On
gesetzt ist und die Taste DISPLAY gedriickt
wird.

Name des Clips
Gamma-Anzeigeassistent
Audiopegel-Messer
Gammawert

bole fiir die Netzwerkverbindung

Net:
dus

zwerkmo- Verbin-
dungsstatus

Symbol

Zugangspunkt-

mod

Betrieb als
Zugangspunkt

us

Fehler beim
Betrieb als
Zugangspunkt

AR




Netzwerkmo- Verbin-
dungsstatus

dus

Symbol

Stationsmodus

WLAN
verbunden

A
> I

WLAN-
Signalstirke (4
Stufen)

WLAN getrennt .
(auch wihrend
Einrichtung)

WLAN-Verbin-
dungsfehler

>3

Statushildschirm

Sie konnen die Einstellungen und den Status des
Camcorders auf dem Statusbildschirm

iiberpriifen.

Bedienung des Statushildschirms

So blenden Sie den Statusbildschirm ein:
* Driicken Sie die Taste STATUS CHECK.

So wechseln Sie den Statusbildschirm:
¢ Drehen Sie den Regler SEL/SET oder driicken

Sie die Taste #/¥.

So blenden Sie den Statusbildschirm aus:
* Driicken Sie die Taste STATUS CHECK.

Bildschirm ,,Camera Status®
Hier werden Bildqualitit, Zoom-Einstellungen

und Status angezeigt.

White Switch<B> Einstellwert des
WeiBabgleich-Speichers B

White Switch<A> Einstellwert des
WeiBabgleich-Speichers A

White Switch<P> Einstellung von Preset White

ND<Preset> Einstellung Preset! bis 3 fiir
ND Filter

Zebral Einstellung Zebral On/Off
und Pegel

Zebra2 Einstellung Zebra2 On/Off
und Pegel

Gamma Gamma-Kategorie und -kurve

Gain Switch

Einstellung von Gain<L>,
Gain<M>, Gain<H>

Handle Zoom Speed

Einstellung von Handle
Zoom

Scene File

Aktuelle Szenendatei und
Datei-ID

Bildschirm ,,Audio Status“

Hier werden der Eingangspegel, die
Audiopegelanzeige und der Windfilter fiir die
einzelnen Kanile angezeigt.

CHI level meter

CHI Pegelanzeige

CHI Input Source

CHI Eingangsquelle

CH1 Ref./Sens.

CH1 Referenzeingangspegel

CH1 Wind Filter

CHI1 Mikrofon-
Windfiltereinstellung

CH2 level meter CH2 Pegelanzeige

CH2 Input Source CH2 Eingangsquelle

CH2 Ref./Sens. CH2 Referenzeingangspegel
CH2 Wind Filter CH2 Mikrofon-

Windfiltereinstellung

CH3 level meter

CH3 Pegelanzeige

CH3 Input Source

CH3 Eingangsquelle

CH3 Ref./Sens.

CH3 Referenzeingangspegel

CH3 Wind Filter

CH3 Mikrofon-
Windfiltereinstellung

CH4 level meter CH4 Pegelanzeige

CH4 Input Source CH4 Eingangsquelle

CH4 Ref./Sens. CH4 Referenzeingangspegel

CH4 Wind Filter CH4 Mikrofon-
Windfiltereinstellung

HDMI Output CH Audiokanal-
Kombinationseinstellung fiir
HDMI-Ausgang

Analog Output CH Audiokanal-
Kombinationseinstellung fiir
Analogausgang

Monitor CH Monitorkanal

Headphone Out Kopfhorer-Ausgabetyp

Bildschirm ,, System Status“
Hier werden die Einstellungen fiir das
Videosignal angezeigt.

Frequency/Scan Systemfrequenz und
Abtastverfahren

Codec Codec-Einstellung

Simul Rec 2-Einschiibe-
Simultanaufzeichnung
aktiviert/deaktiviert (,,On*/
L, Off*)

Title Prefix Titelprifix des Clipnamens

Picture Size

Aufzeichnungsformat
BildgroBe

Rec Function

Aktivierte Aufnahmemodi
und Einstellungen

Clip Continuous Rec

Kontinuierliche
Clipaufnahme aktiviert bzw.
deaktiviert (,,On*/,,0ff*)




Picture Cache Rec Bildpuffer-Funktion aktiviert
bzw. deaktiviert (,,On‘/,,Off")

und Einstellung

Number Numerische Endung des
Clipnamens

Shooting Mode Einstellung des
Aufnahmemodus

Proxy Rec Proxy-Aufnahme aktiviert

bzw. deaktiviert (,On*/,,Off*)
und Einstellung

Bildschirm ,,Video Output Status“
Zeigt die Einstellungen fiir SDI, HDMI und
Videoausgabe an.

SDI GroBe der Bildausgabe
Rec Control-Status
Ausgabe ein/aus

HDMI GroBe der Bildausgabe
Rec Control-Status
Ausgabe ein/aus

Gamma Gammawert

Color Gamut Farbraumeinstellung

Gamma Display Assist Einstellung des Gamma-

Anzeigeassistenten

Bildschirm ,Assignable Button Status*“
Hier werden die Funktionen angezeigt, die den
belegbaren Tasten zugewiesen sind.

1 Der Taste ASSIGN1
zugewiesene Funktion
2 Der Taste ASSIGN2
zugewiesene Funktion
3 Der Taste ASSIGN3
zugewiesene Funktion
4 Der Taste ASSIGN4
zugewiesene Funktion
5 Der Taste ASSIGNS
zugewiesene Funktion
6 Der Taste ASSIGN6
zugewiesene Funktion
7 Der Taste ASSIGN7
zugewiesene Funktion
8 Der Taste ASSIGN8

zugewiesene Funktion

Bildschirm ,Battery Status“
Zeigt Informationen zum Akku und zur
Stromanschluss an DC IN an.

Detected Battery Akkutyp

Remaining Verbleibende Kapazitit (%)
Charge Count Anzahl der Ladevorginge
Capacity Verbleibende Kapazitit (Ah)

Voltage

Spannung (V)

Manufacture Date

Fertigungsdatum des Akkus

Video Light Remaining

Restladung des Akkus fiir die
Videoleuchte

Power Source

Stromquelle

Supplied Voltage

Spannung der
angeschlossenen Stromquelle

Bildschirm ,,Media Status“

Hier werden der restliche Speicherplatz, die
verfiigbare Aufnahmedauer und die geschitzte
Lebensdauer des Aufnahmemediums
(Speicherkarte A/Speicherkarte B) sowie der
UTILITY-Speicherkarte angezeigt.

Informationen zu
Speichermedium A

Zeigt ein Mediensymbol an,
wenn sich in Einschub A ein
Aufzeichnungsmedium
befindet.

Schutz von
Speichermedium A

Zeigt ein Schloss-Symbol an,
wenn das
Aufzeichnungsmedium in
Einschub A geschiitzt ist.

Restkapazititsanzeige
fiir Speichermedium A

Zeigt die Restkapazitit des
Aufzeichnungsmediums in
Einschub A in Form eines
Prozentsatzes oder Balkens
an.

Restaufnahmezeit auf
Speichermedium A

Zeigt die unter den aktuellen
Aufnahmebedingungen
geschitzte Restaufnahmezeit
des Aufzeichnungsmediums
in Einschub A in Minuten an.

Informationen zu
Speichermedium B

Zeigt ein Mediensymbol an,
wenn sich in Einschub B ein
Aufzeichnungsmedium
befindet.

Schutz von
Speichermedium B

Zeigt ein Schloss-Symbol an,
wenn das
Aufzeichnungsmedium in
Einschub B geschiitzt ist.

Restkapazititsanzeige
fiir Speichermedium B

Zeigt die Restkapazitit des
Aufzeichnungsmediums in
Einschub B in Form eines
Prozentsatzes oder Balkens
an.

Restaufnahmezeit auf
Speichermedium B

Zeigt die unter den aktuellen
Aufnahmebedingungen
geschitzte Restaufnahmezeit
des Aufzeichnungsmediums
in Einschub B in Minuten an.

Information iiber das
UTILITY-Medium

Zeigt das Mediensymbol an,
wenn im UTILITY SD/MS-
Einschub ein Medium
eingesetzt ist.




Schutz des UTILITY-  Zeigt ein Schloss-Symbol an,

Mediums wenn das Medium im
UTILITY SD/MS-Einschub
geschiitzt ist.

Restkapazititsanzeige  Zeigt die Restkapazitit des

des UTILITY-Mediums Mediums im UTILITY SD/
MS-Einschub in Form eines
Prozentsatzes oder Balkens
an.

Restkapazitit des
UTILITY-Mediums

Zeigt die geschitzte
Restaufnahmezeit des
Aufzeichnungsmediums im
UTILITY SD/MS-Einschub
in Minuten an. Alternativ
wird die verbleibende
Kapazitit in GB angezeigt.

Bildschirm ,Rec Button Settings Status*
Hier wird der Einstellstatus der Aufnahmetaste
und der Aufnahmetaste am Griff angezeigt.

Hier wird der Zieleinschub
fiir Aufnahme mittels der
Aufnahmetaste angezeigt.

Rec Button

Hier wird der Zieleinschub
fiir Aufnahme mittels der
Aufnahmetaste am Griff
angezeigt.

Handle Rec Button

Bildschirm ,,GPS Status“
Hier werden der GPS-Positionierungsstatus und
Informationen angezeigt.

GPS GPS-Signalpositionierungs-

status

Dilution of Precision ~ Genauigkeit der

Positionsdaten

Latitude Breitengrad

Longitude Lingengrad

Altitude Hohe

Positioning date and Datum und Uhrzeit der

time Positionierung

Current date and time ~ Aktuelle Zeit und aktuelles
Datum

Time Zone Zeitzoneneinstellung

Bildschirm ,,Network Status®
Hier wird der Status der Netzwerkverbindung
angezeigt.

Wireless LAN WLAN:-Einstellungen,

Verbindungsstatus

Wireless LAN-Einstellungen

Setting- Status-
Anzeige Anzeige

Beschreibung

Off ---

WLAN-
Einstellung ist
deaktiviert.

Access Point Non Active

Mode

Kein Betrieb als
Zugangspunkt.
Wird bei Fehler an
WLAN-Modul
angezeigt.

Active

Betrieb als
Zugangspunkt.

Station Mode ~ Non Active

Kein Betrieb im
Stationsmodus.
‘Wird bei Fehler an
WLAN-Modul
angezeigt.

Searching

Verbindungsaufbau
zum zuletzt
verbundenen
Netzwerk wird
versucht
(Zugangspunkt).

Disconnected

Nicht mit einem
Netzwerk
verbunden
(Zugangspunkt).
Wird auch
angezeigt, wenn
per DHCP keine
IP-Adresse
zugewiesen wurde.

<SSID>

Verbunden mitdem
Netzwerk <SSID>
(Zugangspunkt).




Vorbereitung

Stromversorgung

Der Camcorder kann mit einem Akku oder mit
einem Netzteil iiber das Stromnetz versorgt
werden.

Wenn ein Netzteil angeschlossen ist, erfolgt die
Stromversorgung dariiber, selbst wenn ein Akku
angebracht ist.

Verwenden Sie zur Sicherheit nur Akkus und
Netzteile von Sony, die unten aufgelistet sind.

Lithium-lonen-Akkusitze
BP-U30 (mitgeliefert)
BP-U60

BP-U60T

BP-U90

Netzteile/Ladegerdte
BC-U1A (mitgeliefert)
BC-U2A

Akkus diirfen keinesfalls iibermaBiger
Wirmeeinwirkung ausgesetzt werden, wie z. B.
Sonneneinstrahlung, Feuer o. 4.

« Bei Betrieb iiber das Stromnetz ist das mitgelieferte
Netzteil zu verwenden.

Verwenden eines Akkus

So setzen Sie den Akku ein: Schieben Sie den
Akku bis zum Anschlag in den Einschub

(Seite 8), und schieben Sie ihn dann nach unten,
bis er einrastet.

Halten Sie zum Entnehmen des Akkus die Taste
BATT RELEASE (Seite 8) gedriickt, schieben
Sie den Akku nach oben, und nehmen Sie ihn
dann aus dem Einschub.

Laden Sie den Akku vor der Verwendung mit dem
Ladegeriit BC-U1A (mitgeliefert) oder dem Ladegerit
BC-U2A.

¢ Ein erwiarmter Akku (direkt nach dem Gebrauch) ldsst
sich moglicherweise nicht vollstindig aufladen.

Der Akku BP-U90 mit hoher Kapazitit ist gro und
ragt aus dem Camcorder heraus, wenn er angebracht
ist. Der BP-U90 eignet sich besonders bei
Verwendung des Camcorders fiir langere
Aufnahmezeiten auf einem Stativ.

Uberpriifen der Restkapazitat

Wenn die Aufnahme oder Wiedergabe iiber den
Akku erfolgt, werden ein Symbol fiir die aktuelle
Akkuladung und die restliche Nutzungsdauer auf
dem LCD-/Sucherbildschirm angezeigt

(Seite 11).

Symbol Verbleibende Kapazitit

100% bis 91%

90% bis 71%

70% bis 51%

50% bis 31%

30% bis 11%

BNy

10% bis 0%

Die vom Camcorder in Minuten angezeigte
Restnutzungsdauer ist ein errechneter Wert und
basiert auf der Annahme, dass der Akkubetrieb
mit der aktuellen Leistungsaufnahme fortgesetzt
wird.

Wenn die Akkuladung abnimmt

Wenn die Akkuladung wihrend des Betriebs
unter einen bestimmten Grenzwert fillt (Low
Battery-Zustand), wird eine Meldung angezeigt,
die Aufnahme-/Tally-Anzeige beginnt zu
blinken, und es ertont ein Warnton.

Wenn die Akkuladung auf einen Wert fillt, bei
dem der Betrieb nicht fortgesetzt werden kann
(Battery Empty-Zustand), wird eine
entsprechende Meldung angezeigt.

Der Akku muss dann durch einen aufgeladenen
Akku ersetzt werden.

Andern der Grenzwerte fiir Warnmeldungen

Der Wert fiir Low Battery liegt standardmiBig bei
10% der vollen Akkuladung, und der Wert fiir
Battery Empty liegt bei 3%. Diese
Warneinstellungen konnen mit Battery Alarm
(Seite 98) im System-Menii gedndert werden.



Verwendung von Wechselstrom

Beim Anschluss des Camcorders an das
Stromnetz brauchen Sie sich keine Gedanken
dariiber zu machen, den Akku aufzuladen.

Anschluss I )
DCIN é Netzteilstecker

1 SchlieBen Sie das Netzkabel an das Netzteil an.

2 SchlieBen Sie das Netzteil an den Anschluss DC IN
am Camcorder an.

3 SchlieBen Sie das Netzkabel an eine Netzsteckdose
an.

Netzteile

« Netzteile diirfen nicht auf engem Raum
angeschlossen werden, etwa zwischen einer
Wand und einem Maobelstiick.

» Falls wihrend des Betriebs ein Problem auftritt,
das Netzkabel sofort aus der Steckdose ziehen.

 Schlieen Sie den Stecker des Netzteils nicht
mit einem Metallgegenstand kurz, da es sonst
zu einer Fehlfunktion kommt.

¢ Sie konnen den Camcorder nicht laden, indem
Sie ihn an das Netzteil anschlieBen.

Ein-/Ausschalten des Camcorders

Stellen Sie den Schalter ON/STANDBY (Seite 8)
zum Einschalten in die Position ON (l). Stellen
Sie den Schalter ON/STANDBY zum
Ausschalten in die Position STANDBY ().

* Auch wenn sich der Schalter ON/STANDBY in der
Position STANDBY befindet, nimmt das Gerét
weiterhin Strom auf. Entfernen Sie den Akku, wenn
Sie den Camcorder lidngere Zeit nicht verwenden.

* Entfernen Sie den Akku oder trennen Sie die
Spannungsversorgung iiber DC IN, nachdem die Ein-/
Aus-Anzeige erloschen ist, wenn der Netzschalter in
die Position STANDBY gestellt wurde. Wenn die
Stromversorgung getrennt wird, wihrend sich der
Schalter in der Stellung ON befindet, kénnen
Fehlfunktionen des Camcorders oder der
Speicherkarten auftreten.



Einstellen der Uhr

Wenn Sie den Camcorder zum ersten Mal
einschalten, nachdem Sie ihn neu gekauft haben,
oder sich die Pufferbatterie vollig entladen hat,
erscheint die Anzeige mit Anfangseinstellungen
auf dem Sucher- und dem LCD-Bildschirm.

In diesem Bildschirm konnen das Datum und die
Uhrzeit der internen Uhr eingestellt werden.

Time Zone

Der Wert gibt den Zeitunterschied zur UTC
(Coordinated Universal Time) an. Wihlen Sie
hier die gewiinschte Einstellung.

Einstellen von Datum und Uhrzeit

Bewegen Sie den Cursor mithilfe der Tasten #/%/
</ (Seite 8) oder dem Regler SEL/SET

(Seite 9),und driicken Sie die Taste SET oder den
Regler SEL/SET, um das jeweilige Element
festzulegen.

Bewegen Sie den Cursor dann auf [Finish], und
driicken Sie die Taste SET oder den Regler SEL/
SET, um den Einstellungsbildschirm zu schliefen
und die Einstellung der Uhr abzuschlieSen.

Sobald der Einstellungsbildschirm geschlossen
ist, konnen Sie mit Clock Set (Seite 98) im
System-Menii die Einstellungen fiir Datum,
Uhrzeit und Zeitzone #ndern.

* Wenn die Uhrzeit verloren geht, weil sich die
Pufferbatterie nach lingerer Trennung vom Stromnetz
(kein Akku und keine Stromversorgung iiber DC IN)
nach komplett entladen hat, wird der Bildschirm
,Initial Settings* beim néchsten Einschalten des
Camcorders angezeigt.

Wihrend der Bildschirm ,Initial Settings* angezeigt
wird, kann auBier dem Ausschalten des Camcorders
kein anderer Vorgang ausgefiihrt werden, bis die
Einstellungen in diesem Bildschirm abgeschlossen
sind.

Falls Sie den Camcorder etwa drei Monate lang nicht
verwenden, entlddt sich der eingebaute Akku.
Daraufhin gehen die Datums- und Zeiteinstellungen
aus dem Speicher verloren. Laden Sie in diesem Fall
den Akku auf, und stellen Sie dann Datum und Uhrzeit
wieder ein (Seite 103).

AnschlieBen von Geraten

Anbringen der Gegenlichtblende

Taste PUSH (Entriegelung der Gegenlichtblende)

Richten Sie die Markierungen an der
Gegenlichtblende und am Camcorder
aneinander aus und drehen Sie die
Gegenlichtblende in Pfeilrichtung (@, bis sie
einrastet.

Entfernen der Gegenlichtblende

Halten Sie die Taste PUSH (Entriegelung der
Gegenlichtblende) gedriickt und drehen Sie die
Gegenlichtblende entgegen der in der Abbildung
gezeigten Pfeilrichtung.

* Nehmen Sie die Gegenlichtblende zum Anbringen/
Abnehmen eines Polarisationsfilters oder Schutzfilters
mit ¢82 mm ab.

Anbringen der groBien
Augenmuschel

Dehnen Sie die grole Augenmuschel leicht und
passen Sie sie iiber die Nut am Sucher ein.

GroBe Augenmuschel
(mitgeliefert)



Einstellen der
Bildschirme

Einstellen des LCD-Bildschirms

Klappen Sie den LCD-Bildschirm um 180 Grad
auf () und drehen Sie ihn in den fiir die
Aufnahme oder Wiedergabe optimalen Winkel

@).

® Um 180 Grad
aufklappen

® 90 Grad
(max.) ‘

® 180 Grad
(max.)

Der Winkel kann so angepasst werden, dass der
Sucher auf das Motiv ausgerichtet ist. Das Bild
wird auf dem LCD-Bildschirm spiegelverkehrt
angezeigt, jedoch normal aufgenommen.

Einstellen der Hintergrundbeleuchtung

Schalten Sie die Helligkeit der
Hintergrundbeleuchtung mithilfe der Taste LCD
BRIGHT (Seite 10).

Anpassen der Helligkeit

Passen Sie die Helligkeit mithilfe von LCD
Setting >Brightness (Seite 85) im LCD/VF-Menii
an. Anderungen der Helligkeit wirken sich nicht
auf aufgezeichnete Bilder aus.

Einstellen des Suchers

Bei Verwendung des Suchers schauen Sie bei
geschlossenem LCD-Bildschirm durch den
Sucher.

Wenn die Anzeige auf dem Sucherbildschirm
nicht scharf ist, passen Sie diese mit dem
Dioptrienausgleichsregler unter dem Sucher an.

Regler fur Dioptrien-
Einstellung

Verschieben Sie den Regler,
bis das Bild scharf ist.

Anpassen der Helligkeit

Passen Sie die Helligkeit mithilfe von VF Setting
>Brightness (Seite 85) im LCD/VF-Menii an.

Anpassen der Helligkeit von LCD-/
Sucherbildschirm mit frei
belegharer Taste

Zum Einstellen der Helligkeit des LCD-/
Sucherbildschirms konnen Sie einen Pegelbalken
einblenden, indem Sie zuvor die Funktion LCD/
VF Adjust einer frei belegbaren Taste zuweisen
(Seite 36) und dann diese Taste driicken.

1 Driicken Sie die mit LCD/VF Adjust
belegte Taste, um einen Pegelbalken
zum Einstellen der Helligkeit
einzublenden.

Bei jeder Betitigung der Taste wechselt die
Anzeige zwischen Pegelbalken fiir den LCD-
Bildschirm — Pegelbalken fiir den Sucher
— keine Anzeige.

2 Passen Sie den Pegel mithilfe der Tasten
4/¥%/«/» oder dem Regler SEL/SET an
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Der Pegelbalken wird ausgeblendet.

Um den Pegelbalken auszublenden, driicken
Sie die mit LCD/VF Adjust belegte Taste
oder nehmen drei Sekunden lang keine
Bedienung vor.



Verwendung von
Speicherkarten

Bei diesem Camcorder konnen Audio- und
Videosignale auf in die Speicherkarteneinschiibe
eingesetzte Speicherkarten (gesondert erhiltlich)
aufgezeichnet werden.

Speicherkarten

Unterstiitzte Speicherkarten

Die folgenden Speicherkarten werden unterstiitzt.

Einzelheiten zu Aufnahmemedien und kompatiblen
Formaten siehe Seite 107.

SDXC-Speicherkarten (Klasse 10)

Einsetzen von Speicherkarten

1 Oftnen Sie die Abdeckung des
Karteneinschubblocks.

2 Schieben Sie die Speicherkarte mit der
Beschriftung nach rechts weisend
hinein.

Die Zugriffsanzeige (Seite 9) leuchtet
zunéchst rot und wechselt zu griin, sobald die
Speicherkarte betriebsbereit ist.

3 SchlieBen Sie die Abdeckung.

« Die Speicherkarte, der Speicherkartenbereich und die
Bilddaten auf der Speicherkarte konnen beschidigt
werden, wenn die Karte falsch herum eingesetzt wird.

Entnehmen einer Speicherkarte

1 Oftnen Sie die Abdeckung des
Karteneinschubblocks und driicken Sie
die Speicherkarte sanft hinein.

Die Speicherkarte springt heraus.
Wiihrend der Aufzeichnung wird diese
dadurch gestoppt.

2 Entnehmen Sie die Speicherkarte.
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Die Integritit der Daten auf der Karte kann nicht
garantiert werden, wenn withrend des Zugriffs auf die
Speicherkarte der Camcorder ausgeschaltet oder die
Karte entnommen wird. Moglicherweise gehen alle
Daten auf der Karte verloren. Stellen Sie stets sicher,
dass die Zugriffsanzeige entweder griin leuchtet oder
erloschen ist, bevor Sie den Camcorder ausschalten
oder die Speicherkarte entfernen.

Eine nach dem Aufnehmen aus dem Camcorder
herausgenommene Speicherkarte kann heif} sein. Dies
ist keine Fehlfunktion.

Wechseln zwischen
Speicherkarten

Wenn sich sowohl in Einschub A als auch in
Einschub B eine Speicherkarte befindet, konnen
Sie durch Driicken der Taste SLOT SELECT
(Seite 9) die zum Aufzeichnen verwendete Karte
auswiihlen.

Ist die Speicherkapazitiit einer Karte wihrend der
Aufnahme erschopft, wechselt der Camcorder
automatisch zur anderen Karte.

Die Taste SLOT SELECT ist wihrend der Wiedergabe
deaktiviert. Die Speicherkarten werden in dem Fall
auch durch Driicken der Taste nicht gewechselt. Die
Taste ist aktiviert, wihrend die Miniaturbildanzeige
(Seite 56) angezeigt wird.

Formatieren (Initialisieren) einer
Speicherkarte

Speicherkarten miissen bei der ersten
Verwendung im Camcorder zunichst formatiert
werden.

Speicherkarten, die im Camcorder verwendet
werden sollen, sind mit der Formatierfunktion des
Camcorders zu formatieren.

Wenn beim Einsetzen einer Speicherkarte in den
Camcorder eine Meldung angezeigt wird, muss
die Speicherkarte formatiert werden.

Falls eine Speicherkarte eingesetzt wird, die mit
einem anderen, von diesem Camcorder nicht
unterstiitzten Format formatiert wurde, erscheint
die Meldung ,,Unsupported File System* auf dem
LCD-/Sucherbildschirm.

Formatieren Sie das Medium wie nachfolgend
beschrieben.



Formatieren

Wihlen Sie iiber Format Media (Seite 92)
im Media-Menii die Option Media(A)
(Einschub A) oder Media(B) (Einschub B)
und dann Execute aus.

Wiihrend der Formatierung wird eine Meldung
angezeigt, und die Zugriffsanzeige leuchtet rot.
Wenn die Formatierung beendet ist, wird eine
Abschlussmeldung angezeigt.

« Beim Formatieren einer Speicherkarte gehen alle
Daten auf der Karte verloren, einschlieSlich
geschiitzter Videos. Die Daten konnen nicht
wiederhergestellt werden.

Verwenden eines im Camcorder formatierten

Mediums im Einschub eines anderen Geréts

Erstellen Sie ein Backup des Mediums und

formatieren Sie es dann mit dem anderen Geriit.

Uberpriifen der verbleibenden
Aufzeichnungszeit

Wiihrend der Aufnahme (oder im
Aufnahmebereitschaftsmodus) wird der restliche
Speicherplatz auf den in die Karteneinschiibe
eingesetzten Speicherkarten als Status/restlicher
Speicherplatz des Mediums in Einschub A/B auf
dem LCD-/Sucherbildschirm angezeigt

(Seite 11).

Die verbleibende Aufnahmezeit errechnet sich
aus der Restkapazitit auf den Medien in den
beiden Einschiiben und dem aktuellen
Videoformat (Aufzeichnungs-Bitrate) und wird
in Minuten angezeigt.

* Bei einer schreibgeschiitzten Speicherkarte wird das
Symbol @ angezeigt.

Ersetzen einer Speicherkarte

* Wenn die verfiigbare Aufnahmedauer auf
beiden Karten zusammen auf unter 5 Minuten
sinkt, wird die Warnmeldung ,,Media Near
Full* angezeigt, die Aufnahme-/Tally-Anzeige
blinkt und ein Signalton wird an die Kopfhorer
ausgegeben.

Ersetzen Sie die Medien durch Speicherkarten
mit ausreichend freiem Speicherplatz.

* Wenn Sie die Aufnahme fortsetzen, bis die
restliche Aufnahmedauer auf null sinkt, wird
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stattdessen die Meldung ,,Media Full“
angezeigt und die Aufnahme stoppt.

« Auf einer Speicherkarte konnen bis zu ca. 600 Clips
gespeichert werden.
Falls die Anzahl aufgezeichneter Clips den Grenzwert
erreicht, wird eine Anzeige eingeblendet, die dariiber
informiert, dass die Hochstanzahl Clips erreicht
wurde.

Wiederherstellen einer
Speicherkarte

Falls an einer Speicherkarte ein Fehler auftritt,
muss sie vor erneutem Gebrauch
wiederhergestellt werden.

Wenn Sie eine Speicherkarte laden, die
wiederhergestellt werden muss, wird auf dem
LCD-/Sucherbildschirm eine Abfrage angezeigt,
ob Sie sie wiederherstellen mochten.

Wiederherstellen einer Karte

Wiihlen Sie Execute mithilfe der Tasten 4/
¥/«/» oder dem Regler SEL/SET aus und
driicken Sie die Taste SET oder den Regler
SEL/SET.

Wiihrend der Formatierung werden eine Meldung
und ein Fortschrittsstatus (%) angezeigt, und die
Zugriffsanzeige leuchtet rot.

Wenn die Wiederherstellung beendet ist, wird
eine Abschlussmeldung angezeigt.

Wenn die Wiederherstellung fehlschldgt

* Mit Schreibschutz versehene Speicherkarten
und Speicherkarten, an denen ein
Speicherfehler aufgetreten ist, konnen nicht
wiederhergestellt werden. Bei derartigen
Karten wird eine Warnmeldung angezeigt.
Gehen Sie nach den Anweisungen der Meldung
vor und entfernen Sie den Schreibschutz der
Karte oder tauschen Sie sie gegen eine andere
aus.

Speicherkarten, an denen Speicherfehler
aufgetreten sind, konnen durch wiederholte
Formatierung ggf. wieder funktionsfihig
werden.

In einigen Fillen konnen einige Clips
wiederhergestellt werden, andere ggf. jedoch
nicht. Die wiederhergestellten Clips konnen
normal wiedergegeben werden.



« Falls auch nach wiederholten

Wiederherstellungsversuchen die Meldung
,-,Could not Restore Some Clips* angezeigt
wird, kann die Speicherkarte ggf. wie
nachfolgend beschrieben wiederhergestellt
werden.

1 Verwenden Sie die Kopierfunktion (Seite 60) des
Camcorders, um die erforderlichen Clips auf eine
andere Speicherkarte zu kopieren.

2 Formatieren Sie die unbrauchbare Speicherkarte im
Camcorder.

3 Kopieren Sie die Clips zuriick auf die soeben
formatierte Speicherkarte.

Verwenden Sie zur Wiederherstellung von Medien,
die mit diesem Camcorder aufgezeichnet wurden, auf
jeden Fall diesen Camcorder.

Medien, die mit einem anderen als diesem Camcorder
oder mit einem Camcorder mit einer anderen Version
aufgezeichnet wurden (auch wenn es das gleiche
Modell ist), konnen mit diesem Camcorder nicht
wiederhergestellt werden.

Clips mit einer Dauer von weniger als einer Minute
sind moglicherweise nicht wiederherstellbar.
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Aufzeichnung

Basis-Funktionen

Aufzeichnung

Der grundlegende Aufnahmebetrieb lduft
folgendermaflen ab.

1 Vergewissern Sie sich, dass die
benétigten Gerite am Camcorder
angebracht sind und mit Strom
versorgt werden.

2 Setzen Sie die Speicherkarte(n) ein.
Wenn Sie zwei Speicherkarten in die
Einschiibe A und B einsetzen, wird die
Aufnahme automatisch auf der zweiten Karte
fortgesetzt, wenn die Speicherkapazitit der
ersten Karte erschopft ist.

3 Stellen Sie den Schalter ON/STANDBY
auf ON.
Der Aufnahmebildschirm wird auf dem
LCD-/Sucherbildschirm angezeigt.

4 Driicken Sie die Aufnahmetaste am
seitlichen Griff oder am Griff (Seite 8).

Die Aufnahme-/Tally-Anzeige leuchtet und
die Aufnahme beginnt.

5 Umdie Aufzeichnung anzuhalten,
driicken Sie wieder die Aufnahmetaste.
Die Aufnahme wird angehalten, und der

Camcorder wechselt in den
Bereitschaftsmodus (STBY).

Aufzeichnung (Full Auto-Modus)

Driicken Sie die Taste FULL AUTO. Die
Tastenanzeige leuchtet auf.

Der Full Auto-Modus und Auto Exposure

(Seite 75) werden aktiviert, und Auto ND Filter,
Auto Iris, AGC (Auto Gain Control), Auto
Shutter und ATW (Auto Tracing White Balance)
werden auf On gesetzt. AnschlieBend werden die
Helligkeit und der WeiBlabgleich automatisch
eingestellt.
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Wenn Sie diese Einstellungen manuell
vornehmen wollen, schalten Sie die
Vollautomatik aus.

Kontinuierliches Aufzeichnen auf den
Speicherkarten (Relay Rec)

Wenn sich sowohl in Einschub A als auch in
Einschub B eine Speicherkarte befindet, wechselt
die Aufzeichnung, kurz bevor die erste Karte
komplett voll ist, automatisch zur zweiten Karte.
Sie konnen die kontinuierliche Aufzeichnung
fortsetzen, indem Sie zwischen den
Speicherkarten umschalten und eine volle durch
eine neue Speicherkarte ersetzen.

« Speicherkarten nicht wihrend der Aufzeichnung
auswerfen. Nehmen Sie nur die Speicherkarte aus dem
Einschub heraus, dessen Zugriffsanzeige wihrend der
Aufnahme nicht leuchtet.

Wenn die Restdauer der Speicherkarte, auf die
aufgezeichnet wird, weniger als 1 Minute betridgt und
eine bespielbare Speicherkarte in den anderen
Einschub eingesetzt ist, wird die Meldung ,,Will
Switch Slots Soon* angezeigt. Sobald der
Speicherkarteneinschub gewechselt wurde, wird die
Nachricht ausgeblendet.

Die automatische Aufnahmefortsetzung funktioniert
moglicherweise nicht, wenn die Restdauer der
Speicherkarte beim Aufnahmestart weniger als

1 Minute betrigt. Damit die automatische
Aufnahmefortsetzung einwandfrei funktioniert, stellen
Sie sicher, dass die Restdauer der Speicherkarte mehr
als 1 Minute betrigt.

Videos, bei denen wihrend der Aufzeichnung ein
Speicherkartenwechsel stattgefunden hat, konnen
nicht nahtlos vom Camcorder wiedergegeben werden.
Zum Verbinden von Videos, die auf mehrere
Speicherkarten verteilt aufgenommen wurden, kann
das Anwendungsprogramm ,,Content Browser*
verwendet werden.



Informationen zu Clips

Verwenden des Motorzoomhebels

Clip (Aufnahmedaten)

Wenn Sie die Aufzeichnung anhalten, werden
die Video-, Audio- und Zusatzdaten vom
Anfang bis zum Ende der Aufzeichnung als
einzelner Clip auf der Speicherkarte
gespeichert.

Clipnamen

Jedem mit dem Camcorder aufgenommenen
Clip wird geméBl dem Benennungsmodus, der
mit Clip Naming (Seite 93) im Media-Menii
festgelegt wurde, ein Clipname zugewiesen.

Maximale Cliplange

Die maximale Dauer eines Clips variiert je
nach Aufnahmeformat.

Die maximale Dauer einer kontinuierlichen
Aufnahme ist gleich der maximalen Dauer
eines Clips. Falls die Aufnahmedauer die
maximale Dauer eines Clips tiberschreitet, wird
automatisch ein neuer Clip erstellt und die
Aufnahme wird fortgesetzt. Der neue Clip wird
in der Miniaturbildanzeige als separater Clip
angezeigt.

Einzelheiten zur maximalen Aufnahmedauer
eines Clips beim jeweiligen Aufnahmeformat
finden Sie unter ,, Maximale Aufnahmedauer
fiir einen Clip“ (Seite 108).

Ldschen eines Clips

Sie konnen den zuletzt aufgenommenen Clip
mithilfe der Funktion Last Clip Delete 16schen
(Seite 97). Um alle oder bestimmte Clips zu
16schen, fiihren Sie den Vorgang in de
Miniaturbildanzeige (Seite 61) durch.

Einstellen des Zooms

o @

24

Driicken Sie zum Zoomen den Motorzoomhebel
[Cl.

Driicken Sie den Motorzoomhebel fiir einen
langsamen Zoom nur leicht. Fiir einen
schnelleren Zoom driicken Sie den Hebel ganz
durch.

¥

©

wr—_mT

Totale: Weitwinkel
©i
1%

Sy

Nahaufnahme: Tele

* Der fiir die Fokussierung erforderliche
Mindestabstand zwischen Camcorder und
Motiv liegt im Weitwinkelbereich bei etwa
1 cm und im Telebereich bei etwa 80 cm.

* Bei bestimmten Zoompositionen ist eine
Fokussierung eventuell nicht moglich, wenn
sich das Motiv innerhalb von 80 cm Abstand
vom Camcorder befindet.

¢ Lassen Sie den Finger auf dem
Motorzoomhebel [C]. Wenn Sie den Finger
vom Motorzoomhebel nehmen, wird das
Betriebsgerdusch des Motorzoomhebels
moglicherweise mit aufgezeichnet.

Verwenden des Zoom am Griff

1. Stellen Sie fiir die Bedienung des Zoom-
Bedienelements am Griff ,,Low", ,,High*
oder ,,Variable“ unter Handle Zoom
(Seite 76) >Setting im Camera-Menii ein.

* Bei Einstellung von ,,Variable“ konnen Sie
mit je nach Stirke des Drucks auf den
Schalter variabler Geschwindigkeit ein-
und auszoomen.

* Bei Einstellung von ,Low* oder ,,High*
konnen Sie unabhéngig von der Stérke des
Drucks auf den Schalter mit fester
Geschwindigkeit ein- und auszoomen. Sie
konnen mithilfe von Handle Zoom im
Camera-Menii die Geschwindigkeit auf
,,Low* oder ,,High* einstellen.

¢ Indem Sie einer frei belegbaren Taste
(Seite 36) die Funktion Handle Zoom
>Setting zuweisen, konnen Sie die
Funktion des Zoom-Bedienelements am



Griff durch Driicken dieser Taste
umschalten.

2. Driicken Sie zum Ein- und Auszoomen den
Zoomhebel am Griff [A].

* Sie konnen den Zoomhebel am Griff |A| nicht
verwenden, wenn die Zoom-Bedienung am Griff auf
OFF gestellt ist.

Verwenden des Zoomrings

Drehen Sie zum Zoomen den Zoomring Bl.

Sie konnen mit der gewiinschten
Geschwindigkeit zoomen, indem Sie den
Zoomring |B| drehen. Auch eine Feineinstellung
ist moglich.

Einstellen des Fokus

Tipps zum Fokussieren

* Verschieben Sie den Motorzoomhebel zum
Einstellen des Fokus in Richtung T
(Telebereich) und dann zum Einstellen des
Zooms fiir die Aufnahme in Richtung W
(Weitwinkelbereich).

* Wenn Sie eine Nahaufnahme von einem Motiv
machen wollen, verschieben Sie den
Motorzoomhebel zum Vergrofiern des Bildes
auf W (Weitwinkelbereich) und stellen dann
den Fokus ein.

AF/MF-
Modus

.i

(Al

Full MF-Modus

Einstellung im Full MF-Modus

Ziehen Sie den Fokussierring |A| zuriick (in
Richtung des Camcorders), um den Full MF-
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Modus mit vollstindig manueller Fokussteuerung
zu aktivieren.

Drehen Sie zum Einstellen des Fokus den
Fokussierring. Priifen Sie dabei das Bild auf dem
LCD-/Sucherbildschirm.

Im Full MF-Modus kénnen Sie sich beim
Einstellen des Fokus an den
Entfernungsmarkierungen auf dem Fokussierring
orientieren. Die Entfernungen der
Bildschirfenebene entsprechen den Positionen
der Entfernungsmarkierungen.

+ Uben Sie beim Drehen des Fokussierrings am Ende
des Drehbereichs keine iibermaBige Kraft aus.

* Im Full MF-Modus funktionieren der Autofokus und
der Autofokus auf Knopfdruck nicht.

¢ Makro ist unabhingig von der Einstellung Focus
Macro im Camera-Menii deaktiviert.

Einstellung im MF-Modus

Im MF-Modus (manueller Fokus) konnen Sie bei
Bedarf auch den Autofokusbetrieb zuschalten.
Schieben Sie den Fokussierring nach vorn (in
Richtung der Gegenlichtblende) und stellen Sie
den Schalter FOCUS auf MANUAL.

Voriibergehende Verwendung des Autofokus
(Autofokus auf Knopfdruck)

Im MF-Modus wird der Autofokus aktiviert,
solange die Taste FOCUS PUSH AUTO/HOLD
am Objektiv gedriickt wird oder eine mit Push
AF/Push MF belegte belegbare Taste (Seite 36)
gedriickt wird.

Wenn Sie die Taste loslassen, kehrt der Fokus zur
manuellen Fokussierung zurtick.

Diese Funktion ist niitzlich, um den Fokus
withrend des manuellen Fokusmodus von einem
Motiv auf ein anderes zu verlagern.

Einstellung im AF-Modus

Im AF-Modus (Autofokus) wird der Fokus
automatisch eingestellt.

Schieben Sie den Fokussierring [A| nach vorn und
stellen Sie den Schalter FOCUS auf AUTO.

Voriibergehende Verwendung des manuellen
Fokus (Manueller Fokus auf Knopfdruck)

Im AF-Modus wird der manuelle Fokus aktiviert,
solange die Taste FOCUS PUSH AUTO/HOLD
am Objektiv gedriickt wird oder eine mit Push
AF/Push MF belegte belegbare Taste (Seite 36)
gedriickt wird.

Wenn Sie die Taste loslassen, kehrt der Fokus zur
automatischen Fokussierung zuriick.



Verwenden des Makro-Modus

Stellen Sie im MF- oder AF-Modus Focus
(Seite 74) >Focus Macro im Camera-Menii auf
On oder driicken Sie eine mit Focus Macro
(Seite 36) belegte belegbare Taste, um den
Makro-Modus zu aktivieren und die
Fokussierung in einem Bereich zu ermdglichen,
der den Makro-Bereich umfasst.

Der Makro-Modus ist im Full MF-Modus
deaktiviert.

Fokussierung mit vergriBerter Ansicht
(Focus Magnifier)

Wenn eine mit Focus Magnifier belegte belegbare
Taste (Seite 36) gedriickt wird, erscheint der
Fokuslupenbildschirm, in dem ein Teil des Bilds
vergrofert dargestellt wird.

Wenn das Aufzeichnungsformat QFHD ist,
wechselt die VergroBSerung bei jedem
Tastendruck zwischen 4x und 8x. Sie konnen die
vergroferte Position mithilfe der Taste 4/¥/«/®
bewegen.

Die Mitte des Bildschirms wird in anderen
Formaten als QFHD mit fester 2x-Vergroerung
angezeigt.

Driicken Sie die Taste erneut, um zur normalen
Anzeige zuriickzukehren.

Diese Funktion ist hilfreich, um die
Scharfstellung zu tiberpriifen.

¢ Das Bild wird auf dem Bildschirm vergrofert
angezeigt, aber normal aufgenommen.

Priifen von Audiosignalen
wahrend der Aufnahme

SchlieBen Sie zum Uberwachen der
aufgezeichneten Audiosignale einen Kopfhorer
an die Kopfhorerbuchse (Stereominibuchse)
(Seite 9) an.

* Wihrend der Aufnahme (Aufnahme oder
Aufnahmebereitschaft) ist der eingebaute
Lautsprecher deaktiviert.

Lautstérke zur Priifung von Audiosignalen

einstellen

Verwenden Sie die VOLUME-Tasten (Seite 10).

Kanal zur Priifung von Audiosignalen einstellen
Wiihlen Sie den Kanal mithilfe von Audio Output
(Seite 84) im Audio-Menii aus.

|
Andern von

Grundeinstellungen

Die Grundeinstellungen kénnen anhand der
Videoanwendung oder der
Aufnahmebedingungen gedndert werden.

Videoformat

Die zur Auswahl stehenden Formate variieren je
nach Systemfrequenz und Codec-Einstellungen.

Wechseln der Systemfrequenz

Wechseln Sie mithilfe von Rec Format (Seite 96)
>Frequency im System-Menii.

Nach dem Wechsel startet der Camcorder
automatisch neu.

e Wihrend der Aufnahme oder Wiedergabe ist das
Wechseln der Systemfrequenz nicht moglich.

Wechseln des Codecs

Wechseln Sie mithilfe von Rec Format (Seite 96)
>Codec im System-Menii.

e Wihrend der Aufnahme oder Wiedergabe ist das
Wechseln des Codecs nicht moglich.

Format @ndern

Wechseln Sie mithilfe von Rec Format (Seite 96)
>Video Format im System-Menii.

Die Signale von den Anschliissen SDI OUT und
HDMI OUT werden ebenfalls in dem mit diesem
Menii ausgewihlten Format ausgegeben.

» Wihrend der Aufnahme oder Wiedergabe ist das
Wechseln des Formats nicht moglich.



Anpassen der Helligkeit

(A}

Die Helligkeit kann iiber die Wahl der Blende,
Verstirkung, Belichtungszeit sowie iiber das
Anpassen des Lichtpegels iiber ND-Filter
eingestellt werden.

Aufzeichnen mit automatischer Blende

Wenn die Vollautomatik (Seite 23) aktiviert ist
Die Blende wird zwangslidufig auf Automatik
eingestellt.

Wenn die Vollautomatik deaktiviert ist

Stellen Sie den Schalter IRIS in die Position
AUTO. Die Automatik ist eingestellt.

Die beim Umschalten des Blendenschalters
AUTO/MANUAL auf MANUAL angewandte
Einstellung kann auch mithilfe des Direktmeniis
(Seite 34) konfiguriert werden.

Aufzeichnen mit manueller Blende

Wenn die Vollautomatik deaktiviert ist, stellen
Sie den Schalter IRIS auf MANUAL. Der
manuelle Modus ist eingestellt. Drehen Sie zum
Einstellen der Blende den Blendenring (Al

Die beim Umschalten des Blendenschalters
AUTO/MANUAL auf MANUAL angewandte
Einstellung kann auch mithilfe des Direktmeniis
(Seite 34) konfiguriert werden.
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Voriibergehendes Umschalten zur
Blendenautomatik

Driicken Sie im manuellen Blendenmodus die
Taste IRIS PUSH AUTO |E| um die Funktion
,.Blendenautomatik auf Knopfdruck zu
aktivieren.

Die automatische Blende ist aktiviert, solange die
Taste gedriickt gehalten wird. Lassen Sie die
Taste los, um in den manuellen Blendenmodus zu
wechseln.

Aufzeichnen mit automatischer
Verstarkung (AGC)

Wenn die Vollautomatik (Seite 23) aktiviert ist
Der AGC-Modus (automatische
Verstirkungsregelung) wird zwangsldufig
aktiviert.

Wenn die Vollautomatik deaktiviert ist

Stellen Sie Auto Exposure >AGC (Seite 75) im
Camera-Menii auf On, um den AGC-Modus zu
aktivieren.

Sie konnen AGC auch tiber das Direktmenii
(Seite 34) aktivieren/deaktivieren.

Aufnehmen mit fester Verstarkung

1. Deaktivieren Sie die Vollautomatik.

2. Wenn der Gain-Wert automatisch eingestellt
wird, setzen Sie Auto Exposure >AGC
(Seite 75) im Camera-Menii auf Off.
~AGC* wird ausgeblendet.

3. Stellen Sie den Schalter GAIN auf H M
oder L.
Der fiir die ausgewihlte Position des
Schalters GAIN eingestellte
Verstirkungswert erscheint auf dem
Bildschirm.
Sie konnen den Verstarkungswert fiir H/M/L
mithilfe von Gain (Seite 74) im Camera-
Menii einstellen.
Sie konnen den Wert fiir H/M/L auch iiber
das Direktmenii (Seite 34) festlegen.

Aufnehmen mit Verschlussautomatik

Wenn die Vollautomatik (Seite 23) aktiviert ist
Der Verschluss wird zwangsldufig auf Automatik
eingestellt.



Wenn die Vollautomatik deaktiviert ist

Stellen Sie Auto Exposure >Auto Shutter
(Seite 76) im Camera-Menii auf On, um den
Automatikmodus fiir die
Verschlussgeschwindigkeit zu aktivieren.

Sie konnen die Verschlussautomatik aktivieren,
indem Sie im Direktmenii Auto Shutter
auswihlen und auf On setzen.

Aufnehmen mit festem Verschluss

Wenn die Vollautomatik deaktiviert ist und Auto
Exposure >Auto Shutter (Seite 76) im Camera-
Menii auf Off gesetzt ist, stellen Sie den Schalter
SHUTTER in die Position ON, um einen
festen Verschluss mit Modus und
Geschwindigkeit wie unter Shutter (Seite 75) im
Camera-Menii konfiguriert festzulegen.

Einstellen im Camera-Menii

Wiihlen Sie Shutter (Seite 75) im Camera-Menii
aus, und legen Sie den Blendenmodus und die
Belichtungszeit fest.

Einstellung mithilfe des Direktmeniis

Sie konnen den ECS-Modus (Seite 75) und die
Verschlussgeschwindigkeit auch iiber das
Direktmenii (Seite 34) einstellen.

Anpassen des Lichtpegels (ND-Filter)

Wenn die Umgebung zu hell ist, konnen Sie ein
Motiv durch Verwendung des Schalters ND
FILTER [C]| mit der geeigneten Helligkeit
aufnehmen.

Der Camcorder verfiigt iber zwei ND-
Filtermodi. Sie konnen den Modus mit dem
ND FILTER-Modusschalter [D] wechseln.

Voreinstellungsmodus

Stellen Sie den ND FILTER-Modusschalter [D]
auf PRESET und stellen Sie den Schalter ND
FILTER [C| dann folgendermalien ein.
CLEAR: ND-Filter wird nicht verwendet.

1: Filterdichte wie mit ND Filter >Presetl im
Camera-Menii festgelegt. Die
Standardeinstellung ist 1/4.

2: Filterdichte wie mit ND Filter >Preset2 im
Camera-Menii festgelegt. Die
Standardeinstellung ist 1/16.

3: Filterdichte wie mit ND Filter >Preset3 im
Camera-Menii festgelegt. Die
Standardeinstellung ist 1/64.

28

Variabler Modus

Stellen Sie den ND FILTER-Modusschalter [D]
auf PRESET und stellen Sie den Schalter ND
FILTER [C| dann folgendermafen ein.
CLEAR: ND-Filter wird nicht verwendet.

1, 2, 3: Sie konnen die Filterdichte mit dem ND-
Steuerregler [E] auf einen Wert im
durchgehenden Bereich von 1/4 bis 1/128
einstellen.

Die Position (1/2/3) des Schalters ND FILTER
beeinflusst die Einstellung der Filterdichte
nicht.

Auto ND-Filter

Wenn der ND FILTER-Modusschalter auf
VARIABLE und der Schalter ND FILTER in
Position 1 bis 3 gestellt ist, kann die Dichte des
ND-Filters automatisch angepasst werden, indem
Auto Exposure >Auto ND Filter (Seite 75) im
Camera-Menii auf On gestellt wird.

Sie konnen auch iiber das Direktmenii (Seite 34)
Auto ND Filter aktivieren/deaktivieren.

Wenn Auto ND Filter deaktiviert ist, konnen Sie
die Dichte des ND-Filters auch im Direktmenii
auswiihlen.

Einstellen der automatischen Belichtung

Die automatische Belichtung regelt tiberméBige
Helligkeit mithilfe des automatischen ND-Filters
sowie der Blenden-, Verstarkungs- und
Verschlussfunktionen auf einen geeigneten
Pegel.

Legen Sie mithilfe von Auto Exposure (Seite 75)
>Mode im Camera-Menii den Steuerungsmodus
und mithilfe von Level die Stufe fest.

Sie konnen den Steuerungsmodus und die
Korrekturstufe auch iiber das Direktmenii

(Seite 34) festlegen.

Flimmer-Reduzierung

Stellen Sie Flicker Reduce (Seite 76) >Mode im
Camera-Menii auf Auto oder On und stellen Sie
unter Frequency die Netzfrequenz (50 Hz oder
60 Hz) ein.

* Wenn die Bildfrequenz fiir die Aufzeichnung dhnlich
der Netzfrequenz ist, wird das Flimmern
moglicherweise nicht vollstindig reduziert, wenn die
Flimmer-Reduzierung aktiviert ist. Verwenden Sie in
diesem Fall den elektronischen Verschluss.



Anpassung fiir natiirliche Farben
(WeiBabgleich)

GAIN

WHT BAL

Bl
Sie konnen den Anpassungsmodus an die
jeweiligen Aufnahmebedingungen anpassen.

Preset-Modus

In diesem Modus wird die Farbtemperatur auf
einen voreingestellten Wert gesetzt
(Standardwert ist 3200K). Diese Einstellung ist
vorteilhaft, wenn Sie keine Zeit dazu haben, den
WeiBabgleich anzupassen oder wenn Sie den
WeiBabgleich auf die mit White (Seite 78)
>Preset White im Paint-Menii festgelegte
Voreinstellung festlegen mochten.

Memory A-Modus, Memory B-Modus

In diesem Modus wird der Weilabgleich auf die
auf Speichermedium A bzw. B gespeicherten
Einstellungen gesetzt.

Driicken Sie die Taste WB SET , um den
automatischen WeiBabgleich durchzufiihren und
speichern Sie den eingestellten Wert in Speicher
A oder B.

ATW-Modus (Auto Tracing White Balance,
automatische Weilwertanpassung)

In diesem Modus passt der Camcorder den
WeiBwert automatisch an die jeweiligen
Bedingungen an.

Wenn sich die Farbtemperatur der Lichtquelle
dndert, wird der Weilabgleich automatisch
angepasst.

Die Anpassungsgeschwindigkeit kann (in fiinf
Stufen) tiber White Setting >SATW Speed
(Seite 78) im Paint-Menii gedndert werden.
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Sie konnen die aktuelle Einstellung fiir den
WeiBabgleich festhalten, indem Sie einer
belegbaren Taste (Seite 36) die Funktion ATW
Hold zuweisen und diese Taste driicken, um den
ATW-Modus voriibergehend zu unterbrechen.

* Abhingig von den Lichtverhiltnissen und dem Motiv
konnen die Farben moglicherweise nicht per ATW
angepasst werden.

Beispiele:

— Das Motiv wird von einer Farbe dominiert, z. B.
Himmel, Meer, Erdboden oder Blumen.

— Die Farbtemperatur ist extrem hoch oder extrem
niedrig.
Wenn die Nachfiihrgeschwindigkeit des ATW zu
langsam ist und der gewiinschte Effekt aus diesem
oder anderen Griinden nicht erzielbar ist,
verwenden Sie den automatischen Weilabgleich.

Verwenden des Schalters

Wiihlen Sie den Modus mit dem Schalter WHT
BAL aus.

B: ATW-Modus oder Memory B-Modus

A: Memory A-Modus

PRESET: Voreinstellungsmodus

Werkseitig ist der ATW-Modus der Position B
des Schalters WHT BAL zugewiesen. Sie konnen
die Einstellung éndern, sodass der Memory B-
Modus mithilfe von White Setting >White
Switch<B> (Seite 78) im Paint-Menii ausgewéhlt
wird.

Durch Einstellen des Camcorders auf
Vollautomatikmodus (Seite 23) wird der ATW-
Modus zwangsweise aktiviert.

Indem das Ein-/Ausschalten von ATW einer frei
belegbaren Funktionstaste (Seite 36) zugewiesen
wird, kann ATW getrennt aktiviert bzw.
deaktiviert werden, wenn der
Vollautomatikmodus ausgeschaltet ist.

Mit dem Direktmenii

Driicken Sie die Taste DISPLAY (Seite 10), um
den gewihlten Modus und die Farbtemperatur auf
dem Bildschirm anzuzeigen (Seite 11).

ATW: ATW-Modus

W:A: Memory A-Modus

W:B: Memory B-Modus

W:P: Preset-Modus

Sie konnen den Einstellmodus wie folgt im
Direktmentii (Seite 34) dndern.

Wenn der Schalter WHT BAL in Position B
gestellt ist, konnen ATW-Modus und Memory B-
Modus festgelegt werden.




Wenn der Schalter WHT BAL in Position A
gestellt ist, konnen ATW-Modus und Memory A-
Modus festgelegt werden.

Wenn der Schalter WHT BAL in Position
PRESET gestellt ist, konnen ATW-Modus und
Voreinstellungsmodus festgelegt werden.
Wenn nicht der ATW-Modus eingestellt ist,
konnen Sie die Farbtemperatur im Direktmenii
einstellen.

Sie konnen die Farbtemperatur im Direktmenti
dndern, indem Sie die Anzeige der
Farbtemperatur auswéhlen. Im
Voreinstellungsmodus wird durch Driicken der
Taste WB SET die Farbtemperatur ebenfalls
eingestellt.

Umschalten des Voreinstellungsmodus
mit belegbarer Taste

Weisen Sie die Funktion Preset White Select
einer belegbaren Taste zu (Seite 36). Sie konnen
dann mit jedem Driicken auf die Taste die
Voreinstellungswerte in der Reihenfolge 3200K,
4300K, 5600K und 6300K wechseln.

Durchfiihren des automatischen
WeiBahgleichs

1 Wenn Sie einen Anpassungswert im
Speicher festhalten mochten, wihlen
Sie Memory A-Modus oder Memory B-
Modus.

2 Platzieren Sie einen Bogen weilles
Papier (oder ein anderes Objekt) an
einen Ort mit derselben Lichtquelle und
denselben Lichtbedingungen wie das
Motiv, und zoomen Sie dann das Papier
heran, um den weifen Bereich auf dem
Bildschirm anzuzeigen.

3 Passen Sie die Helligkeit an.

Passen Sie die Blende wie unter
»Aufzeichnen mit manueller Blende
(Seite 27) beschrieben an.

4 Driicken Sie die Taste WB SET [A].

Wenn Sie den Abgleich in einem
Speichermodus ausfiihren, wird der
eingestellte Wert in dem in Schritt 1
ausgewihlten Speicher (A oder B) abgelegt.

Wenn der automatische Weiflabgleich im
ATW-Modus durchgefiihrt wird, kehrt der
angepasste WeiBlabgleich nach der
Anpassung in den ATW-Modus zuriick.

Im Preset-Modus ist kein automatischer Weilabgleich
moglich.

Wenn die Anpassung nicht erfolgreich ist, wird eine
Fehlermeldung auf dem Bildschirm angezeigt. Kehrt
die Fehlermeldung auch nach wiederholten Versuchen
zum Anpassen des WeiBabgleichs zuriick, wenden Sie
sich an die zustindige Sony Kundendienstvertretung.

Festlegen der aufzunehmenden
Audiosignale

Mithilfe der folgenden Anschliisse, Schalter und
Regler konnen Sie den Ton fiir die Aufnahme
einstellen.

INPUT1 ~ INPUT2 B

A[IDI0 LEVEL

INPUT1

LINE_MIC INT| EXT
s i

I ’EJ
MIC+48V MI

INPUT2
LINE_MIC INT
o)

L
MIC+48V MI [i

Wo©

Externe Audioeingange und Wahlschalter
Anschluss AUDIO INPUTI1
Anschluss AUDIO INPUT2

Schalter INPUT1

Schalter INPUT? [H]

Schalter fiir Tonquelle
Schalter CHI (INT/EXT/MI SHOE) [D]
Schalter CH2 (INT/EXT/MI SHOE)



Schalter zum Festlegen des Audiopegels
Regler AUDIO LEVEL (CH1) [E]
Regler AUDIO LEVEL (CH2)

Siehe Blockdiagramme (Seite 117).

Verwenden des eingebauten Mikrofons

Sie konnen Ton mithilfe des eingebauten
Mikrofons aufnehmen.

Aufnehmen auf CH1, CH2

Stellen Sie die Schalter CH1 (INT/EXT/MI
SHOE) [D] und CH2 (INT/EXT/MI SHOE)
auf INT.

Aufnehmen auf CH3, CH4

Wiihlen Sie Internal MIC mithilfe von
Audio Input (Seite 83) >CH3 Input Select
und CH4 Input Select im Audio-Menii aus.

Verwenden eines externen Audiogerats

Mischpulte und andere externe Audiogerite
werden unterstiitzt.

Aufnehmen auf CH1, CH2

1 Stellen Sie die Schalter CH1 (INT/EXT/
MI SHOE) @ und CH2 (INT/EXT/MI
SHOE) [G] auf EXT.

Wenn Audio Input >CH2 EXT Input Select
im Audio-Menii auf INPUT?2 gesetzt ist, wird
der Ton vom Anschluss AUDIO INPUT1 auf
CHI1 und der Ton vom Anschluss AUDIO
INPUT?2 auf CH2 aufgenommen.

Wenn CH2 EXT Input Select auf INPUT1
gesetzt ist, wird der Ton vom Anschluss
AUDIO INPUT1 auf CH1 und CH2
aufgenommen.

2 Stellen Sie die Schalter INPUT1/
INPUT2 ([C)/[H]) auf LINE.

3 SchlieBen Sie ein externes Audiogeriit
an die Anschliisse AUDIO INPUT1/
AUDIO INPUT2 ([Al/[B)) an.

Aufnehmen auf CH3, CH4

1 Wiihlen Sie INPUT1 mithilfe von Audio
Input (Seite 83) >CH3 Input Select und
INPUT?2 mithilfe von CH4 Input Select
im Audio-Menii aus.
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Wenn INPUT 1 mithilfe von CH4 Input
Select ausgewihlt ist, wird der Ton vom
Anschluss AUDIO INPUT1 auf CH3 und
CH4 aufgenommen.

2 Fiihren Sie die Schritte 2 und 3 wie
unter ,,Aufnehmen auf CH1, CH2¢
beschrieben durch.

Verwenden eines externen Mikrofons

Ein Elektret-Kondensatormikrofon oder andere
Gerite konnen fiir die Aufnahme angeschlossen
werden.

Aufnehmen auf CH1, CH2

1 Stellen Sie die Schalter CH1 (INT/EXT/
MI SHOE) [D] und CH2 (INT/EXT/MI
SHOE) [G] auf EXT.

Wenn Audio Input >CH2 EXT Input Select
im Audio-Menii auf INPUT2 gesetzt ist, wird
der Ton vom Anschluss AUDIO INPUT1 auf
CHI1 und der Ton vom Anschluss AUDIO
INPUT?2 auf CH2 aufgenommen.

Wenn CH2 EXT Input Select auf INPUT1
gesetzt ist, wird der Ton vom Anschluss
AUDIO INPUT1 auf CH1 und CH2
aufgenommen.

2 Stellen Sie die Schalter INPUT1/
INPUT?2 ([C)/[H]) ein.
MIC: Fiir Mikrofone, die keine
Phantomspeisung erfordern.
MIC+48V: Fiir Mikrofone, die eine
Phantomspeisung mit +48 V erfordern.

* Wenn Sie MIC+48V auswihlen und ein
Mikrofon anschlieBen, das nicht mit einer +48-V-
Quelle kompatibel ist, kann es zu Schiaden am
angeschlossenen Gerit kommen. Uberpriifen Sie
dies, bevor Sie das Gerit anschliefen.

* Wenn Rauschen von unbelegten Anschliissen ein
Problem darstellt, stellen Sie die zugehdrigen
Schalter INPUT1/INPUT?2 auf LINE.

3 Offnen Sie die Abdeckung, indem Sie
den Griff des Mikrofonhalters aufwirts
ziehen.

4 Bringen Sie ein Mikrofon an. SchlieBen
Sie dann den Mikrofonhalter, um das
Mikrofon zu sichern.



9 SchlieBen Sie das Mikrofonkabel an die
Anschliisse AUDIO INPUT1/AUDIO
INPUT2 ([Al/[B]) an.

Wenn Sie ein Stereomikrofon (zwei XLR-
Stecker) verwenden wollen, schlielen Sie
den Stecker fiir den linken Kanal (L) an den
Anschluss AUDIO INPUT1 und den Stecker
fiir den rechten Kanal (R) an den Anschluss
AUDIO INPUT?2 an.

Aufnehmen auf CH3, CH4

1 Wihlen Sie INPUT1 mithilfe von Audio
Input (Seite 83) >CH3 Input Select und
INPUT?2 mithilfe von CH4 Input Select
im Audio-Menii aus.

Wenn INPUT1 mithilfe von CH4 Input
Select ausgewdhlt ist, wird der Ton vom
Anschluss AUDIO INPUTI1 auf CH3 und
CH4 aufgenommen.

2 Fiihren Sie die Schritte 2 bis 5 wie unter
,,Aufnehmen auf CH1, CH2¢
beschrieben durch.

Verwenden eines mit dem Multi-
Interface-Schuh kompatiblen Mikrofons

Aufnehmen auf CH1, CH2

1 Stellen Sie die Schalter CH1 (INT/EXT/
MI SHOE) [D] und CH2 (INT/EXT/MI
SHOE) [G] auf MI SHOE.

2 Bringen Sie ein Mikrofon am Multi-
Interface-Schuh an.

Aufnehmen auf CH3, CH4

1 Wihlen Sie Shoe CH1 mithilfe von
Audio Input (Seite 83) >CH3 Input
Select und Shoe CH2 mithilfe von CH4
Input Select im Audio-Menii aus.

2 Bringen Sie ein Mikrofon am Multi-
Interface-Schuh an.

» Es konnen nicht zwei Mikrofone gleichzeitig am
vorderen und hinteren Multi-Interface-Schuh
angeschlossen werden. Das zuerst angeschlossene
Mikrofon ist das aktive Mikrofon.
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Einstellen des Audio-Aufnahmepegels

Fiir CH1, CH2

Automatische Anpassung (AGC):

Stellen Sie die Regler AUDIO LEVEL
(CH1/CH2) ([EV/[F]) auf die Position
AUTO.

Sie konnen mithilfe von Audio Input (Seite 83)
>CHI1&2 AGC Mode im Audio-Menii festlegen,
ob die Pegel auf CH1 und CH2 automatisch
separat (Mono) oder zusammen (Stereo)
angepasst werden.

Manuelle Anpassung:

Stellen Sie wihrend der Aufzeichnung bzw.
im Bereitschaftsmodus die Regler AUDIO
LEVEL (CH1/CH2) ([E)/[F]) der
entsprechenden Kaniéle im Bereich
zwischen 0 bis 10 ein, um den Audio-
Aufnahmepegel des Mikrofons anzupassen.

Fiir CH3, CH4

Automatische Anpassung (AGC):

Setzen Sie Audio Input (Seite 8§3) >CH3
Level Control/CH4 Level Control im
Audio-Menii auf Auto.

Sie konnen mithilfe von Audio Input (Seite 83)
>CH3&4 AGC Mode im Audio-Mentii festlegen,
ob die Pegel auf CH3 und CH4 automatisch
separat (Mono) oder zusammen (Stereo)
angepasst werden.

Manuelle Anpassung:

1 Setzen Sie Audio Input (Seite 83) >CH3
Level Control/CH4 Level Control im
Audio-Menii auf Manual.

2 Stellen Sie den Audio-Aufnahmepegel
mithilfe von CH3 Input Level/CH4
Input Level ein.

Zum Verringern von Windgerduschen setzen Sie
Audio Input >CH Wind Filter im Audio-Menii
auf On (Seite 83).

Audio-Aufnahmen in speziellen
Aufzeichnungsmodi

Im Intervall-Aufzeichnungsmodus und
Zeitlupen-/Zeitraffer-Modus wird kein Ton
aufgezeichnet.



Bildstabilisierung

Durch die Aktivierung der Funktion zur
Bildstabilisierung (SteadyShot) wird das
Wackeln des Bilds unterdriickt, was durch die
Bewegung der Kamera wihrend der Aufnahme
verursacht wird.

Setzen Sie SteadyShot (Seite 76) >Setting im
Camera-Menii auf Active oder Standard.

Standard: Reduziert durch Bewegung der
Kamera verursachtes Wackeln des Bilds.
Active: Reduziert durch schnelle Bewegung der
Kamera verursachtes Wackeln des Bilds wie
beim Gehen; verwendet stirkere Korrektur
als bei der Einstellung Standard.
Off: Deaktiviert den Bildstabilisierungsmodus.
Weisen Sie die Funktion SteadyShot einer frei
belegbaren Taste zu (Seite 36), und schalten Sie
den Bildstabilisierungsmodus zwischen
Standard, Active und Off um, indem Sie die Taste
driicken.
Die Einstellung wird auf dem LCD-/
Sucherbildschirm angezeigt.
Der Bildstabilisierungsmodus kann auch mithilfe
des Direktmeniis (Seite 34) zwischen Standard,
Active und Off umgeschaltet werden.

« Die Einstellung Active ist in den folgenden Fillen
nicht verfiigbar.
— Wenn Video Format auf 3840x2160 eingestellt ist
— Wihrend Aufnahme mit Zeitlupe und Zeitraffer

* Wenn Sie mithilfe eines Stativs zur Stabilisierung
arbeiten, stellen Sie SteadyShot auf Off.

Zeitdaten

Einstellen des Timecodes

Legen Sie den Timecode fiir die Aufzeichnung
iiber die Einstellung Timecode (Seite 89) im TC/
UB-Menii fest.

Festlegen von User-Bits

Sie konnen den aufgezeichneten Bildern eine
achtstellige Hexadezimalzahl als User-Bits
hinzufiigen. Sie konnen die User-Bits auch auf
die aktuelle Zeit setzen.

Nehmen Sie die Einstellung mithilfe von Users
Bit (Seite 89) im TC/UB-Menii vor.

Anzeigen von Zeitdaten

Driicken Sie zum Anzeigen der Zeitdaten auf dem
Bildschirm (Seite 11) die Taste DISPLAY.

Die Anzeige wechselt mit jedem Driicken der
Taste DURATION/TC/U-BIT (Seite 10)
zwischen Timecode, Benutzerbits und

Aufzeichnungsdauer.

Anzeige Beschreibung

TCG *k i r sk Timecode

CLK ek ek sk Timecode (Clock-Modus)
UBG ** % % 3% User-Bits

DUR ko ok okox Dauer seit Aufnahmestart
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Niitzliche Funktionen

Verwenden des Direktmeniis

Einige Optionen werden direkt auf dem LCD-/
Sucherbildschirm angezeigt. Sie konnen deren
Status iiberpriifen und deren Einstellungen
andern.

Sie konnen die Direct Menu-Funktion
verwenden, indem Sie die Funktion einer
belegbaren Taste zuweisen.

Die folgenden Optionen konnen konfiguriert
werden.

« Autofokusmodus

« SteadyShot

* ATW

¢ Preset White

* Color Temp <A>/Color Temp <B>

* Scene File

« Auto ND Filter

« ND Filter-Wert

* Auto Iris

o Iris-Wert

*« AGC

¢ Gain-Wert (H/M/L/Turbo)

« ECS

* Auto Shutter

« Shutter Speed-Wert

 Shutter Angle-Wert

* Auto Exposure Mode

* Auto Exposure Level

¢ S&Q Frame Rate

* Das Direktmenii ist nicht verfiigbar, wenn die
Vollautomatik (Seite 23) aktiviert ist (Tastenanzeige
FULL AUTO leuchtet).

1 Driicken Sie die mit Direct Menu
belegte belegbare Taste.

Wenn die Informationen mithilfe der Taste
DISPLAY auf dem LCD-/Sucherbildschirm
angezeigt werden, sind nur jene Optionen mit
dem Cursor auswihlbar, die mit dem
Direktmenii konfiguriert werden konnen.
Wenn die Informationen nicht auf dem LCD-
/Sucherbildschirm angezeigt werden, werden
nur jene Optionen angezeigt und sind mit
dem Cursor auswéhlbar, die mit dem
Direktmenii konfiguriert werden konnen.
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2 Bewegen Sie den Cursor mithilfe der
Tasten 4/¥%/«/% oder dem Regler SEL/
SET auf die gewiinschte Option und
driicken Sie die Taste SET oder den
Regler SEL/SET.

Das Direktmenii fiir die gewihlte Option
wird angezeigt.

3 Wihlen Sie mithilfe der Tasten #/%
oder dem Regler SEL/SET eine
Einstellung aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Der Cursor wird ausgeblendet und die neue
Einstellung wird angezeigt.

Driicken Sie die mit Direct Menu belegte
belegbare Taste erneut oder nehmen Sie drei
Sekunden lang keine Einstellung vor, um das
Direktmenii zu schlieBen und zum
Aufnahmebildschirm zuriickzukehren.

Sie konnen das Direktmenii 6ffnen, indem Sie
Menu Settings >Direct Menu with <SET>

(Seite 99) im System-Menii auf On setzen und die
Taste SET oder den Regler SEL/SET driicken.
Die Gesichtserkennung-AF-Funktion fiir
registrierte Gesichter ist jedoch nicht mehr
verfligbar.

Gesichtserkennung-AF

Der Camcorder kann die Gesichter von Personen
erkennen und den Fokus dann auf die Gesichter
anpassen.

Diese Funktion ist nur verfiigbar, wenn die
Fokussierung im AF-Modus oder durch
Autofokus auf Knopfdruck erfolgt.

Sobald Gesichter erkannt werden, werden graue
Gesichtserkennungsrahmen angezeigt. Die Farbe
der Rahmen wechselt zu Weill, nachdem
Autofokus aktiviert wurde. Wenn mehrere
Personen erkannt werden, wird das Hauptmotiv
automatisch bestimmt.

Legen Sie die Gesichtserkennung-AF
mithilfe von Focus (Seite 74) im Camera-
Menii fest.

Face Only AF: Die Kamera erkennt die
Gesichter von Motiven (Personen) und
fokussiert nur auf ihre Gesichter. Solange ein
Gesicht nicht erkannt wird, wird AF
voriibergehend gestoppt (MF) und das



Symbol ,,Face Only AF Autofokus
angehalten* [1] (Seite 11) wird angezeigt.
angezeigt, wodurch signalisiert wird, dass
kein Gesicht erkannt wurde. Dieser Modus
ist hilfreich, wenn sich die
Gesichtserkennung nicht stabilisiert hat.

Face Priority AF: Die Kamera erkennt die
Gesichter von Motiven (Personen) und
gewihrt der Fokussierung auf die Gesichter
Vorrang. Falls kein Gesicht erkannt wird,
erfolgt die Fokussierung im AF-Modus
(Standardeinstellung).

Off: Die Funktion Gesichtserkennung-AF ist
deaktiviert.

« Wihrend des Autofokus auf Knopfdruck wird Face
Priority AF aktiviert, auch wenn gegenwirtig Face
Only AF ausgewihlt ist.

¢ Gesichtserkennung-AF ist in den folgenden Fillen
nicht verfiigbar.

— Im Full MF-Modus

— Wenn der Schalter FOCUS auf MANUAL gestellt
ist (ausgenommen wihrend Autofokus auf
Knopfdruck)

— Wenn das Aufzeichnungsformat DVCAM ist

* Wenn Sie den Camcorder ausschalten, wihrend Face
Only AF ausgewihlt ist, wechselt der Modus beim
nichsten Einschalten des Camcorders automatisch zu
Face Priority AF.

Aushblenden von
Gesichtserkennungsrahmen

Sie konnen Gesichtserkennungsrahmen mithilfe
von Display On/Off >Face Detection Frame
(Seite 87) im LCD/VF-Menii ein-/ausblenden.

Fokussieren auf ein registriertes Gesicht

Wiihrend des Betriebs mit Gesichtserkennung-

AF konnen Sie ein Gesicht eines Motivs (Person)

zum Fokussieren darauf registrieren.

Es kann nur ein Gesicht registriert werden. Das

Registrieren eines Gesichts iiberschreibt die

vorhandene Registrierung.

Wenn ein Gesicht registriert wird, wechselt der

Erkennungsrahmen zu einem Doppelrahmen, und

das Symbol ,,Registriertes Gesicht* g» (Seite 11)

wird angezeigt.

Bei Gesichtserkennung-AF ergeben sich je nach

Kombination von registriertem Gesicht und

Betriebsmodus der Gesichtserkennung-AF

folgende Szenarien.

Face Priority AF (mit registriertem
Gesicht): Falls die Kamera das registrierte
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Gesicht erkennt, fokussiert sie darauf. Falls
das registrierte Gesicht nicht erkannt wird,
wird das normale Face Priority AF aktiviert.

Face Only AF (mit registriertem Gesicht):
Falls die Kamera das registrierte Gesicht
erkennt, fokussiert sie darauf. Falls das
registrierte Gesicht nicht erkannt wird, so
wird AF voriibergehend angehalten (MF)
und das Symbol ,,Face Only AF Autofokus
angehalten® [1] (Seite 11) wird angezeigt.
Dieser Modus ist hilfreich, wenn Sie
automatisch auf die registrierte Person
fokussieren mochten.

Festlegen des registrierten Gesichts

Bewegen Sie den Gesichtsauswahl-Cursor
(orange unterstrichen) mithilfe der Tasten
4/¥%/«/» auf das zu registrierende Gesicht
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Rahmen um das
registrierte Gesicht
(weiBer Doppelrahmen)

Andere
Gesichter (grau)

Gesichtsauswahl-Cursor (orange)

Verwerfen des registrierten Gesichts

Bewegen Sie den Auswahl-Cursor mithilfe der
Tasten 4/¥/«/ auf das registrierte Gesicht und
driicken Sie die Taste SET oder den Regler SEL/
SET.

Das registrierte Gesicht wird verworfen, der
Gesichtsrahmen wechselt zu einem einfachen
Rahmen, und das Symbol ,,Registriertes Gesicht*
wird ausgeblendet.

Wenn Gesichter ohne angezeigten Rahmen eines
registrierten Gesichts erkannt werden und der
Gesichtsauswahl-Cursor (orange) angezeigt wird,
konnen Sie das registrierte Gesicht verwerfen,
indem Sie zwei Mal die Taste SET oder den
Regler SEL/SET driicken.

* Je nach Aufnahmeumgebung, Zustand des Motivs
oder Einstellungen werden Gesichter moglicherweise
nicht registriert.



In einigen Aufnahmeumgebungen konnen Sie ggf. den
Effekt nicht richtig nutzen, oder es werden andere
Motive anstelle von Gesichtern als Gesicht erkannt.
Stellen Sie in diesen Fillen die AF-Funktion der
Gesichtserkennung auf Off.

Es wird empfohlen, das Gesicht der gewiinschten
Person vor der Aufnahme zum Fokussieren zu
registrieren.

Die Gesichtsregistrierung schligt ggf. je nach Frisur,
Gesichtsausgestaltung oder fehlender Ausrichtung auf
die Kamera fehl. In diesem Fall wechselt der
Gesichtsrahmen ggf. zu einem Doppelrahmen, jedoch
wird das Symbol ,,Registriertes Gesicht* nicht
angezeigt.

Falls ein Gesicht bereits registriert wurde, wird
empfohlen, das registrierte Gesicht zu verwerfen und
dann das neue zu registrieren.

Die Funktion zum Registrieren von Gesichtern ist
nicht verfiigbar, wenn Menu Settings >Direct Menu
with <SET> (Seite 99) im System-Menii auf On
gesetzt ist.

Gesichtserkennung-AF mithilfe einer
belegharen Taste umschalten

Weisen Sie die Funktion Face Detection AF einer
belegbaren Taste zu (Seite 36). Sie konnen dann
die Funktionsweise des Gesichtserkennung-AF in
der Reihenfolge Face Priority AF, Face Only AF
und Off per Tastendruck durchschalten.

Einstellung mithilfe des Direktmeniis

Sie konnen die Funktionsweise des
Gesichtserkennung-AF auch iiber das
Direktmenii (Seite 34) festlegen.

Farbbalken/Referenzton

Sie konnen Farbbalken anstelle des Kamerabilds
ausgeben lassen, indem Sie Color Bars (Seite 76)
>Setting im Camera-Menii auf On setzen. Sobald
die Einstellung auf Off gesetzt wird, erfolgt
wieder die Bildausgabe.

Sie konnen zu den Farbbalken auch einen 1-kHz-
Referenzton ausgeben lassen, indem Sie Audio
Input (Seite 83) >1kHz Tone on Color Bars im
Audio-Menii auf On setzen.

Die Farbbalken- und Referenzton-Signale
werden an den Anschliissen SDI OUT und HDMI
OUT ausgegeben.

Die Art der Farbbalken koénnen Sie mithilfe von
Color Bars >Type im Camera-Menii festlegen.
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¢ Wenn sich der Camcorder im Zeitlupen- &
Zeitraffermodus befindet, konnen keine Farbbalken
ausgegeben werden.

« Sie konnen wihrend der Aufnahme nicht zu
Farbbalken umschalten (Umschalten von Farbbalken
zum Kamerabild ist moglich).

Priifen der Aufnahme (Rec
Review)

Den zuletzt aufgezeichneten Clip konnen Sie im
Bildschirm anschauen (Rec Review).

Wenn die Aufnahme angehalten wurde,
driicken Sie die mit Rec Review belegte
belegbare Taste.

Je nach Einstellung der Option Rec Review
(Seite 91) im Recording-Menii werden die letzten
3 Sekunden, 10 Sekunden oder der gesamte Clip
wiedergegeben.

Am Ende des Clips schaltet sich die
Aufnahmeriickschau-Wiedergabe aus, und der
Camcorder kehrt in den Bereitschaftsmodus
(STBY) zuriick.

Beenden von ,,Rec Review*

Driicken Sie die Taste STOP/CAM oder
eine belegbare Taste, der Rec Review
zugewiesen wurde.

» Die Aufnahmeriickschau wird nicht unterstiitzt, wenn
nach der Aufzeichnung des Clips das Videoformat
gedndert wird.

* Die Einstellmeniis konnen wihrend der
Aufnahmeriickschau nicht bedient werden.

Frei belegbare Tasten

Am Camcorder gibt es acht belegbare Tasten
(Seite 6), denen Funktionen zugewiesen werden
konnen.

Zuweisen anderer Funktionen

Verwenden Sie Assignable Button (Seite 97) im
System-Menii.

Die zugewiesenen Funktionen werden im
Bildschirm ,,Assignable Button Status* (Seite 14)
angezeigt.

Standardm@Big zugewiesene Funktionen
Taste 1 Zebra



Taste 2 Peaking

Taste 3 Video Signal Monitor

Taste 4 Off
Taste 5 Off

Taste 6 Off
Taste 7 Direct Menu
Taste 8 Focus Magnifier

Zuweishare Funktionen

Nihere Informationen zu den Funktionen

erhalten Sie unter Seite 97.
* Off

¢ Push AF/Push MF

» Face Detection AF

* Focus Macro

¢ Auto ND Filter

¢ Push Auto ND

* Push Auto Iris

¢ Turbo Gain

* AGC

* Shutter

* Auto Exposure Level
* Spotlight

* Backlight

* Flash Band Reduce

« Digital Extender x2
* Handle Zoom
 SteadyShot

* Color Bars

* Preset White Select

« ATW

* ATW Hold

* Marker

e Zebra

¢ Peaking

* Video Signal Monitor
» Focus Magnifier

¢ Lens Info

¢ LCD/VF Adjust

* VF Mode

¢ Gamma Display Assist
« Display

* Rec

¢ S&Q Motion

« Clip Continuous Rec
* Picture Cache Rec

* Proxy Rec Start/Stop
* Rec Review

« Last Clip Delete

¢ Thumbnail

* NFC

¢ Direct Menu

¢ User Menu
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* Menu

Intervallaufzeichnung (Interval
Rec)

Sie konnen Bilder in bestimmten Intervallen
automatisch aufzeichnen und hierzu die Anzahl
Einzelbilder pro Einstellung (Number of Frames)
und das Aufzeichnungsintervall (Interval Time)
festlegen.

Diese Funktion ist besonders gut zur Aufnahme
von sich langsam bewegenden Motiven geeignet.

Aufzeichnungsintervall (Interval Time)

—

Anzahl der Einzelbilder in einer Einstellung
(Number of Frames)

Es wird empfohlen, den Camcorder auf einem
Stativ 0. A. zu montieren und die Aufzeichnung
mit der Web-Fernbedienung anstatt mit der
Aufnahmetaste am Camcorder zu steuern.

Im Intervall-Aufzeichnungsmodus wird kein Ton
aufgezeichnet.

Die Funktion Interval Rec kann nicht gleichzeitig mit
Picture Cache Rec, S&Q Motion, Clip Continuous
Rec, 2-slot Simul Rec oder Proxy Rec auf On gesetzt
werden. Wenn Interval Rec auf On gesetzt wird,
werden diese anderen Aufzeichnungsmodi auf Off
gesetzt.

Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion Interval Rec (Seite 90) im Recording-
Menii.

Wenn Setting auf On gesetzt wird, ist der
Intervall-Aufzeichnungsmodus aktiviert und auf
dem Bildschirm wird ,,Int Stby** angezeigt.

Wenn eine mit dem Multi-Interface-Schuh
kompatible Videoleuchte angebracht ist, konnen



Sie Interval Rec> Pre-Lighting im Recording-
Menii auf On setzen, sodass sich die Leuchte
automatisch 2, 5 oder 10 Sekunden vor der
Aufnahme einschaltet.

* Wenn Pre-Lighting auf On gesetzt wird, bleibt die
Videoleuchte eingeschaltet, falls die Ausschaltdauer
gemif der Einstellung fiir Interval Time kiirzer als
5 Sekunden wire. Dies ist auch dann der Fall, wenn
Video Light Set im Camera-Menii auf Rec Link oder
Rec Link + Stby gesetzt wurde.

Aufnehmen im Intervall-
Aufzeichnungsmodus

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Sobald Sie die Aufnahme starten, dndert sich die
Anzeige ,,Int Stby* und wechselt zwischen ,,Int
@Rec* und ,.Int @Stby*.

Wihrend der Aufnahme im Intervall-
Aufzeichnungsmodus kénnen die Einstellungen
Interval Time und Number of Frames nicht geéndert
werden. Um die Einstellungen zu @ndern stoppen Sie
zunichst die Aufnahme.

Nach Beginn der Aufnahme im Intervall-
Aufzeichnungsmodus ist die Aufnahmeriickschau-
Funktion deaktiviert. Dies gilt auch wihrend der
Intervallzeit.

Wihrend der Aufzeichnung im Intervall-
Aufzeichnungsmodus (Seite 89) wird der Timecode im
Rec Run-Modus aufgezeichnet.

Wiihrend einer Pause im Intervall-
Aufzeichnungsmodus werden einige zusitzliche
Bilder aufgezeichnet, wenn Sie die Aufzeichnung
anhalten oder den Speicherkarteneinschub wechseln.
Interval Rec >Setting wird automatisch auf Off
gesetzt, wenn der Schalter ON/STANDBY in die
Position STANDBY gebracht wird. Die Einstellungen
Interval Time und Number of Frames werden jedoch
beibehalten.

Kontinuierliche Aufnahme (Clip
Continuous Rec)

Normalerweise wird mit jedem Starten und
Stoppen der Aufnahme ein Clip als unabhingige
Datei erstellt. Mithilfe des Modus fiir die
kontinuierliche Aufnahme konnen Sie jedoch die
Aufnahme starten und stoppen und dabei
kontinuierlich fiir denselben Clip aufnehmen,
solange die Funktion aktiviert bleibt.
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Dies ist niitzlich, wenn Sie keine grofe Anzahl
kurzer Clips generieren und sich bei der
Aufnahme keine Gedanken um das Uberschreiten
der Hochstzahl an Clips machen wollen. Die
Aufnahmestartpunkte lassen sich dennoch
problemlos finden, da bei jedem Starten der
Aufnahme eine Aufnahmestartmarkierung
aufgezeichnet wird.

Einzelheiten zu den Aufnahmeformaten, die mit
der kontinuierlichen Clipaufnahme kompatibel
sind, finden Sie unter (Seite 107).

Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion Clip Continuous Rec (Seite 90) im
Recording-Menii.

Wenn Setting auf On gesetzt wird, ist der Modus
zur kontinuierlichen Clipaufnahme aktiviert und
auf dem Bildschirm wird ,,Cont Stby* angezeigt
(Seite 11).

Konfigurieren mithilfe belegbarer Tasten

Sie konnen Clip Continuous Rec auch einer frei
belegbaren Funktionstaste (Seite 36) zuweisen
und durch Driicken dieser Taste den Modus Clip
Continuous Rec auf On/Off setzen.

* Clip Continuous Rec kann nicht gleichzeitig mit
Interval Rec, Picture Cache Rec, S&Q Motion oder 2-
slot Simul Rec auf On gesetzt werden. Wenn Clip
Continuous Rec auf On gesetzt wird, werden diese
anderen Aufzeichnungsmodi auf Off gesetzt.

* Wihrend der Aufzeichnung kann der Modus fiir die
kontinuierliche Clipaufnahme nicht verwendet
werden.

Aufnehmen im Modus fiir die
kontinuierliche Clipaufnahme

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Wenn Sie mit der Aufnahme beginnen, wechselt
die Anzeige ,,Cont Stby* zu ,,Cont @Rec* (@
wird rot).

* Wenn Sie wihrend der Aufnahme oder im
Aufnahmebereitschaftsmodus (,,Cont Stby* wird
angezeigt) die Speicherkarte oder den Akku
herausnehmen bzw. die Stromquelle vom Gerit
trennen, muss die Speicherkarte wiederhergestellt
werden. Beenden Sie den Modus fiir die



kontinuierliche Clipaufnahme und nehmen Sie dann
die Speicherkarte heraus. Wenn ,,Cont Stby* blinkt
(ein Mal pro Sekunde), konnen Sie die Speicherkarten
entnehmen.

« Stoppen Sie die Aufnahme friihestens nach zwei
Sekunden ab Aufnahmestart.

Stoppen Sie zum Beenden die Aufnahme.

So beenden Sie den Modus fiir die
kontinuierliche Clipaufnahme

Setzen Sie wihrend der Aufnahmebereitschaft
Clip Continuous Rec (Seite 90) >Setting
entweder im Recording-Menii auf Off oder
driicken Sie die belegbare Taste, der die Funktion
Clip Continuous Rec zugewiesen ist.

Einschrankungen

Ein einziger kontinuierlicher Clip kann nicht

erstellt werden, wenn Sie eine der folgenden

Funktionen ausfiihren, wihrend sich der

Camcorder im Aufnahme- oder

Aufnahmebereitschaftsmodus befindet. Beim

ndchsten Starten der Aufnahme wird ein neuer

Clip erstellt.

« Einen Clip bearbeiten (Sperren, Loschen oder
Umbenennen eines Clips)

* Den Speicherkarteneinschub wechseln

* Das Aufnahmeformat wechseln

¢ Den Schalter ON/STANDBY auf STANDBY
stellen

 Die Miniaturbildanzeige aufrufen

« Einen Clip wiedergeben

* Den Modus fiir die kontinuierliche
Clipaufnahme beenden

Aufzeichnung im Bildpuffermodus
(Picture Cache Rec)

Der Camcorder behilt wihrend der Aufnahme
stets fiir ein bestimmtes Intervall einen Puffer mit
Video- und Audiodaten (maximal 28 Sekunden)
im internen Speicher, sodass Sie einige Sekunden
Material bereits vor dem Beginn der eigentlichen
Aufzeichnung aufnehmen.

Der Bildpuffermodus kann verwendet werden,
wenn das Aufnahmeformat (Seite 96) auf XAVC-
L eingestellt ist.

* Picture Cache Rec kann nicht gleichzeitig mit Interval
Rec, Clip Continuous Rec, S&Q Motion, 2-slot Simul
Rec oder Proxy Rec auf On gesetzt werden. Wenn
Picture Cache Rec auf On gesetzt wird, werden diese
anderen Aufzeichnungsmodi auf Off gesetzt.
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e Wihrend der Aufzeichnung oder der
Aufnahmeriickschau kann der Bildpuffermodus nicht
gewihlt werden.

¢ Wenn Picture Cache Rec auf On gesetzt ist, wird der
Timecode unabhingig von der Einstellung im TC/UB-
Menti im Modus Free Run aufgezeichnet (Seite 89).

Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion Picture Cache Rec (Seite 90) im
Recording-Menii.

Wenn Setting auf On gesetzt wird, ist die
Aufzeichnung im Bildpuffermodus aktiviert und
auf dem Bildschirm wird ,,Cache* angezeigt.

Konfigurieren mithilfe belegbarer Tasten
Weisen Sie Picture Cache Rec einer frei
belegbaren Funktionstaste (Seite 36) zu und
setzen Sie sie durch Driicken dieser Taste auf On/
Off.

Aufnehmen im Bildpuffermodus

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Wenn Sie mit der Aufnahme beginnen, wechselt
die Anzeige ,,Cache* zu ,,@Rec*.

Stoppen Sie zum Beenden die Aufnahme.

So beenden Sie den Bildpuffermodus

Setzen Sie Picture Cache Rec >Setting entweder
im Recording-Menii auf Off oder driicken Sie die
belegbare Taste, der die Funktion Picture Cache
Rec zugewiesen ist.

Bei einer Anderung des Aufzeichnungsformat wird
das bis zu diesem Zeitpunkt aufgezeichnete Video im
Pufferspeicher geloscht, und es wird ein neues Video
gepuffert. In dem Fall konnen Bilder, die vor der
Formatidnderung im Puffer gespeichert wurden, nicht
aufgezeichnet werden, wenn Sie die Aufzeichnung
direkt nach der Formatinderung starten.

Wenn die Aufzeichnung im Bildpuffermodus
unmittelbar nach dem Einlegen einer Speicherkarte
gestartet oder gestoppt wird, werden Pufferdaten
moglicherweise nicht auf der Karte gespeichert.
Videoaufnahmen werden im Pufferspeicher
gespeichert, wenn der Modus Picture Cache Rec auf
On gesetzt ist. Video, das vor Setzen der Funktion auf
On aufgezeichnet wurde, wird nicht gepuffert.
Wihrend des Zugriffs auf eine Speicherkarte, z. B.
wiihrend der Wiedergabe, Uberpriifung der Aufnahme
oder Miniaturbildanzeige, werden keine
Videoaufnahmen im Pufferspeicher gespeichert.



Wihrend dieser Zeit ist die Bildpuffer-Aufzeichnung
von Videoaufnahmen nicht moglich.

Wenn eine mit dem Multi-Interface-Schuh kompatible
Videoleuchte angebracht ist, dann ist keine
Pufferaufnahme vor dem Beginn der Aufzeichnung
moglich, selbst wenn Video Light Set im Camera-
Menii auf Rec Link oder Rec Link + Stby gesetzt ist.
Die Leuchte wird ein-/ausgeschaltet, wenn Sie die
Aufnahmetaste driicken.

Zeitlupe und Zeitraffer

Wenn das Aufnahmeformat (Seite 96) auf eines
der unten aufgefiihrten Formate eingestellt ist,
konnen Sie eine Aufzeichnungsbildfrequenz
festlegen, die sich von der
Wiedergabebildfrequenz unterscheidet.

Aufzeich- Systemfre-  Bildfrequenz

nungsformat quenz fiir Zeitlupe/
Zeitraffer

XAVC-L 1080P 59.94/29.97/ 1 bis 60 fps

23.98/50/25
XAVC-L2160P 59.94/50

(Schritte von 1 fps)

Zeitlupe & Zeitraffer konnen nicht wihrend der
Aufzeichnung, Wiedergabe oder Miniaturbildanzeige
festgelegt werden.

Zeitlupe & Zeitraffer konnen nicht gleichzeitig mit
Interval Rec, Clip Continuous Rec, Picture Cache Rec,
2-slot Simul Rec oder Proxy Rec auf On gesetzt
werden. Wenn Zeitlupe & Zeitraffer auf On gesetzt ist,
werden diese anderen Aufzeichnungsmodi auf Off
gesetzt.

Im Zeitlupen- & Zeitraffermodus ist keine
Audioaufnahme moglich.

Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion S&Q Motion (Seite §9) im Recording-
Menii.

Wenn Setting auf On gesetzt wird, ist der
Zeitlupen- & Zeitraffermodus aktiviert und auf
dem Bildschirm wird ,,S&Q Stby“ angezeigt.

Aufzeichnungsbildfrequenz mithilfe des
Direktmeniis einstellen

Sie konnen die Aufzeichnungsbildfrequenz im
Zeitlupen- & Zeitraffermodus mithilfe des
Direktmeniis festlegen (Seite 34).

Konfigurieren mithilfe belegbarer Tasten

Sie konnen S&Q Motion einer frei belegbaren
Funktionstaste (Seite 36) zuweisen und durch
Driicken dieser Taste auf On/Off den Zeitlupen-
& Zeitraffermodus wechseln.
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Sie konnen die Bildfrequenz fiir die Aufnahme
festlegen, indem Sie eine belegbare Taste
gedriickt halten, um den Einstellungsbildschirm
fiir die Aufzeichnungsbildfrequenz aufzurufen.

Aufzeichnung mit Zeitlupe und Zeitraffer

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Wenn Sie mit der Aufnahme beginnen, wechselt
die Anzeige ,,S&Q Stby* zu ,,S&Q @Rec*.

» Wiihrend der Aufzeichnung mit Zeitlupe/Zeitraffer
konnen Sie die Einstellung Frame Rate nicht éndern.
Um die Einstellungen zu @ndern stoppen Sie zunéchst
die Aufnahme.

* Die Aufnahmeriickschau wird nicht wihrend der
Aufzeichnung mit Zeitlupe/Zeitraffer unterstiitzt.

» Wihrend der Aufzeichnung mit Zeitlupe/Zeitraffer
(Seite 89) wird der Timecode im Rec Run-Modus
aufgezeichnet.

* Wenn Sie mit einer geringen Bildfrequenz aufnehmen,
setzt der Camcorder die Aufnahme ggf. noch einige
Sekunden fort, nachdem Sie die Aufnahmetaste
gedriickt haben, um die Aufnahme anzuhalten.

Stoppen Sie zum Beenden die Aufnahme.

Beenden des Zeitlupen/Zeitraffer-Modus

Setzen Sie wihrend der Aufnahmebereitschaft
S&Q Motion >Setting entweder im Recording-
Menii auf Off oder driicken Sie die belegbare
Taste, der die Funktion S&Q Motion zugewiesen
ist.

Simultanaufzeichnung in zwei
Einschiiben (Simul Rec)

Es ist moglich, auf Speicherkarte A und B
gleichzeitig aufzuzeichnen.

Konfiguration vor der Aufzeichnung

Konfigurieren Sie vor der Aufzeichnung die
Funktion Simul Rec (Seite 90) im Recording-
Menii.

* 2-slot Simul Rec kann nicht gleichzeitig mit Interval
Rec, Clip Continuous Rec, Picture Cache Rec oder
S&Q Motion auf On gesetzt werden. Wenn die
Simultanaufzeichnung in 2 Einschiiben auf On gesetzt
wird, werden diese anderen Aufzeichnungsmodi auf
Off gesetzt.



Aufnehmen im Modus fiir
Simultanaufzeichnung in 2 Einschiiben

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Verwenden Sie fiir die Simultanaufzeichnung in 2
Einschiiben Speicherkarten gleichen Typs und
gleicher GroBe.

Simultanaufzeichnung in 2 Einschiiben kann nicht
wihrend der Aufzeichnung, Wiedergabe oder
Miniaturbildanzeige festgelegt werden.

Wenn der Speicherplatz auf einer Speicherkarte in
einem Einschub zur Neige geht und der andere
Einschub eine beschreibbare Speicherkarte enthilt,
wird die Aufzeichnung normal fortgesetzt. Wenn Sie
die Speicherkarten bei normaler kontinuierlicher
Aufzeichnung wechseln, stehen die
Simultanaufzeichnung und die automatische
Aufzeichnungsfortsetzung nicht zur Verfiigung.
Wenn Simultanaufzeichnung in 2 Einschiiben startet
und nur in einem Einschub ein Medium eingesetzt ist
oder das Medium in einem Einschub voll ist, wird nur
auf dem aufnahmebereiten Medium Video
aufgenommen.

Stoppen Sie zum Beenden die Aufnahme.

Aufheben der Simultanaufzeichnung in 2
Einschiiben
Stellen Sie im Aufzeichnungsbereitschaftsmodus

Simul Rec >Setting im Recording-Menii auf Off.

Andern der Einstellung fiir die
Aufnahmetaste und die Aufnahmetaste
am Griff

Sie konnen mit den Aufnahmetasten am Griff
oder am seitlichen Griff die Aufnahme auf die
Speicherkarten in den beiden Einschiiben
unabhingig voneinander starten bzw. stoppen.
StandardmiBig wird durch Driicken einer der
Tasten die Aufnahme auf Speicherkarte A und
auf Speicherkarte B gleichzeitig gestartet bzw.
gestoppt.
* Rec Button:[ A » Handle Rec
Button:[ A ] [ B |

Andern der Einstellung

Wiihlen Sie Simul Rec >Rec Button Set im
Recording-Menii aus.
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Rec Button Set Tasten und

Speicherkarten

Durch Driicken einer dieser
Tasten wird die simultane
Auszeichnung auf
Speicherkarte A und
Speicherkarte B gestartet
bzw. angehalten.

Rec Button:| A »
Handle Rec
Button: B

Die Aufnahme auf
Speicherkarte A wird mit der
Aufnahmetaste, die
Aufnahme auf Speicherkarte
B wird mit der
Aufnahmetaste am Griff
gestartet bzw. gestoppt.

Rec Button:

Handle Rec

Button:| B »

Die Aufnahme auf
Speicherkarte B wird mit der
Aufnahmetaste, die
Aufnahme auf Speicherkarte
A wird mit der
Aufnahmetaste am Griff
gestartet bzw. gestoppt.

Rec Button:| B »

Handle Rec

Button:

High Dynamic Range (HDR)-
Aufnahme

Sie konnen fiir die Bildgebung den High
Dynamic Range (HDR)-Modus festlegen, um
Bilder mit einem zu BT.20202 dquivalenten
Farbraum und erweitertem Dynamikbereich
aufzunehmen und auszugeben.

* Wird nicht fiir DVCAM-Dateiformate unterstiitzt.

Festlegen des Dynamikbereichs

Setzen Sie Base Setting (Seite 96) >Shooting
Mode im System-Menii auf HDR, um den High
Dynamic Range-Modus festzulegen.

HLG-Typeinstellungen

Wenn der High Dynamic Range-Modus
ausgewdhlt ist, konnen Sie den HLG-Typ
festlegen.

Niheres dazu finden Sie unter (Seite 77).

Einstellung des Gamma-Anzeigeassistenten
Die LCD-/Sucherbildschirme des Camcorders
sind nicht HDR-kompatibel und nicht zur
Anzeige von HDR geeignet. Dementsprechend
kann die Erkennbarkeit der Anzeige zum
leichteren Aufnehmen mithilfe der Gamma-
Anzeigeassistentenfunktion verbessert werden.



Die Einstellung des Gamma-Anzeigeassistenten
konnen Sie mithilfe von Gamma Display Assist
(Seite 87) im LCD/VF-Menii dndern.

¢ Der Gamma-Anzeigeassistent wird nur fiir den LCD-/
Sucherbildschirm verwendet. Die Einstellungen
wirken sich nicht auf das aufgezeichnete oder
ausgegebene Bild aus.

Speichern und Laden von
Konfigurationsdaten

Sie konnen Einstellungen des Einstellmeniis im
internen Speicher des Camcorders oder auf SD-
Karten im UTILITY SD/MS-Einschub und
,Memory Stick“-Medien speichern. Dadurch
konnen Sie schnell auf einen fiir die jeweilige
Situation geeigneten Satz Meniieinstellungen
zuriickgreifen.

Konfigurationsdaten werden in den folgenden
Kategorien gespeichert.

Benutzerdateien

In Benutzerdateien werden die Einstelloptionen
und Daten des benutzerdefinierbaren User-
Meniis gespeichert.

Sie konnen auf einer SD-Karte oder einem
,.Memory Stick“-Medium bis zu 64 Dateien
speichern.

Indem Sie derartige Dateien in den Speicher des
Camcorders laden, konnen Sie das User-Menii
entsprechend einrichten.

ALL-Dateien (alle Einstellungen)

In ALL-Dateien werden die Konfigurationsdaten
aller Meniis gespeichert. Sie konnen auf einer
SD-Karte oder einem ,,Memory Stick“-Medium
bis zu 64 Dateien speichern.

« Geriitespezifische Daten (Schattierung, Ausgabepegel
und andere Daten, die eine Einstellung auf das
spezifische Gerit erfordern) werden nicht gespeichert.

Szenendateien

In Szenendateien werden Einstellungen der fiir

Szenen konfigurierten Paint-Optionen

gespeichert. Sie konnen bis zu fiinf Dateien im

internen Speicher des Camcorders und bis zu

64 Dateien auf einer SD-Karte oder einem

~Memory Stick“-Medium speichern.

Medien, auf denen Konfigurationsdaten
gespeichert werden kdnnen

SDXC-Speicherkarten*

SDHC-Speicherkarten*

SD-Speicherkarten*

»Memory Stick PRO-HG Duo*“**

»Memory Stick PRO Duo“**

* In diesem Handbuch mit dem Begriff ,,SD-Karte*
bezeichnet.

*#* In diesem Handbuch mit dem Begriff ,,Memory
Stick* bezeichnet.

Konfigurationsdaten werden in dem folgenden

Verzeichnis auf dem Medium gespeichert.

/PRIVATE/SONY/PRO/CAMERA/PXW-

Z190V/ (oder PXW-Z190T)

Formatieren (Initialisieren) von Medien

SD-Karten und ,,Memory Stick*-Medien miissen
bei der ersten Verwendung im Camcorder
zunichst formatiert werden.

Eine SD-Karte oder ein ,,Memory Stick*-
Medium zur Verwendung in diesem Camcorder
muss mit der Formatierungsfunktion des
Camcorders formatiert werden. Wenn beim
Einsetzen der SD-Karte oder des ,,Memory
Stick*“-Mediums in den Camcorder eine Meldung
angezeigt wird, muss das Speichermedium
formatiert werden.

1 Setzen Sie die SD-Karte oder das
,»Memory Stick“-Medium mit dem
Etikett nach rechts weisend in den
UTILITY SD/MS-Einschub (Seite 8)
ein.

2 Wiihlen Sie Format Media (Seite 92)
>Utility SD/MS >Execute im Media-
Menii aus. Wihlen Sie beim Anzeigen
einer Bestitigungsmeldung erneut
Execute.

Wihrend der Formatierung werden eine
Meldung und ein Fortschrittsstatus
angezeigt, und die Zugriffsanzeige leuchtet
rot.

Nach Abschluss der Formatierung wird eine
Abschlussmeldung angezeigt. Driicken Sie
die Taste SET oder den Regler SEL/SET, um
die Meldung auszublenden.

* Beim Formatieren einer SD-Karte oder eines
,.Memory Stick“-Mediums werden alle Daten



geldscht. Die Daten konnen nicht wiederhergestellt
werden.

Uberpriifen der Restkapazitat

Die Restkapazitit auf einer SD-Karte oder einem
»Memory Stick“~-Medium kann im Bildschirm
,Media Status* (Seite 14) tiberpriift werden.

Wenn die SD-Karte oder das ,,Memory Stick“-
Medium geschiitzt ist, wird eine (7)-Markierung
angezeigt.

Um mit dem Camcorder formatierte Medien im
Einschub eines anderen Gerits zu verwenden, sichern
Sie die Daten und formatieren Sie das Medium im zu
verwendenden Geriit.

Speichern einer Benutzerdatei/ALL-Datei

1 Setzen Sie die SD-Karte oder das
,,Memory Stick*“-Medium mit dem
Etikett nach rechts weisend in den
UTILITY SD/MS-Einschub (Seite 8)
ein.

2 Im Fall einer Benutzerdatei wihlen Sie
User File (Seite 93) >Save Utility SD/MS
>Execute im File-Menii aus.

Im Fall einer ALL-Datei wiihlen Sie All
File >Save Utility SD/MS >Execute im
File-Menii aus.

Es wird ein Bildschirm mit einem
Speicherort fiir Dateien angezeigt.

3 Wiihlen Sie mithilfe der Tasten 4/¥/«/»
oder dem Regler SEL/SET im Fenster
fiir den Speicherort eine ,,No File‘“-Zeile
aus und driicken Sie die Taste SET oder
den Regler SEL/SET.

Wenn Sie eine Zeile mit einer File ID
auswihlen, wird dadurch die ausgewihlte
Datei iiberschrieben.

Die File ID wird automatisch erzeugt; Sie
konnen sie jedoch verdndern.

4  Wiihlen Sie mithilfe der Tasten 4/%/«/+
oder dem Regler SEL/SET auf dem
Bestitigungsbildschirm Execute aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.
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Laden einer Benutzerdatei/ALL-Datei

1 Setzen Sie die SD-Karte oder das
,,Memory Stick‘-Medium mit der
gespeicherten Datei mit dem Etikett
nach rechts weisend in den
UTILITY SD/MS-Einschub (Seite 8)
ein.

2 Im Fall einer Benutzerdatei wihlen Sie
User File (Seite 93) >Load Utility SD/
MS >Execute im File-Menii aus.

Im Fall einer ALL-Datei wiihlen Sie All
File >Load Utility SD/MS >Execute im
File-Menii aus.

Es wird ein Bildschirm mit einer Dateiliste
angezeigt.

3 Wiihlen Sie mithilfe der Tasten #/%/«/»
oder dem Regler SEL/SET die zu
ladende Datei aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Ein Bestitigungsbildschirm wird angezeigt.

4 Wihlen Sie Execute mithilfe der Tasten
4/¥%/«/» oder dem Regler SEL/SET aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

¢ Nach dem Laden von Konfigurationsdaten startet der
Camcorder automatisch neu.

* Wenn All File >Load Network Data im File-Menii auf
Off gesetzt ist, werden alle Einstellungen der ALL-
Datei bis auf die Einstellungen des Network-Meniis
geladen.

Speichern einer Szenendatei

Im internen Speicher

1 Wihlen Sie Scene File >Store Internal
Memory >Execute im File-Menii aus
(Seite 93).

Es wird ein Bildschirm mit einer
Szenendateiliste angezeigt.

Falls die File ID auf das Ziel ,,Standard*
gesetzt ist, werden vorkonfigurierte
Standardeinstellungen gespeichert.

2 Wiihlen Sie mithilfe der Tasten 4/¥/«/%
oder dem Regler SEL/SET einen



Speicherort aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Die Szenendatei wird am ausgewéhlten
Speicherort gespeichert, wobei eine ggf.
vorhandene Datei iiberschrieben wird.

Wiihlen Sie mithilfe der Tasten #/¥/«/»
oder dem Regler SEL/SET auf dem
Bestitigungsbildschirm Execute aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Auf einer SD-Karte oder einem ,,Memory Stick“-
Medium

1

Setzen Sie die SD-Karte oder das
,,Memory Stick‘‘-Medium mit dem
Etikett nach rechts weisend in den
UTILITY SD/MS-Einschub (Seite 8)
ein.

Wiihlen Sie Scene File >Save Utility SD/
MS >Execute im File-Menii aus

(Seite 93).

Es wird ein Bildschirm mit einem
Speicherort fiir Szenendateien angezeigt.

Waihlen Sie mithilfe der Tasten 4/¥/«/%
oder dem Regler SEL/SET im Fenster
fiir den Speicherort eine ,,No File*“-Zeile
aus und driicken Sie die Taste SET oder
den Regler SEL/SET.

Wenn Sie eine Zeile mit einer File ID
auswihlen, wird dadurch die ausgewihlte
Datei iiberschrieben.

Die File ID wird automatisch erzeugt; Sie
konnen sie jedoch verindern.

Wiihlen Sie mithilfe der Tasten #/¥/«/»
oder dem Regler SEL/SET auf dem
Bestitigungsbildschirm Execute aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Laden einer Szenendatei

Aus dem internen Speicher

1

Wiihlen Sie Scene File >Recall Internal
Memory >Execute im File-Menii aus
(Seite 93).

Es wird ein Bildschirm mit einer
Szenendateiliste angezeigt.
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2 Wiihlen Sie mithilfe der Tasten 4/%/«/%
oder dem Regler SEL/SET die zu
ladende Datei aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Ein Bestitigungsbildschirm wird angezeigt.

3 Wiihlen Sie Execute mithilfe der Tasten
4/¥%/«/» oder dem Regler SEL/SET aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Szenendateien konnen auch mithilfe vom
Direktmenti (Seite 34) in den Camcorder
geladen werden.

Von einer SD-Karte oder einem ,,Memory Stick“-
Medium

1 Setzen Sie die SD-Karte oder das
,,Memory Stick‘-Medium mit der
gespeicherten Datei mit dem Etikett
nach rechts weisend in den
UTILITY SD/MS-Einschub (Seite 8)
ein.

2 Wihlen Sie Scene File >Load Utility
SD/MS >Execute im File-Menii aus
(Seite 93).

Es wird ein Bildschirm mit einer
Szenendateiliste angezeigt.

3 Wiihlen Sie mithilfe der Tasten 4/%/«/%
oder dem Regler SEL/SET die zu
ladende Datei aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Ein Bestitigungsbildschirm wird angezeigt.

4  Wihlen Sie Execute mithilfe der Tasten
4/¥%/«/%» oder dem Regler SEL/SET aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Andern der File ID

1 Im Fall einer Benutzerdatei wiihlen Sie
User File >File ID im File-Menii aus
(Seite 93).

Im Fall einer ALL-Datei wiihlen Sie All
File >File ID im File-Menii aus

(Seite 93).

Im Fall einer Szenendatei wiihlen Sie
Scene File >File ID im File-Menii aus
(Seite 93).



Ein Bildschirm zum Bearbeiten der File ID
wird angezeigt.

2 Wiihlen Sie mithilfe der Tasten 4/¥/«/»
oder dem Regler SEL/SET ein Zeichen
aus und driicken Sie die Taste SET oder
den Regler SEL/SET.

3 Wiederholen Sie Schritt 2 bei Bedarf.

Wiihlen Sie zum Abschluss der
Zeicheneingabe mithilfe der Tasten 4/
¥/«/% oder dem Regler SEL/SET
,,Done‘ aus und driicken Sie die Taste
SET oder den Regler SEL/SET.

Abrufen von
Standortinformationen (GPS)

Standort- und Uhrzeitinformationen des mit
aktivierter Positionierung aufgenommenen
Videos werden auf das in den Karteneinschub des
Camcorders eingesetzte Medium gespeichert und
konnen als SDI ausgegeben werden.

1. Driicken Sie im Bereitschaftsmodus die
Taste MENU.

2. Setzen Sie GPS im System-Menii auf On.
MO wird angezeigt, wihrend der
Camcorder nach GPS-Satelliten sucht. Wenn
die Position ermittelt wurde, werden bei der
Videoaufzeichnung Standortinformationen
erfasst.

« Das angezeigte Symbol édndert sich je nach
Signalempfang von den GPS-Satelliten.

Positionie- Anzeige Status des GPS-
rungsstatus Empfangs

Ausgeschaltet Keine GPS ist auf Off gesetzt,
Anzeige oder es ist ein Fehler

aufgetreten.
Positionsda- NO GPS Es konnten keine
ten nicht ver-  SIGNAL Standortinformationen
fligbar ermittelt werden, weil kein

GPS-Signal empfangen
wurde. Begeben Sie sich
an einen Ort mit
unversperrtem Blick in
den Himmel.

Positionie- Anzeige Status des GPS-
rungsstatus Empfangs

Satelliten Satelliten werden gesucht.
MO b
werden o+ Dieser Vorgang kann
gesucht mehrere Minuten in
Anspruch nehmen.

Positionierung P Der Camcorder empfingt
'\I ein schwaches GPS-
Signal.

0 Der Camcorder empfingt
Ml cin GPS-Signal.
Standortinformationen
konnen abgerufen werden.

Der Camcorder empfingt
ein starkes GPS-Signal.
Standortinformationen
konnen abgerufen werden.
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* GPS ist standardmiBig auf On gesetzt. Wenn
die Positionierung aktiviert ist, zeichnet der
Camcorder Standort- und Zeitinformationen zu
den Videos auf. Zum Aufnehmen von
Positionsinformationen setzen Sie GPS auf On.
Nach dem Einschalten des Camcorders kann es
eine Weile dauern, bis die Positionierung
gestartet wird.

Falls auch nach mehreren Minuten noch kein
Positionierungssymbol angezeigt wird, liegt

moglicherweise ein Problem beim
Signalempfang vor. Sie konnen die Aufnahme
ohne Standortinformationen starten oder an
einen Ort mit unversperrtem Blick zum Himmel
wechseln. Wenn das Positionierungssymbol
wihrend der Aufnahme nicht angezeigt wird,
werden auch keine Standortinformationen
aufgezeichnet.

Bei Innenaufnahmen oder Aufnahmen in der
Nihe hoher Gebilde kann der Camcorder
moglicherweise kein GPS-Signal empfangen.
Begeben Sie sich an einen Ort mit

unversperrtem Blick in den Himmel.

Die Aufzeichnung von Standortinformationen
kann abreifien, wenn die Signalstirke abnimmt,
selbst wenn ein Positionierungssymbol
angezeigt wird.



Proxy-Aufzeichnung

Sie konnen Proxy-Daten auf einer SD-Karte im
UTILITY SD/MS-Einschub aufzeichnen,
wihrend Sie auf die Speicherkarten in den
Speicherkarteneinschiiben aufzeichnen.

Unterstiitzte SD-Karten

SDXC-Speicherkarten*
(Geschwindigkeitsklasse: 4 oder hoher)
SDHC-Speicherkarten*
(Geschwindigkeitsklasse: 4 oder hoher)
SD-Speicherkarten*
(Geschwindigkeitsklasse: 4 oder hoher)

* In diesem Handbuch mit dem Begriff ,,SD-Karte*
bezeichnet.

Formatieren (Initialisieren) von
SD-Karten

SD-Karten miissen bei der ersten Verwendung im
Camcorder zunidchst formatiert werden.
SD-Karten, die im Camcorder verwendet werden
sollen, sind mit der Formatierfunktion des
Camcorders zu formatieren. Wenn beim
Einsetzen einer SD-Karte in den Camcorder eine
Meldung angezeigt wird, muss die SD-Karte
formatiert werden.

1 Setzen Sie die SD-Karte mit dem Etikett
nach rechts weisend in den UTILITY
SD/MS-Einschub (Seite 8) ein.

2 Wihlen Sie Format Media (Seite 92)
>Utility SD/MS >Execute im Media-
Menii aus. Wihlen Sie beim Anzeigen
einer Bestitigungsmeldung erneut
Execute.

Wiihrend der Formatierung werden eine
Meldung und ein Fortschrittsstatus
angezeigt, und die Zugriffsanzeige leuchtet
rot.

Nach Abschluss der Formatierung wird eine
Abschlussmeldung angezeigt. Driicken Sie
die Taste SET oder den Regler SEL/SET, um
die Meldung auszublenden.
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¢ Beim Formatieren einer SD-Karte gehen alle Daten auf
der Karte verloren. Die Karte kann nicht
wiederhergestellt werden.

¢ SDXC-Karten werden mit exFAT, SDHC-Karten mit
FAT32 und SD-Karten mit FAT formatiert.

Uberpriifen der Restkapazitat

Die Restkapazitit auf einer SD-Karte kann im
Bildschirm ,,Media Status* (Seite 14) tiberpriift
werden.

* Wenn die SD-Karte geschiitzt ist, wird ein @
angezeigt.

Verwenden eines im Camcorder formatierten

Mediums im Einschub eines anderen Gerits

Erstellen Sie zunichst eine Sicherheitskopie der Karte,
und formatieren Sie die Karte dann in dem Geriit, in dem
sie verwendet werden soll.

Proxy-Aufnahme (Proxy Rec)

Konfiguration vor der Aufzeichnung

1 Setzen Sie Proxy Rec >Setting im
Recording-Menii auf On.

2 Setzen Sie die SD-Karte mit dem Etikett
nach rechts weisend in den UTILITY
SD/MS-Einschub (Seite 8) ein.

» Proxy Rec kann nicht gleichzeitig mit Interval Rec,
Picture Cache Rec oder S&Q Motion auf On gesetzt
werden. Wenn Proxy Rec auf On gesetzt wird, werden
diese anderen Aufzeichnungsmodi auf Off gesetzt.

Aufnahmen eines Proxy

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.

Driicken Sie die Aufnahmetaste.

Die Integritit der Daten auf der SD-Karte kann nicht
garantiert werden, wenn wihrend des Zugriffs auf die
SD-Karte der Camcorder ausgeschaltet oder die Karte
entnommen wird. Moglicherweise gehen alle Daten
auf der Karte verloren. Stellen Sie stets sicher, dass die
Zugriffsanzeige erloschen ist, bevor Sie den
Camcorder ausschalten oder die SD-Karte entfernen.
Passen Sie auf, dass die SD-Karte beim Einsetzen und
Auswerfen nicht herausfliegt.



Stoppen Sie zum Beenden die Aufnahme.
Wenn die Aufnahme auf Speicherkarten in den
Speicherkarteneinschiiben gestoppt wird, wird
die Proxy-Aufnahme ebenfalls gestoppt.

Andern der Einstellungen fiir die
Proxy-Aufzeichnung

Einstellen der BildgrdBe

Wiihlen Sie Proxy Rec >Proxy Format im
Recording-Menii aus, und legen Sie die
Bildgrofe fest.

Festlegen des Audiokanals

Wihlen Sie Proxy Rec >Audio Channel im
Recording-Menii aus und legen Sie den
Audiokanal fiir die Proxy-Aufzeichnung fest.

Hinweis zur aufgenommenen
Datei

Die Dateinamenerweiterung lautet ,,.mp4*.
Der Timecode wird ebenfalls gleichzeitig
aufgezeichnet.

Speicherzielort der

aufgenommenen Datei

Die aufgenommene Datei wird im Verzeichnis
/PRIVATE/PXROOT/Clip* gespeichert.

Hinweis zum Dateinamen

Der Dateiname besteht aus dem Namen des auf
den Speicherkarten in den

Speicherkarteneinschiiben aufgezeichneten Clips

und einer fortlaufenden Nummernendung.

Bei Simultanaufzeichnung in zwei Einschiiben

erhilt der Clipname von Einschub A Vorrang.

« Die fortlaufende Nummer wird beibehalten, auch
wenn der Camcorder ausgeschaltet wird. Die
fortlaufende Nummer wird auf 0001 zuriickgesetzt,
wenn All Reset ausgefiihrt wird.

Einzelheiten zu Clipnamen siehe Clip Naming

(Seite 93) im Media-Menii.

Aufnehmen von Proxy-Daten
allein

Sie konnen Proxy-Daten unabhiéngig auf einer
SD-Karte im UTILITY SD/MS-Einschub
aufzeichnen, ohne auf eine Speicherkarte in
einem Speicherkarteneinschub aufzuzeichnen.
Das Aufnahmeformat der Proxy-Daten ist
identisch mit dem fiir gleichzeitige
Aufzeichnung.

Der Dateiname wird jedoch aus dem Timecode
zum Startzeitpunkt der Aufnahme gebildet.
Beispiel: Wenn der Timecode zum Startzeitpunkt
der Aufnahme ,,14:30:20:05% ist, wird der
Dateiname ,,14_30_20_05.mp4* gebildet.

Konfiguration vor der Aufzeichnung

1 Weisen Sie die Funktion Proxy Rec
Start/Stop einer belegbaren Taste zu
(Seite 36).

2 Setzen Sie Proxy Rec >Setting im
Recording-Menii auf On.

3 Setzen Sie die SD-Karte mit dem Etikett
nach rechts weisend in den UTILITY
SD/MS-Einschub (Seite 8) ein.

Aufzeichnung lauft

Starten Sie nach dem Vornehmen der
erforderlichen Einstellung die Aufnahme.
Driicken Sie die mit Proxy Rec Start/Stop
belegte belegbare Taste.

Um die Aufzeichnung anzuhalten, driicken Sie
die belegbare Taste.



Verbhinden mit anderen
Geraten iiber LAN

Der Camcorder kann iiber eine LAN-Verbindung
mit Smartphones, Tablets und anderen Geriten
verbunden werden.

Indem Sie eine LAN-Verbindung zwischen
einem Gerit und dem Camcorder herstellen,
konnen Sie mithilfe der Web-Fernbedienung
(Seite 54) oder der Anwendung ,,Content
Browser Mobile* die im Folgenden aufgefiihrten
Funktionen nutzen.
¢ Fernbedienung iiber ein LAN
Sie konnen den Camcorder von einem
Smartphone, Tablet oder Computer aus steuern,
das bzw. der tiber das LAN mit dem Camcorder
verbunden ist.
 Video-Priifung per LAN
Sie konnen das Kamerasignal oder das
Wiedergabevideo des Camcorders als Stream
(H.264) iibertragen lassen und mithilfe der
Anwendung ,,Content Browser Mobile* auf
einem Geriit iiber ein LAN priifen.

Anwendung ,,Content Browser Mobile*

Sie konnen den Camcorder vom
Geritebildschirm aus wihrend der Priifung
fernsteuern und die Einstellungen des
Camcorders mit der Anwendung ,,Content
Browser Mobile* konfigurieren.

Informationen zur Anwendung ,, Content Browser
Mobile* erhalten Sie beim zustindigen Sony-
Kundendienst oder einer Handelsvertretung.

Herstellen einer Verbhindung im
WLAN-Zugangspunktmodus
Der Camcorder fungiert als Zugangspunkt und

stellt eine Verbindung zu einem Gerit iiber ein
WLAN her.
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Smartphone/
Tablet

Computer

Schnelles Herstellen einer Verbindung
mit einem NFC-kompatiblen Gerét

NFC-fahige Gerite konnen mithilfe der
Nahfelderkennung per Beriihrung verbunden
werden.

1 Offnen Sie auf dem Geriit das Menii
[Settings], wiihlen Sie [More], und
aktivieren Sie das Kontrollkiistchen
neben [NFC].

2 Schalten Sie den Camcorder ein.

3 Aktivieren Sie die NFC-Funkion.

Um den NFC-Verbindungsmodus zu
aktivieren, halten Sie eine mit NFC belegte
belegbare Taste drei Sekunden lang gedriickt
oder wihlen Sie Wireless LAN >NFC im
Network-Menii aus.

Die NFC-Funktion steht nur zur Verfiigung,
solange [N auf dem Bildschirm erscheint.

4 Beriihren Sie mit dem Gerit den
Camcorder.
Das Geriit verbindet sich mit dem Camcorder
und ,,Content Browser Mobile* wird
gestartet.



» Deaktivieren Sie vorher den Schlafmodus und die
Bildschirmsperre.

 Beriihren Sie das Gerit, und halten Sie es still, bis die
Anwendung ,,Content Browser Mobile* gestartet wird
(ca. 1 bis 2 Sekunden).

Herstellen der Verbindung mit einem
WPS-kompatiblen Gerat

Gerite, die WPS unterstiitzen, konnen mithilfe
von WPS verbunden werden.

1 Wiihlen Sie Wireless LAN >Setting
>Access Point Mode im Network-Menii
aus.

2 Wiihlen Sie Wireless LAN >WPS
>Execute im Network-Menii aus.

3 Aktivieren Sie in den Netzwerk- oder
WLAN:-Einstellungen des Geriits die
WLAN-Funktion.

4 Wiihlen Sie am zu verbindenden Ger:it
aus der SSID-Liste der WLAN-
Netzwerke die SSID des Camcorders
und dann WPS Push Button in den
Optionen aus.

¢ Das Verfahren hingt vom jeweiligen Gerit ab.

« Informationen zu SSID und Passwort des Camcorders
finden Sie unter AP Mode Settings (Seite 95) >Camera
SSID & Password im Network-Menii.

O Rufen Sie die Web-Fernbedienung auf
(Seite 54). Alternativ stellen Sie die
Verbindung mithilfe der Anwendung
,,Content Browser Mobile‘ her.
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Herstellen der Verbindung durch Eingabe
von SSID und Passwort am anderen
Gerat

Sie konnen die Verbindung zwischen dem
Camcorder und einem Gerit herstellen, indem Sie
an diesem Gerit die SSID und das Passwort
eingeben.

1 Wiihlen Sie Wireless LAN >Setting
>Access Point Mode im Network-Menii
aus.

2 Aktivieren Sie in den Netzwerk- oder
WLAN:-Einstellungen des Geriits die
WLAN-Funktion.

3 Verbinden Sie das Gerit mit dem
Camcorder, indem Sie die SSID des
Camcorders aus der SSID-Liste unter
Wi-Fi Network auswéhlen und das
Passwort eingeben.

Informationen zu SSID und Passwort des
Camcorders finden Sie unter AP Mode
Settings (Seite 95) >Camera SSID &
Password im Network-Menii.

¢ Das Verfahren hingt vom jeweiligen Geriit ab.

4 Rufen Sie die Web-Fernbedienung auf
(Seite 54). Alternativ stellen Sie die
Verbindung mithilfe der Anwendung
,»Content Browser Mobile‘* her.

Herstellen einer Verbindung im
WLAN-Stationsmodus

Der Camcorder stellt eine Verbindung zu einem
vorhandenen Zugangspunkt des WLAN als
Client her. Der Camcorder und das andere Gerit
werden iiber den Zugangspunkt verbunden.

Im Verlauf sind die letzten zehn Zugangspunkte
aufgefiihrt, mit denen eine Verbindung
hergestellt wurde.

Der Verbindungsverlauf wird in einer ALL-Datei
gespeichert, die Kennworter werden jedoch nicht
gespeichert. Beim néchsten Herstellen der
Verbindung nach dem Laden der ALL-Datei
muss das Passwort eingegeben werden.



Smartphone/
Tablet

Computer

Zugangs-
punkt

Verhindung mit einem Zugangspunkt
mittels WPS herstellen

Wenn der Zugangspunkt mit der WPS-Funktion
kompatibel ist, konnen Sie die Verbindung zum
Zugangspunkt mit einfachen Einstellungen
herstellen.

1 Schalten Sie den Zugangspunkt ein.
2 Schalten Sie den Camcorder ein.

3 Wihlen Sie Wireless LAN >Setting
>Station Mode im Network-Menii aus.

4 Wiihlen Sie Wireless LAN >WPS
>Execute im Network-Menii aus.

O Driicken Sie die WPS-Taste am
Zugangspunkt.
Einzelheiten zur Funktion der WPS-Taste
finden Sie in der Bedienungsanleitung zum
Zugangspunkt.
Wenn die Verbindung erfolgreich hergestellt
wurde, signalisiert die
Netzwerkstatusanzeige auf dem LCD-/
Sucherbildschirm eine Stirke von 1 oder
hoher.
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* Wenn die Verbindung fehlschligt, filhren Sie die
Schritte ab Schritt 1 erneut aus.

6 Verbinden Sie das andere Geriit mit
dem Zugangspunkt.
Einzelheiten zum Herstellen der Verbindung
finden Sie in der Bedienungsanleitung zum
anderen Gerit.

T Rufen Sie die Web-Fernbedienung auf
(Seite 54). Alternativ stellen Sie die
Verbindung mithilfe der Anwendung
,,Content Browser Mobile‘ her.

Verhindung mit einem Zugangspunkt
mittels automatischer
Netzwerkerkennung oder manuell
herstellen

Sie konnen iiber das Einstellmenii die
Verbindung mit einem gewiinschten
Zugangspunkt konfigurieren.

Sie konnen die Verbindung mit einem
gewiinschten Zugangspunkt mittels
automatischer Netzwerkerkennung
konfigurieren.

Verhinden mithilfe der automatischen
Netzwerkerkennung

1 Fiihren Sie die Schritte 1 bis 3 unter
,, Verbindung mit einem Zugangspunkt
mittels WPS herstellen* (Seite 50) durch.

2 Wiihlen Sie ST Mode Settings >Scan
Networks (Seite 95) >Execute im
Network-Menii aus.

Der Camcorder beginnt mit der Erkennung
von Verbindungszielen.

Die erkannten Verbindungsziele werden in
der Liste Scan Networks angezeigt.

3 Wiihlen Sie mithilfe der Tasten #/%/</»
oder dem Regler SEL/SET eine
Verbindung aus und driicken Sie die
Taste SET oder den Regler SEL/SET.
Daraufhin wird ein Bildschirm mit
Einzelheiten zum Netzwerk (Zugangspunkt)
angezeigt. Die ausgewéhlte Verbindung wird
unter SSID angezeigt.



Wiihlen Sie Password aus und legen Sie
das Passwort auf dem
Passworteingabebildschirm fest.

Falls bereits vor der automatischen
Netzwerkerkennung eine Verbindung
hergestellt wurde, wird nach der Auswahl
einer SSID der Passwortbildschirm
angezeigt.

Legen Sie das Passwort fest, um zum
Bildschirm mit Einzelheiten zum Netzwerk
(Zugangspunkt) zuriickzukehren.

Konfigurieren Sie die folgenden
Verbindungseinstellungen.

« DHCP
Legen Sie die DHCP-Einstellung fest.
Wenn Sie die Option auf On setzen, wird
die IP-Adresse dem Camcorder
automatisch zugewiesen.
Wenn Sie die IP-Adresse dem Camcorder
manuell zuweisen wollen, stellen Sie Off
ein.
IP Address
Geben Sie die IP-Adresse des Camcorders
ein. Diese Einstellung steht nur zur
Verfiigung, wenn DHCP auf Off eingestellt
ist.
Subnet Mask
Geben Sie die Subnetzmaske des
Camcorders ein.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf Off eingestellt ist.
Gateway
Geben Sie das Standard-Gateway fiir den
Zugangspunkt ein.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf Off eingestellt ist.
DNS Auto
Mit dieser Einstellung konnen Sie DNS
automatisch abrufen.
‘Wenn Sie On einstellen, wird die DNS-
Serveradresse automatisch abgerufen.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf On eingestellt ist.
Primary DNS Server
Geben Sie den primédren DNS-Server fiir
den Zugangspunkt ein.
Diese Einstellung steht nur zur Verfiigung,
wenn DNS Auto auf Off eingestellt ist.
¢ Secondary DNS Server
Geben Sie den sekundédren DNS-Server fiir
den Zugangspunkt ein.
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Diese Einstellung steht nur zur Verfiigung,
wenn DNS Auto auf Off eingestellt ist.

6 Wi hlen Sie abschlieBend Connect aus,

um die Verbindung mit dem
Zugangspunkt herzustellen.

Manuell verbinden

1

Fiihren Sie die Schritte 1 bis 3 unter
,, Verbindung mit einem Zugangspunkt
mittels WPS herstellen* (Seite 50) durch.

Wiihlen Sie ST Mode Settings >Manual
Register (Seite 95) >Execute im
Network-Menii aus.

Daraufhin wird ein Bildschirm mit
Einzelheiten zum Netzwerk (Zugangspunkt)
angezeigt.

Konfigurieren Sie die folgenden
Verbindungseinstellungen.

* SSID
Geben Sie die SSID fiir den Zugangspunkt
ein.
* Security
Wihlen Sie die Verschliisselungsmethode
aus.
Password
Geben Sie das Passwort fiir den
Zugangspunkt ein.
Verfiigbar, wenn Security nicht auf None
gesetzt ist.
DHCP
Legen Sie die DHCP-Einstellung fest.
Wenn Sie die Option auf On setzen, wird
die IP-Adresse dem Camcorder
automatisch zugewiesen.
Wenn Sie die IP-Adresse dem Camcorder
manuell zuweisen wollen, stellen Sie Off
ein.
IP Address
Geben Sie die IP-Adresse des Camcorders
ein. Diese Einstellung steht nur zur
Verfiigung, wenn DHCP auf Off eingestellt
ist.
Subnet Mask
Geben Sie die Subnetzmaske des
Camcorders ein.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf Off eingestellt ist.
* Gateway
Geben Sie die Adresse des Gateway ein.



Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf Off eingestellt ist.

DNS Auto

Mit dieser Einstellung konnen Sie DNS
automatisch abrufen.

Wenn Sie On einstellen, wird die DNS-
Serveradresse automatisch abgerufen.
Diese Einstellung steht nur zur Verfiigung,
wenn DHCP auf On eingestellt ist.
Primary DNS Server

Geben Sie die Adresse des primédren DNS-
Servers ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DNS Auto auf Off eingestellt ist.
Secondary DNS Server

Geben Sie die Adresse des sekundiren
DNS-Servers ein.

Diese Einstellung steht nur zur Verfiigung,
wenn DNS Auto auf Off eingestellt ist.

Wiihlen Sie abschlieBend Connect aus,
um die Verbindung mit dem
Zugangspunkt herzustellen.
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Liste der Funktionen fiir Netzwerkverbindungen

In der folgenden Tabelle wird aufgefiihrt, welche Netzwerkfunktionen in den Netzwerkverbindungsmodi
verfiigbar sind.

Netzwerkfunktion Netzwerkverbindungsmodus
Access Point Station Ausgeschaltet
Priifung ob ob X
(Seite 48)
Fernbedienung des Camcorders ob ob X
(Seite 54)

1) Funktionen eines iiber ein Netzwerk mit dem Camcorder verbundenen Geriits
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Verwenden der Web-
Fernbedienung

Sie konnen von einem Tablet oder Computer aus
iiber eine Netzwerkverbindung auf die im
Camcorder integrierte Web-Fernbedienung
zugreifen.

Mithilfe der Web-Fernbedienung konnen Sie den
Camcorder fernbedienen. Sie konnen mit einem
verbundenen Gerit die Aufnahme starten/stoppen
und Aufnahmeeinstellungen vornehmen. Diese
Funktion ist niitzlich, wenn der Camcorder an
einem entfernten Ort wie z. B. oben auf einem
Kran usw. platziert wird.

Bildschirm ,,Camera Control”

Bildschirm ,,Main*

= Camera Control * Connected

00:00:00.00 e mmmm
12003 .

7y

Main Cursor

Playback

v
1

Assign

Lock=>

ND 8...... 116,

11 CLOSE

Near

S8Q FPS
off
Auto Tris
off

* Status
» Taste zum Starten/Stoppen der Aufzeichnung
¢ ND-Regler

« Iris-Regler

* Focus-Regler

¢ Zoom-Regler

« Aufnahmeeinstellungen
S&Q FPS, Shutter, White, Gamma, Auto Iris, Auto
Shutter, AGC, Auto ND Filter, ATW, Gain, Color
Bars, Auto White
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Bildschirm ,,Playback‘

= Camera Control

00:00:00.00 =

Assign

* Status
« Schaltflichen zur Wiedergabesteuerung:
F Rev, Play/Pause, F Fwd, Prev, Stop, Next

Bildschirm ,,Cursor

= Camera Control
000_0001

00:00:00.00 == e
12 34

Assign Main  Playback  Ct

Menu

Thumbnail

Status

* Status

« Schaltflichen zur Cursorbedienung:
Up, Left, Set, Right, Down, Cancel/Back, Menu,
Status, Thumbnail

Bildschirm ,,Assign*

= Camera Control

agmin

00:00:00.00 =

( 998min

Playback  Cursor

@ sional
@ Direct Menu

@ or
-

* Status
* Belegbare Tasten:
Belegbare Tasten 1 bis 8

Aufrufen der Web-Fernbedienung

1 Stellen Sie eine Netzwerkverbindung
(Seite 48) zwischen Camcorder und
Geriit her.



2  Starten Sie auf dem Geriit einen
Browser und rufen Sie die Seite ,,http://
IP-Adresse des Camcorders/rm.html*
auf,

Beispiel: Wenn die IP-Adresse
192.198.122.1 lautet, geben Sie http://
192.168.1.1/rm.html in die Adressleiste ein.
Sie konnen die IP-Adresse des Camcorders
auf dem Network Status-Bildschirm
tiberpriifen (Seite 15).

3 Geben Sie den Benutzernamen und das
Passwort (Network-Menii — Access
Authentication — User Name und
Password) im Browser ein.

Bei erfolgreicher Verbindung wird der
Bildschirm der Web-Fernbedienung auf dem
Gerit angezeigt.

Sie kénnen den Camcorder dann iiber den
Bildschirm der Web-Fernbedienung
bedienen.

Die Tastenfunktion kann deaktiviert werden,
indem der Schalter Lock nach rechts
geschoben wird.

In den unten aufgefiihrten Fillen stimmt der

Bildschirm der Web-Fernbedienung moglicherweise

nicht mit den Camcorder-Einstellungen iiberein.

Aktualisieren Sie in diesem Fall das Browserfenster.

— Der Camcorder wird bei bestehender Verbindung
neu gestartet.

— Der Camcorder wird bei bestehender Verbindung
direkt bedient.

— Das Gerit wurde erneut verbunden.

— Die Browser-Schaltflichen ,,Vorwirts* oder
,Zuriick® wurden verwendet.

Wenn das WLAN-Signal zu schwach ist, funktioniert

die Web-Fernbedienung moglicherweise nicht.

Gerate, die mit der Web-Fernbedienung
kompatibel sind

Zur Konfiguration und Steuerung des
Camcorders konnen Tablets oder Computer
verwendet werden. Die unterstiitzten Geriite,
Betriebssysteme und Browser sind in der
folgenden Tabelle aufgefiihrt:

Gerit Betriebssystem Browser

Tablet Android 6/7 Chrome
i0S 11 Safari

Computer Windows 7/8.1/10 Chrome
macOS 10.12/10.13  Safari
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Informationen zu Geriten, die von der
Anwendung ,,Content Browser Mobile*
unterstiitzt werden, erhalten Sie vom Sony-
Kundendienst oder einer Handelsvertretung.



Konfiguration der Miniaturbildanzeige

Wenn Sie die Taste THUMBNAIL (Seite 10) driicken, werden auf der Speicherkarte aufgezeichnete Clips
als Miniaturbilder auf dem Bildschirm angezeigt.

Sie konnen einen Clip in der Miniaturbildanzeige wihlen und die Wiedergabe des Clips starten. Das
Wiedergabebild kann auf dem LCD-/Sucherbildschirm und externen Monitoren angezeigt werden.
Durch erneutes Driicken der Taste THUMBNAIL wird die Miniaturbildanzeige geschlossen und das
Kamerabild wieder angezeigt.

« In der Miniaturbildanzeige werden nur Clips angezeigt, die im derzeit gewihlten Aufzeichnungsformat aufgenommen
wurden. Falls ein aufgezeichneter Clip wider Erwarten nicht angezeigt wird, iiberpriifen Sie das Aufzeichnungsformat.
Beachten Sie diesen Aspekt vor dem Formatieren (Initialisieren) von Speichermedien.

Informationen zum Clip an der Cursorposition werden unten im Bildschirm angezeigt.

Anzeige der derzeit gewéahlten Speicherkarte
(Gesperrte Karten sind durch ein Schlosssymbol gekennzeichnet.)

Clip-Nummer/Gesamtzahl der Clips
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1. Miniaturbild (Indexbild) 4. Spezielle Aufzeichnungsinformationen
Hier wird das Indexbild eines Clips angezeigt. Der Aufzeichnungsmodus wird nur angezeigt,
Wenn ein Clip aufgezeichnet wird, wird sein wenn der Clip in einem speziellen
erstes Einzelbild automatisch als Indexbild Aufzeichnungsmodus aufgenommen wurde.
gesetzt. Bei Zeitlupen- & Zeitrafferclips wird rechts die
Unter dem Miniaturbild werden Informationen Bildrate angezeigt.

zum Clip/Bild angezeigt. Sie konnen die
Anzeige der Informationen mithilfe von
Customize View (Seite 62) >Thumbnail 6. Erstellungsdatum
Caption im Thumbnail-Menii dndern.

2. Name des Clips
Zeigt den Namen des ausgewdhlten Clips an.

5. Clipléinge

3. Videoaufzeichnungsformat
Zeigt das Dateiformat des ausgewdhlten Clips
an.
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Wiedergeben von Clips

Abspielen der aufgezeichneten
Clips

Aufgezeichnete Clips konnen wiedergegeben
werden, wenn sich der Camcorder im
Bereitschaftsmodus (Stby) befindet.

1 Setzen Sie eine Speicherkarte fiir die
Wiedergabe ein.

2 Driicken Sie die
Wiedergabefunktionstaste PLAY/
PAUSE.

3 Driicken Sie die Taste PREV oder
NEXT, um den gewiinschten Clip
anzusteuern.

4 Driicken Sie die Taste PLAY/PAUSE.
Das Wiedergabebild erscheint im Sucher.

Die Wiedergabe kann durch Driicken der

folgenden Tasten gesteuert werden:

Taste PLAY/PAUSE: Die Wiedergabe wird
angehalten. Driicken Sie die Taste erneut, um
die Wiedergabe fortzusetzen.

Taste F FWD/Taste F REV: Schnelle
Wiedergabe. Driicken Sie die Taste PLAY/
PAUSE, um zur normalen Wiedergabe
zuriickzuschalten.

Taste STOP/CAM: Die Wiedergabe oder
Aufnahme wird gestoppt.

Auswdhlen des ersten Miniaturbilds
Halten Sie die Taste F REV gedriickt und driicken
Sie die Taste PREV.

Auswéhlen des letzten Miniaturbilds
Halten Sie die Taste F FWD gedriickt und
driicken Sie die Taste NEXT.

Wiedergeben des ausgewahlten
und der folgenden Clips
nacheinander

1 Driicken Sie die Tasten #/%/«/% oder
drehen Sie den Regler SEL/SET, um
den Cursor auf das Miniaturbild des
gewiinschten Clips zu verschieben.

2 Driicken Sie die Taste SET oder den
Regler SEL/SET.

Die Wiedergabe beginnt am Anfang des
ausgewdhlten Clips.

An den Ubergiingen zwischen verschiedenen Clips
kann es temporir zu einem Bildabbruch oder zur
Anzeige von Standbildern kommen. Der Camcorder
kann wihrenddessen nicht gesteuert werden.

‘Wenn Sie einen Clip in der Miniaturbildanzeige
wihlen und die Wiedergabe starten, kann es zu einem
kurzzeitigen Bildabbruch am Anfang des Clips
kommen. Ohne Verzerrung kénnen Sie die
Wiedergabe starten, indem Sie zunichst die
Wiedergabe starten und in die Pause schalten, mit der
Wiedergabefunktionstaste PREV den Anfang des
Clips ansteuern und dann die Wiedergabe fortsetzen.

Priifung von Audiosignalen
wahrend der Wiedergabe

Im normalen Wiedergabemodus konnen Sie die
aufgezeichneten Audiosignale iiber den
integrierten Lautsprecher oder den
angeschlossenen Kopfhorer priifen.

Wenn Sie einen Kopfhorer an die
Kopthorerbuchse anschliefen (Seite 9), wird der
integrierte Lautsprecher stummgeschaltet.
Passen Sie die Lautstirke mithilfe der VOLUME-
Tasten an (Seite 10).

Sie konnen den zu priifenden Kanal mithilfe von
Audio Output (Seite 84) im Audio-Menii
auswihlen.



Clipfunktionen

Mithilfe des Thumbnail-Meniis konnen Sie Clips
schiitzen/l6schen, Eigenschaften priifen und
andere Vorginge durchfiihren.

Bedienung des Thumbnail-Meniis

Das Thumbnail-Menii kann nur verwendet
werden, wenn eine Miniaturbildanzeige
angezeigt wird.

1 Driicken Sie die Taste THUMBNAIL.

Die Miniaturbildanzeige erscheint.

2 Driicken Sie die Taste MENU.

Die Meniianzeige erscheint.

3 Wiihlen Sie Thumbnail mithilfe der
Tasten #/¥%/«/% oder dem Regler SEL/
SET aus und driicken Sie die Taste SET
oder den Regler SEL/SET.

Um das Thumbnail-Menii auszublenden, driicken
Sie die Taste MENU erneut.

Waiihlen Sie die Meniioptionen und Unteroptionen
wie nachfolgend beschrieben aus.

Wiihlen Sie mithilfe der Tasten #/¥/«/»
oder dem Regler SEL/SET eine
Meniioption oder Unteroption aus und
driicken Sie die Taste SET oder den Regler
SEL/SET.

Durch Driicken der Taste CANCEL/BACK
(Seite 9) gelangen Sie zum vorherigen
Bildschirm.

* Wenn eine Speicherkarte schreibgeschiitzt ist, sind
einige Bedienvorginge nicht moglich.

* Einige Punkte konnen nicht gewihlt werden, abhingig
vom Zustand des Camcorders wihrend der
Meniianzeige.
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Wiihlen Sie Display Clip Properties im Thumbnail-Menii aus.

Clip Properties

(clipoood )
1 ———e

(TC Index  00:05:00:02|| Video codec ~ XAVC-L50
2 Start 00:05:00:00| Size 1920x1080
End 00:08:19:23||| FPS 59.94P 8
\Duration 00:03:19:23||l Audio Codec  LPCM
(Created ||| Ch/Bit 4ch 24bit
3 Aug-23-20141058:42 ||| pec Mode  Interval Rec

o 23-2014 10,5642 | |Re0 Device  PXW-Z190V/(SN00001014)

1. Bild des aktuellen Clips

2. Timecode-Anzeige
TC Index: Timecode des angezeigten Vollbilds
Start: Timecode am Startpunkt der Aufnahme
End: Timecode am Endpunkt der Aufnahme
Duration: Dauer des Clips

3. Datum von Erstellung und Anderung
4. Zurzeit ausgewiihlte Speicherkarte
5. Symbeol fiir geschiitztes Medium

6. Clip-Nummer/Gesamtzahl der Clips
7. Akkusymbol

8. Informationen zum Clip
Name des Clips
Aufzeichnungsformat
Spezielle Aufzeichnungsinformationen
Name des Aufnahmegerits
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Schiitzen von Clips

Sie konnen einen bestimmten Clip oder alle Clips
vor dem Loschen schiitzen.

Den Miniaturbildern geschiitzter Clips wird (3)
hinzugefiigt.

Clips konnen in der Miniaturbildanzeige
geschiitzt werden.

Schiitzen eines bestimmten Clips

1 Wiihlen Sie Lock/Unlock Clip >Select
Clip >Execute im Thumbnail-Menii
aus.

Der Bildschirm zur Auswahl von Clips wird
angezeigt.

2 Wihlen Sie den zu schiitzenden Clip
aus.

Der ausgewihlte Clip wird mit einem
Hikchen versehen.

3 Driicken Sie die Taste MENU.

Ein Bestitigungsbildschirm wird angezeigt.

4 Wihlen Sie Execute aus.

Der Clip wird geschiitzt und eine
Abschlussmeldung wird angezeigt.

9 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Schiitzen aller Clips

1 Wihlen Sie Lock/Unlock Clip >Lock
All Clips im Thumbnail-Menii aus.

Ein Bestitigungsbildschirm wird angezeigt.

2 Waihlen Sie Execute aus.

Alle Clips werden geschiitzt und eine
Abschlussmeldung wird angezeigt.

3 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.
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Entsperren aller Clips

1 Wiihlen Sie Lock/Unlock Clip >Unlock
All Clips im Thumbnail-Menii aus.

Ein Bestitigungsbildschirm wird angezeigt.

2 Wiihlen Sie Execute aus.

Alle Clips werden entsperrt und eine
Abschlussmeldung wird angezeigt.

3 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Kopieren von Clips

Sie konnen Clips auf eine andere Speicherkarte
kopieren.

Clips werden unter den gleichen Namen wie die
Originalclips auf Zielspeicherkarten kopiert.

« Falls auf der Zielspeicherkarte bereits ein Clip
gleichen Namens vorhanden ist, wird dem
Originalnamen eine Zahl in Klammern hinzugefiigt.
Die Ziffer in Klammern ist die kleinste, die am
Speicherort noch nicht vorhanden ist.

Beispiele: ABCD0002 — ABCD0002(1)
ABCDO0002(1) — ABCD0002(2)
ABCDO0005(3) — ABCD0005(4)

Falls die Ziffern von (1) bis (999) am Kopierziel

bereits vorhanden sind, weil ein Clip mehr als

1000 Mal kopiert wurde, konnen Sie unter diesem

Namen keine weiteren Clips kopieren.

Eine Meldung wird angezeigt, wenn nicht geniigend

Speicherplatz auf der Zielspeicherkarte vorhanden ist.

Tauschen Sie die Karte gegen eine mit mehr freiem

Speicherplatz aus.

Bei einer Speicherkarte mit mehreren aufgezeichneten

Clipsistes je nach Speichercharakteristik und Nutzung

der Speicherkarten ggf. nicht moglich, alle Clips zu

kopieren, selbst wenn die Speicherkarten die gleiche

Kapazitit besitzen.

Einen bestimmten Clip kopieren

1 Wihlen Sie Copy Clip >Select Clip
>Execute im Thumbnail-Menii aus.

Der Bildschirm zur Auswahl von Clips wird
angezeigt.

2 Wihlen Sie den zu kopierenden Clip
aus.



Der ausgewiihlte Clip wird mit einem
Hikchen versehen.

3 Driicken Sie die Taste MENU.

Ein Bestitigungsbildschirm wird angezeigt.

4 Wiihlen Sie Execute aus.

Der Clip wird kopiert und eine
Abschlussmeldung wird angezeigt.

5 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Alle Clips kopieren

Sie konnen alle auf einer Speicherkarte
vorhandenen Clips gleichzeitig auf eine andere
Speicherkarte kopieren.

1 Wihlen Sie Copy Clip >All Clips im
Thumbnail-Menii aus.

Ein Bestitigungsbildschirm wird angezeigt.

2 Wiihlen Sie Execute aus.

Alle Clips werden kopiert und eine
Abschlussmeldung wird angezeigt.

3 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Loschen von Clips

Sie konnen Clips von Speicherkarten 16schen.

¢ Geschiitzte Clips konnen nicht geloscht werden.
Entsperren Sie zum Loschen zunichst den Clip.

Einen bestimmten Clip Iéschen

1 Wiihlen Sie Delete Clip >Select Clip
>Execute im Thumbnail-Menii aus.

Der Bildschirm zur Auswahl von Clips wird
angezeigt.

2 Wiihlen Sie den zu léschenden Clip aus.

Der ausgewiihlte Clip wird mit einem
Hikchen versehen.

3 Driicken Sie die Taste MENU.

Ein Bestitigungsbildschirm wird angezeigt.

4  Wihlen Sie Execute aus.

Der Clip wird geldscht und eine
Abschlussmeldung wird angezeigt.

5 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Alle Clips loschen

1 Wibhlen Sie Delete Clip >All Clips im
Thumbnail-Menii aus.

Ein Bestitigungsbildschirm wird angezeigt.

2 Wiihlen Sie Execute aus.

Alle Clips werden geloscht und eine
Abschlussmeldung wird angezeigt.

3 Driicken Sie die Taste SET oder den
Regler SEL/SET, um die Meldung
auszublenden.

Selektives Anzeigen von Clips
(Einzelbildern) mithilfe der
Miniaturbildanzeige mit
Inhaltsmarkierung

Wenn in einem Clip eine
Aufnahmestartmarkierung aufgezeichnet wurde,
konnen Sie Miniaturbilder fiir nur jene
Einzelbilder anzeigen lassen, denen eine
Aufnahmestartmarkierung hinzugefiigt wurde.
Dieser Bildschirm wird als Miniaturbildanzeige
mit Inhaltsmarkierung bezeichnet.

Wiihlen Sie Thumbnail View >Essence
Mark Thumbnail im Thumbnail-Menii aus
und wiihlen Sie dann den Typ der
Inhaltsmarkierung aus, nach der gefiltert
werden soll.
All: Alle Einzelbilder mit Inhaltsmarkierungen
Rec Start: Einzelbilder mit einer
Aufnahmestartmarkierung und das erste
Einzelbild von Clips, die keine
Aufnahmestartmarkierung besitzen



Die Miniaturbildanzeige mit Inhaltsmarkierung
wird gefiltert nach der ausgewihlten
Inhaltsmarkierung angezeigt.

Andern der in der
Miniaturbildanzeige
erscheinenden Informationen

Sie konnen dndern, welche Informationen zum
Clip bzw. Bild unter einem Miniaturbild
angezeigt werden.

Wiihlen Sie Customize View >Thumbnail

Caption im Thumbnail-Menii aus und dann

die anzuzeigenden Informationen.

Date Time: Datum und Uhrzeit der Clip-
Erstellung und seiner letzten Anderung.

Time Code: Timecode

Duration: Dauer

Sequential Number: Miniaturbildnummer
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AnschlieBen externer Monitore und Aufnahmegerate

Zum Anzeigen von Aufzeichnungs-/
Wiedergabebildern auf einem externen Monitor
wihlen Sie das Ausgangssignal des Camcorders
und schliefen den Monitor mit einem geeigneten
Kabel an.

Sie konnen auch Aufnahmegerite wie einen
Videorekorder anschlieen und das
Ausgangssignal vom Camcorder aufzeichnen.
Auf einem externen Monitor konnen dieselben
Informationen angezeigt werden, die auch im
Sucher erscheinen, z. B. Statusinformationen und
Meniis. Setzen Sie Output Display (Seite 85) im
Video-Menii fiir den entsprechenden Signaltyp
auf On, um das Signal an den Monitor
auszugeben.

Anschluss SDI OUT (BNC-Ausfiihrung)

Stellen Sie im Video-Menii ein, ob der Ausgang
ein- bzw. ausgeschaltet ist, und legen Sie das
Ausgabeformat fest (Seite 85).

Verwenden Sie fiir den Anschluss ein
handelsiibliches 75- Q-Koaxialkabel.

Stellen Sie vor dem Einschalten unbedingt eine
Erdungsverbindung zwischen Camcorder und
externem Gerit her.

(Wir empfehlen, vor dem Einschalten des Camcorders
und des externen Geriits erst ein 75- Q-Koaxialkabel
anzuschlieBen.)

Wenn Sie ein externes Gerit an den Camcorder
anschlielen, withrend der Camcorder eingeschaltet ist,
schlieBen Sie das 75- Q-Koaxialkabel erst an das
externe Gerit an und dann an den Camcorder.

Synchronisierte Aufnahme auf dem Camcorder
und einem externen Gerét starten

Wenn der SDI-Signalausgang ausgewihlt wurde,
setzen Sie SDI/HDMI Rec Control (Seite 85)
>Setting im Menii Video auf On, um an das
externe Gerdt am Anschluss SDI OUT ein REC-
Auslosersignal zu leiten. Dadurch wird die
Aufzeichnung auf dem externen Gerit mit dem
Camcorder synchronisiert.

« Wenn ein angeschlossenes externes Gerit nicht auf das
REC Auslosesignal anspricht, kann das Gerit nicht
bedient werden.

Anschluss HDMI OUT (Typ A)

Stellen Sie im Video-Menii ein, ob der Ausgang
ein- bzw. ausgeschaltet ist, und legen Sie das
Ausgabeformat fest (Seite 85).

Verwenden Sie fiir den Anschluss ein
handelsiibliches HDMI-Kabel.

Multi/Micro USB-Anschluss

2-Kanal-Audiosignale konnen mithilfe des AV-
Kabels VMC-15MR2 (separat erhiltlich)
ausgegeben werden.



Verwalten/Bearbeiten
von Clips auf einem
Computer

Verbindung per USB-Kabel

Verbinden Sie den Camcorder iiber ein USB-
Kabel mit einem Computer und setzen Sie eine
Speicherkarte in den Einschub ein. Die
Speicherkarte wird als externes
Computerlaufwerk erkannt.

Wenn zwei Speicherkarten in den Camcorder
eingesetzt sind, werden sie vom Computer als
zwei unabhingige externe Laufwerke erkannt.

* Der Camcorder kann nicht per USB vom Computer
mit Strom versorgt werden. Halten Sie eine separate
Stromquelle bereit.

In den folgenden Fillen wird der Camcorder nicht als

Laufwerk erkannt.

— Withrend der Aufnahme (einschlieBlich
Spezialaufnahmemodi)

— Wiihrend der Wiedergabe (einschlieSlich
Hochgeschwindigkeitswiedergabe und im
angehaltenen Zustand)

— Wiihrend der Miniaturbildanzeige

— Wiihrend Medien formatiert (initialisiert) werden

— Wenn Speicherkarten wiederhergestellt oder
Verwaltungsdateien aktualisiert werden
(einschlieBlich wihrend der Bestitigung vor der
Ausfiihrung)

1 Verbinden Sie den Multi/Micro USB-
Anschluss des Camcorders iiber ein
USB-Kabel mit dem Computer.

2 Stellen Sie den Schalter ON/STANDBY
auf ON.

Auf dem LCD-/Sucherbildschirm wird eine
Meldung mit der Frage angezeigt, ob Sie die
USB-Verbindung aktivieren mdchten.

Wenn die Bestitigungsmeldung ausgeblendet
wird, trennen Sie das USB-Kabel und schlielen
es erneut an. Die Bestitigungsmeldung wird nicht
wihrend der Aufnahme/Wiedergabe und der
Miniaturbildanzeige angezeigt.

3 Wiihlen Sie Execute mithilfe der Tasten
4/¥%/«/» oder des Reglers SEL/SET aus.

64

4  Auf einem Windows-Computer muss
gepriift werden, ob die Speicherkarte
unter ,,Arbeitsplatz* als
Wechseldatentriiger angezeigt wird.
Auf einem Macintosh-Computer ist zu
priifen, ob der Ordner ,,NO NAME*
oder ,,Untitled* auf dem Desktop
erstellt wurde.

Die folgenden Vorginge sollten nicht ausgefiihrt

werden, wenn die ACCESS-Leuchte rot leuchtet.

— Ausschalten des Gerits oder Trennen des
Netzkabels

— Entnehmen der Speicherkarte

— Abziehen des USB-Kabels

Wiihlen Sie beim Herausnehmen einer Speicherkarte

an einem Macintosh nicht die Option ,,Card Power

Off* tiber das Speicherkartensymbol auf der

Mentileiste.

Der ordnungsgemifie Betrieb ist nicht bei allen

Computern gewihrleistet.

Anwendungssoftware

Um Clips auf die lokale Festplatte Ihres
Computers zu kopieren, muss die dafiir
vorgesehene Anwendungssoftware
heruntergeladen und auf Threm Computer
installiert werden. Einzelheiten zum
Herunterladen von Software siehe ,, Software-
Downloads* (Seite 122).

Die Daten zu den Aufnahmen werden zwar auf
mehrere Dateien und Ordner verteilt gespeichert,
aber mit der dedizierten Anwendungssoftware
konnen Sie die Clips problemlos handhaben,
ohne die Daten- und Verzeichnisstruktur zu
berticksichtigen.

* Wenn Sie Funktionen wie das Kopieren von Clips auf
einer Speicherkarte mit dem Explorer (Windows) oder
Finder (Macintosh) ausfiihren, gehen die in den Clips
enthaltenen ergéinzenden Daten moglicherweise
verloren.

Verwenden eines nichtlinearen
Schnittsystems

Ein nonlineares Bearbeitungssystem erfordert ein
optionales Bearbeitungsprogramm, das mit den
Aufnahmeformaten des Camcorders kompatibel
ist.

Speichern Sie zuerst die Clips, die bearbeitet
werden sollen, mithilfe der dedizierten
Anwendungssoftware auf der Festplatte Ihres
Computers.



AnschlieBen einer externen
Festplatte/eines USB-Mediums

Wenn eine externe Festplatte oder ein USB-
Medium mit dem USB 3.0 (HOST)-Anschluss
des Camcorders verbunden ist, konnen Sie Clips
von dem in einen Speicherkarteneinschub
eingesetzten Aufnahmemedium auf die externe
Festplatte oder das USB-Medium kopieren.

Kopieren von Clips auf ein USB-Medium

1 Wihlen Sie USB >Select Folder
(Seite 92) im Media-Menii aus.

2 Wiihlen Sie in der Ordnerliste den
Zielordner fiir das Kopieren aus und
driicken Sie die Taste SET oder den
Regler SEL/SET.

Sie konnen auch New auf dem Bildschirm
auswihlen, um einen neuen Ordner zu
erstellen.

Falls kein Ordner angegeben wird, so wird
automatisch ein neuer erstellt und mit dem
Erstellungsdatum des ersten zu kopierenden Clips
benannt. Die Clips werden in diesen Ordner
kopiert.

3 Wihlen Sie USB >Copy to USB

(Seite 92) im Media-Menii aus, setzen

Sie das zu kopierende

Aufnahmemedium ein und wiihlen Sie

den Speicherkarteneinschub aus.

Media(A) to USB: Alle Clips vom in den
Einschub A eingesetzten
Aufnahmemedium kopieren.

Media(B) to USB: Alle Clips vom in den
Einschub B eingesetzten
Aufnahmemedium kopieren.

Media(A)(B) to USB: Alle Clips von den
in die Einschiibe A und B eingesetzten
Aufnahmemedien kopieren.
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Wenn ein Kopierzielordner in Schritt 2 und
Media(A)(B) to USB angegeben wurde, werden
die Clips von Einschub A in den angegebenen
Zielordner kopiert. Clips von Einschub B werden
in einen automatisch erstellten Ordner kopiert,
der mit dem Erstellungsdatum des ersten Clips
benannt wird.

4 Wihlen Sie Execute mithilfe der Tasten
4/¥%/«/» oder dem Regler SEL/SET aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Alle Clips vom Aufnahmemedium werden
auf das USB-Medium kopiert.

« Falls im Zielordner bereits ein Clip mit dem
gleichen Namen wie der zu kopierende Clip
vorhanden ist, wird der Clip nicht kopiert.

Anzeigen einer Liste der Clips auf einer
externen Festplatte/einem USB-Medium

Mithilfe von USB >View Clip List (Seite 92) im
Media-Menii konnen Sie eine Liste der auf einer
externen Festplatte/einem USB-Medium
gespeicherten Clips anzeigen.

Umbenennen eines Ordners auf einer
externen Festplatte/einem USB-Medium

1 Wiihlen Sie USB >Rename Folder
(Seite 92) im Media-Menii aus.

2 Wiihlen Sie in der Ordnerliste den
umzubenennenden Ordner aus und
driicken Sie die Taste SET oder den
Regler SEL/SET.

Es wird ein Bildschirm zum Eingeben von
Dateinamen angezeigt.

3 Geben Sie einen Ordnernamen ein und
wiihlen Sie Done aus.

Der Ordner wird umbenannt.

Priifen auf Lesefehler beim Kopieren

Sie konnen Clips nach dem Schreiben auf
Lesefehler priifen lassen, indem Sie USB >Error
Check (Seite 92) im Media-Menii auf On setzen.



Formatieren (Initialisieren) einer
externen Festplatte/eines USB-Mediums

1 Wihlen Sie USB >Format USB
(Seite 92) im Media-Menii aus.

2 Wiihlen Sie Execute mithilfe der Tasten
4/¥%/«/% oder dem Regler SEL/SET aus
und driicken Sie die Taste SET oder den
Regler SEL/SET.

Die Initialisierung (Formatierung) beginnt.

3 Sobald die Formatierung abgeschlossen
ist, wird eine Meldung angezeigt.
Wiihlen Sie OK aus.

Zustand Losung
Bei Aufnahme/Wiedergabe Beenden Sie den
von Clips, vorhergehenden
Miniaturbildanzeige, Proxy- Vorgang.

Aufnahme, Formatieren/
Wiederherstellen von
Medien, Aktualisieren von
Verwaltungsdateien und
Software, Zuriicksetzen des
Camcorders oder des
Netzwerks, AnschlieBen
eines Computers, Anzeige
von
Bestitigungsbildschirmen

Unzureichende Wechseln Sie den Akku

Versorgungsspannung oder verwenden Sie eine
andere
Stromversorgung.

Priifen der verbleibenden Kapazitat einer
externen Festplatte/eines USB-Mediums

Der freie Speicherplatz auf einer externen
Festplatte/einem USB-Medium wird in der Zeile
Media Remain auf dem Bildschirm angezeigt,
wenn USB im Media-Menii ausgewihlt wird.

Hinweise zur Stromversorgung einer
externen Festplatte/eines USB-Mediums

Externe Festplatten/USB-Medien werden bei
Verwendung von USB-Meniioptionen im Media-
Menii automatisch iiber den USB 3.0 (HOST)-
Anschluss mit Strom versorgt.

Unter den nachfolgend aufgefiihrten
Bedingungen jedoch wird selbst bei Verwendung
von USB-Meniioptionen im Media-Menii die
Stromversorgung nicht aufgenommen. Um die
Stromversorgung einzuschalten, gehen Sie nach
der in der Tabelle aufgefiihrten Losung vor.
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* Clips auf einer externen Festplatte/einem USB-
Medium konnen nicht auf in einen
Speicherkarteneinschub eingesetzte Aufnahmemedien
kopiert werden.

* Clips kénnen nicht aufgenommen werden, solange der
USB 3.0 (HOST)-Anschluss mit Strom versorgt wird.
Um Clips aufzunehmen, beenden Sie die Verwendung
von USB-Meniioptionen im Media-Menii.



Meniianzeige und Einstellungen

Konfiguration und Hierarchie des Einstellmeniis

Driicken Sie die Taste MENU, um das

Einstellmenti auf dem LCD-Bildschirm/Sucher

anzuzeigen und verschiedene Einstellungen fiir

die Aufnahme, Aufzeichnung und Wiedergabe
festzulegen (das Menii kann auch auf einem
externen Monitor angezeigt werden). Das

Einstellmentii ist in folgende Meniis gegliedert.

User Menu: Menii mit
benutzerkonfigurierbaren Optionen (mithilfe
von Edit User Menu zu bearbeiten).

Edit User Menu-Menii: Menii zum Bearbeiten
der User-Meniioptionen.

Camera-Menii: Enthilt Einstellungen fiir die
Aufnahme.

Paint-Menii: Enthilt Einstellungen fiir die
Bildqualitit.

Audio-Menii: Enthilt Einstellungen fiir die
Audiosteuerung.

Video-Menii: Enthilt Einstellungen fiir die
Videoausgabe.

LCD/VF-Menii: Enthilt Einstellungen fiir die
Anzeige auf LCD-Bildschirm und im
Sucher.

TC/UB-Menii: Enthilt Einstellungen zu
Timecode und User-Bits.

Recording-Menii: Enthilt Einstellungen fiir
die Aufzeichnung.

Thumbnail-Menii: Enthilt Einstellungen fiir
die Miniaturbildanzeige.

Media-Menii: Enthilt Einstellungen fiir die
Speichermedien.

File-Menii: Enthilt Einstellungen fiir die
Dateien.

Network-Menii: Enthilt Einstellungen fiir
Netzwerke.

System-Menii: Enthilt Einstellungen fiir das
System.

Struktur des Einstellmeniis

MENU
User Base Setting
Rec Format
S&Q Motion
Picture Cache Rec
Simul Rec
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+ Edit User Menu

- Camera

 Paint

 Audio

 Video

- Proxy Rec

— Output Format

I Assignable Button
- Delete Clip

— Wireless LAN

- Format Media

— Menu Settings

L Edit User Menu

Add ltem
Customize Reset

— Focus

- ND Filter

— Gain

— Shutter

— Auto Exposure

- Color Bars

I Flicker Reduce

- Flash Band Reduce
- SteadyShot

- Handle Zoom

- Speed Zoom

- Auto Black Balance
L Video Light Set

—— HDR Paint Setting
— White

— White Setting
— Offset White
 Black

— Gamma

- Knee

— White Clip

- Detail(QFHD)
- Detail(HD)
 Detail(SD)

- Skin Detail

— Aperture

— Matrix

L Maintenance

—I: Audio Input
Audio Output

Output On/Off
Qutput Format



— LCD/VF

- TC/UB

— Recording

— Thumbnail

— Media

- File

— Network

L System

I Output Display
I SDI/HDMI Rec Control
L Down Converter

— LCD Setting

— VF Setting

I Peaking

— Marker

- Zebra

- Gamma Display Assist
L Display On/Off

— Timecode
 Users Bit
L HDMI TC Out

— S&Q Motion

— Interval Rec

- Picture Cache Rec
 Clip Continuous Rec
— Simul Rec

- Proxy Rec

- Rec Review

— Display Clip Properties
- Lock/Unlock Clip

- Delete Clip

- Copy Clip
 Thumbnail View

L Customize View

— Update Media
- Format Media
— USB

L Clip Naming

— User File
- All File
L Scene File

— Access Authentication
— Wireless LAN

- AP Mode Settings

- ST Mode Settings

L Network Reset

— Base Setting

— Rec Format

- Assignable Button
— Tally

- Language

 Clock Set

- Hours Meter

- GPS

I Battery Alarm

- DC Voltage Alarm
- Menu Settings

— Fan Control

— All Reset

L Version
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Funktionen im
Einstellmenii

Driicken Sie die Taste MENU, um das
Einstellmenii auf dem LCD-Bildschirm/Sucher
anzuzeigen und verschiedene Einstellungen fiir
die Aufnahme, Aufzeichnung und Wiedergabe
festzulegen (das Menii kann auch auf einem
externen Monitor angezeigt werden).

Meniisteuerung

Taste MENU (Seite 9)
Aktiviert bzw. deaktiviert den Meniimodus fiir
die Bedienung des Einstellmeniis.

Regler SEL/SET (Seite 9)

Durch Drehen lisst sich der Cursor zur Auswahl
von Optionen oder Einstellungen nach oben und
unten bewegen.

Driicken Sie den Regler SEL/SET, um das
gewihlte Element zu iibernehmen.

Taste CANCEL/BACK (Seite 9)

Driicken Sie diese Taste, um zum
vorhergehenden Menii zu wechseln. Nicht
bestitigte Anderungen werden verworfen.

Tasten 4/%/«/»/SET

Driicken Sie die Tasten 4/¥/«/% um den Cursor
nach oben/unten/links/rechts zu bewegen und
Meniioptionen oder Einstellungen auszuwéihlen.
Driicken Sie den Taste SET, um die gewihlte
Option zu iibernehmen.

¢ Im Fokuslupenbildschirm (Seite 26) kann das
Einstellmenii nicht verwendet werden.

Festlegen von Meniielementen

Bewegen Sie den Cursor mithilfe der Tasten #/%/
«/% oder dem Regler SEL/SET auf die
gewiinschte Option und driicken Sie die Taste
SET oder den Regler SEL/SET, um die
Einstellung zu tibernehmen.

* Im Auswahlbereich der Meniioption werden
maximal 9 Zeilen angezeigt. Falls nicht alle
verfiigbaren Optionen fiir ein Element
gleichzeitig angezeigt werden konnen, bléttern
Sie durch die Liste, indem Sie den Cursor nach
oben bzw. nach unten bewegen.
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* Bei Unteroptionen mit einem grofien
Einstellbereich (z. B. —99 bis +99) wird der
Einstellbereich nicht angezeigt. Die aktuelle
Einstellung ist hervorgehoben, um den
dnderbaren Wert zu kennzeichnen.

* Durch die Wahl von Execute wird die
entsprechende Funktion ausgefiihrt.

¢ Bei Auswahl eines Elements, das vor der
Ausfiihrung bestitigt werden muss, wird das
Menii voriibergehend durch eine
Bestitigungsmeldung iiberlagert. Uberpriifen
Sie die Meldung, und wihlen Sie dann, ob die
Funktion ausgefiihrt oder abgebrochen werden
soll.

Eingeben einer Zeichenfolge

Wenn Sie ein Element wihlen, fiir das eine
Zeichenfolge eingegeben werden muss (z. B. ein
Dateiname), wird ein Bildschirm zur
Zeicheneingabe eingeblendet.

Edit File Name

Kurokawa_Scene_001 a

Bbcdefgh.i

nopgqgr st

u v wixy z

2 3

1 Wihlen Sie durch Drehen des Reglers
SEL/SET die Art der Zeichen und
driicken Sie dann auf den Regler.
ABC: GroBbuchstaben
abc: Kleinbuchstaben
123: Numerische Zeichen
1#$: Sonderzeichen

2 Wiihlen Sie ein Zeichen aus dem
gewihlten Zeichentyp aus, und driicken
Sie auf den Regler.

Der Cursor bewegt sich zum néchsten Feld.
Space: Fiigt an der Cursorposition ein
Leerzeichen ein.

«/*: Andert die Position des Cursors.

BS: Loscht das Zeichen links vom Cursor
(Riicktaste).



3 Wenn Sie fertig sind, wiihlen Sie Done
und driicken auf den Regler.
Die Zeichenfolge wird iibernommen, und der
Bildschirm zur Zeicheneingabe wird
ausgeblendet.

Sperren und Entsperren des Meniis

Sie konnen das Einstellmenii sperren, sodass nur
das User-Menii angezeigt wird.

Sperren des Meniis

1 Halten Sie den Regler SEL/SET
gedriickt und driicken Sie die Taste
MENU.

2 Wiihlen Sie Menu Settings >User Menu
with Lock im System-Menii aus.

Wenn Sie nur die Taste MENU driicken, um das
normale Einstellmenii anzuzeigen, wird User
Menu Only unter Menu Settings im System-
Menii angezeigt. Halten Sie den Regler SEL/SET
gedriickt und driicken Sie die Taste MENU, um
User Menu with Lock anzuzeigen.

3 Setzen Sie die Einstellung auf On und
driicken Sie die Taste SET oder den
Regler SEL/SET.

Die Anzeige des LCD-/Sucherbildschirms
wechselt zu einem Bildschirm fiir die
Eingabe eines Codes.

4 Geben Sie eine beliebige Zahl ein.

Geben Sie eine vierstellige Zahl von 0000 bis
9999 ein. Der Standardwert ist 0000.

Geben Sie eine Ziffer ein und driicken Sie die
Taste SET oder den Regler SEL/SET, um zur
nichsten Ziffer zu wechseln.

Wenn alle Ziffern eingegeben wurden,
bewegen Sie den Cursor auf SET.

9 Driicken Sie die Taste SET oder den
Regler SEL/SET.

Die Eingabe wird iibernommen.

Eine Bestitigungsmeldung erscheint und der
Bildschirm wechselt zur Anzeige des User-
Meniis.

« Falls das Menii gesperrt wird, ohne
Einstellmeniioptionen aus den folgenden Tabellen im
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User-Menii zu registrieren, konnen diese Funktionen
keinen belegbaren Tasten zugewiesen werden.

Falls diese Funktionen bereits belegbaren Tasten

zugewiesen wurden, wird die zugewiesene Einstellung
ab dem Zeitpunkt deaktiviert, zu dem das Menii

gesperrt wird.

Einstellmeniioption

Auswahloptionen
fiir belegbare
Tasten

Camera >Focus >Face
Detection AF

Face Detection AF

Camera >Focus >Focus
Macro

Focus Macro

Camera >Gain >Gain
<Turbo>

Turbo Gain

Camera >Auto Exposure
>Level

Auto Exposure Level

Camera >Auto Exposure Spotlight
>Mode

Camera >Auto Exposure Backlight
>Mode

Camera >Auto Exposure Auto ND Filter
>Auto ND Filter

Camera >Auto Exposure AGC

>AGC

Camera >Auto Exposure Shutter

>Auto Shutter

Camera >Color Bars Color Bars
>Setting

Camera >Flash Band Reduce Flash Band Reduce
>Setting

Camera >SteadyShot SteadyShot
>Setting

Camera >Handle Zoom
>Setting

Handle Zoom

Paint >White >Preset White Preset White Select

LCD/VF >VF Setting >Color VF Mode
Mode

LCD/VF >Peaking >Setting Peaking
LCD/VF >Marker >Setting ~ Marker
LCD/VF >Zebra >Setting Zebra

LCD/VF >Gamma Display =~ Gamma Display Assist

Assist >Setting

LCD/VF >Display On/Off
>Lens Info

Lens Info

LCD/VF >Display On/Off
>Video Signal Monitor

Video Signal Monitor

Recording >S&Q Motion
>Setting

S&Q Motion

Recording >Picture Cache
Rec >Setting

Picture Cache Rec

Recording >Clip Continuous

Rec >Setting

Clip Continuous Rec

Recording >Rec Review
>Setting

Rec Review




Einstellmeniioption Auswahloptionen
fiir belegbare
Tasten

Network >Wireless LAN NFC

>NFC

User User Menu

Entsperren des Meniis

1 Halten Sie den Regler SEL/SET
gedriickt und driicken Sie die Taste
MENU.

2 Wiihlen Sie Menu Settings >User Menu
with Lock im System-Menii aus.

* Wenn Sie nur die Taste MENU driicken, um das
normale Einstellmenii anzuzeigen, wird User
Menu Only unter Menu Settings im System-
Menii angezeigt. Halten Sie den Regler SEL/SET
gedriickt und driicken Sie die Taste MENU, um
User Menu with Lock anzuzeigen.

3 Setzen Sie die Einstellung auf Off und
driicken Sie die Taste SET oder den
Regler SEL/SET.

Die Anzeige des LCD-/Sucherbildschirms
wechselt zu einem Bildschirm fiir die
Eingabe eines Codes.

4 Geben Sie den zum Sperren des Meniis
verwendeten Code ein.
Geben Sie eine Ziffer ein und driicken Sie die
Taste SET oder den Regler SEL/SET, um zur
nichsten Ziffer zu wechseln.
Wenn alle Ziffern eingegeben wurden,
bewegen Sie den Cursor auf Set.

O Driicken Sie die Taste SET oder den
Regler SEL/SET.
Die Eingabe wird iibernommen.
Falls der eingegebene Code jenem fiir die
Sperrung des Meniis entspricht, wird das
Menii entsperrt und angezeigt.

« Falls der eingegebene Code jenem fiir die Sperrung des

Meniis nicht entspricht, wird das Menii nicht entsperrt.

* Es wird empfohlen, den Code so aufzubewahren, dass
Sie ihn nachschlagen konnen, falls Sie ihn vergessen.
Falls Sie den Code vergessen haben sollten, wenden
Sie sich an den Sony-Kundendienst.
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Bearheiten des User-Meniis

Sie konnen das User-Menii mithilfe von Edit User
Menu bearbeiten, z. B. Optionen hinzufiigen,
16schen oder anders anordnen, um das User-
Menii an Ihre Bediirfnisse anzupassen.

Hinzufiigen von Optionen und
Unteroptionen

1 Wiihlen Sie Edit User Menu >Add Item
im User-Menii aus.

Die hinzufiigbaren Optionen werden
angezeigt.

2 Wihlen Sie eine hinzuzufiigende
Option aus.

Ein Bildschirm zur Auswahl
hinzuzufiigender Unteroptionen wird
angezeigt.

3 Wihlen Sie eine hinzuzufiigende
Unteroption aus.

Aktivieren Sie das Kontrollkistchen All, um
alle Unteroptionen hinzuzufiigen.
Aktivieren Sie Kontrollkistchen individuell,
um die hinzuzufiigenden Unteroptionen
festzulegen.

4  Wihlen Sie OK aus und driicken Sie die
Taste SET oder den Regler SEL/SET.

Die Optionen/Unteroptionen werden
hinzugefiigt.

Ein und dieselbe Option oder Unteroption kann nicht
zwei Mal registriert werden.

AuBerdem kann der Name der Option oder
Unteroption nicht geéndert werden.

Bearbeiten von Unteroptionen

Sie konnen die anzuzeigenden Unteroptionen
angeben.

1 Wiihlen Sie Edit User Menu im User-
Menii aus und dann die zu bearbeitende
Option.

Die Liste zur Bearbeitung der Funktionen
wird angezeigt.



2 Wiihlen Sie Edit Sub Item aus. 2 Waihlen Sie Reset aus und driicken Sie

Der Bildschirm Edit Sub Item erscheint. die Taste SET oder den Regler SEL/
Alle Unteroptionen werden gepriift, sobald SET.

der Bildschirm erstmals geoffnet wird Ein Bestitigungsbildschirm wird angezeigt.
(Funktion zur Anzeige aller Unteroptionen).

Deaktivieren Sie die Hikchen der 3 Wihlen Sie Execute aus und driicken
Unteroptionen, die nicht im User-Menii Sie die Taste SET oder den Regler SEL/
angezeigt werden sollen. SET.

Der werkseitige Zustand des User-Meniis

3 Wiihlen Sie OK aus und driicken Sie die wird wiederhergestellt.

Taste SET oder den Regler SEL/SET.

Die Bearbeitung ist abgeschlossen.

Ldschen einer Option

1 Wiihlen Sie Edit User Menu im User-
Menii aus und dann die zu loschende
Option.

Die Liste zur Bearbeitung der Funktionen
wird angezeigt.

2 Wihlen Sie Delete aus.
Die Option wird geloscht.

Verschieben einer Option

1 Wiihlen Sie Edit User Menu im User-
Menii aus und dann die zu
verschiebende Option.

Die Liste zur Bearbeitung der Funktionen
wird angezeigt.

2 Wiihlen Sie Move aus.

Die zu verschiebende Option wird
hervorgehoben. Eine Dreiecksmarkierung
und eine Linie kennzeichnen die
Zielposition.

3 Bewegen Sie Dreiecksmarkierung und
Linie ans Ziel der Option und driicken
Sie die Taste SET oder den Regler SEL/
SET.

Die Option wird verschoben.

Wiederherstellen des werkseitigen
Zustands vom User-Menii

1 Wiihlen Sie Edit User Menu
>Customize Reset im User-Menii aus.

Der Bildschirm Customize Reset erscheint.
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Liste der Elemente im Einstellmenii

In diesem Abschnitt werden die Funktionen und Einstellungen der Elemente in den einzelnen Meniis

erldutert.

Standardeinstellungen sind fett gedruckt (z. B. 18dB).

User-Menii

User

Werkseitig registrierte Optionen Beschreibung

Base Setting Option System >Base Setting
Rec Format Option System >Rec Format
S&Q Motion Option Recording >S&Q Motion

Picture Cache Rec

Option Recording >Picture Cache Rec

Simul Rec

Option Recording >Simul Rec

Proxy Rec

Option Recording >Proxy Rec

Output Format

Option Video >Output Format

Assignable Button

Option System >Assignable Button

Delete Clip

Option Thumbnail >Delete Clip

Wireless LAN

Option Network >Wireless LAN

Format Media

Option Media >Format Media

Menu Settings

Option System >Menu Settings

Edit User Menu

Ruft den Bildschirm Edit User Menu auf.

Edit User Menu-Menii

Edit User
Menu

Option Unteroptionen und Beschreibung
Einstellungen
Add Item - Fiigt Optionen und Unteroptionen hinzu.
Customize Reset Stellt den werkseitigen Zustand des User-Meniis wieder her.
Reset

Bei Auswahl der  Delete

Loscht eine Option.

registrierten

Move Verschiebt eine Option.
Option angezeigte - - - -
. Edit Sub Item Bearbeitet eine Unteroption.
Optionen
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Camera-Menii

Camera

Option Unteroptionen und Beschreibung

Einstellungen
Focus Face Detection AF Aktiviert/deaktiviert Gesichtserkennung-AF.
Gesichtserken- Face Only AF/

nung-AF-Einstel-

Face Priority AF / Off

lungen

Focus Macro
On / Off

Zum Ein-/Ausschalten des Makro-Modus.

ND Filter
ND-Filtereinstel-
lungen

Preset]
1/128 /1 1/64 /1 1/32/ 1/16 /
1/8 /114

Zum Einstellen des Voreinstellwerts 1 fiir den ND-Filter.

Preset2
1/128 7/ 1/64/1/32 /1116 /
178/ 1/4

Zum Einstellen des Voreinstellwerts 2 fiir den ND-Filter.

Preset3
1/128 /1/64 /1/32/1/16 /
1/8/1/4

Zum Einstellen des Voreinstellwerts 3 fiir den ND-Filter.

Gain
Verstirkungsein-
stellungen

Gain<L>
18dB/15dB/ 12dB /9dB / 6dB
/3dB/0dB /-3dB

Legt die Verstdrkung fiir die Position L des Schalters GAIN
fest.

Gain<M>
18dB / 15dB / 12dB / 9dB /
6dB /3dB /0dB /-3dB

Legt die Verstirkung fiir die Position M des Schalters GAIN
fest.

Gain<H>
18dB / 15dB / 12dB / 9dB /
6dB /3dB /0dB /-3dB

Legt die Verstéirkung fiir die Position H des Schalters GAIN
fest.

Gain <Turbo>
30dB / 18dB / 15dB /
12dB /9dB / 6dB / 3dB / 0dB /
-3dB

Legt den Verstiarkungswert fiir den Fall fest, dass eine
belegbare Taste gedriickt wird, der die Funktion Turbo Gain
zugewiesen wurde.

High Sensitivity Mode Schaltet den Hochempfindlichkeitsmodus ein bzw. aus.
On / Off

Shockless Gain Schaltet die nahtlose Verstiarkungsumschaltung ein bzw. aus.
On / Off
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Camera

Option Unteroptionen und Beschreibung

Einstellungen
Shutter Mode Legt den Betriebsmodus der elektronischen Blende fest.
Einstellungen fiir Speed / Angle Wird verwendet, um bewegliche Motive deutlich
die Betriebsbedin- aufzuzeichnen. Wihlt den Modus zum Einstellen der
gungen der elek- Belichtungszeit in Sekunden (Speed) oder als
tronischen Blende Verschlusswinkel (Angle) aus.

Shutter Speed Legt die Verschlusszeit fest, wenn der Speed-Modus

64F, 32F, 16F, 8F, 7F, 6F, 5F,
4F, 3F, 2F, 1/24, 1/25, 1/30,
1/32, 1/33, 1/40, 1/48, 1/50,
1/60, 1/96, 1/100, 1/120, 1/125,
1/250, 1/500, 1/1000, 1/2000,
174000, 1/8000

ausgewihlt ist. Die verfiigbaren Einstellungen héngen von der
Bildfrequenz des gewihlten Videoformats ab.

Shutter Angle
64F / 32F / 16F / 8F / TF /
6F / 5F/4F | 3F / 2F /
360.0° /300.0° /270.0° /
240.0°/216.0°/210.0°/
180.0°/172.8°/150.0° /
144.0° /120.0° /90.0° / 86.4° /

Legt den Verschlusswinkel fest, wenn der Angle-Modus
ausgewahlt ist.

72.0°/45.0°/30.0°/22.5°/
11.25°/5.6°
ECS Schaltet den ECS-Modus ein bzw. aus.
On / Off Wird fiir das Aufzeichnen ohne rollende horizontale Balken

auf dem LCD-/Sucherbildschirm verwendet.

ECS Frequency
8000 bis 23.99
(NTSC-Bereich: 60.00, PAL-
Bereich: 50.00)

Legt die ECS-Frequenz fest, wenn der ECS-Modus
ausgewihlt ist. Die verfiigbaren Einstellungen héngen von der
Bildfrequenz des gewihlten Videoformats ab.

Auto Exposure
Helligkeitseinstell
ungen der
automatischen
Belichtung

Level
+3.0/42.75/+42.5/+2.25/
+2.0/+1.75/+1.5/+1.25/
+1.0/40.75/+0.5/+0.25/
+0/-0.25/-0.5/-0.75/
-1.0/-1.25/-1.5/-1.75/
-2.0/-2.25/-25/-2.75/
-3.0

Legt den Korrekturpegel fest.

Mode Legt den Steuerungsmodus fest.
Backlight / Standard / Backlight: Gegenlichtmodus (Modus zum Verringern der
Spotlight Verdunkelung des Hauptmotivs, die bei Gegenlicht
entsteht)
Standard: Standardmodus
Spotlight: Punktlicht-Modus (Modus zum Verringern der
iiberstrahlten Spitzlichter des Hauptmotivs, die im
Scheinwerferlicht entstehen)
Speed Legt die Regelungsgeschwindigkeit fest.
—99 bis +99 (x0)
Auto ND Filter Schaltet die automatische Einstellung der ND-Filterdichte ein
On / Off bzw. aus.
AGC Schaltet die AGC-Funktion (automatische
On / Off Verstirkungssteuerung) ein bzw. aus.
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Camera

Option Unteroptionen und Beschreibung
Einstellungen
Auto Exposure AGC Limit Legt die maximale Verstirkung der AGC-Funktion fest.

Helligkeitseinstell

0dB /3dB /6dB /9dB / 12dB /

ungen der 15dB / 18dB
automatischen AGC Point Legt den F-Stoppwert der Blende fest, bei der die AGC-
Belichtung F2.8/F4/F5.6 Funktion einsetzt, sofern auf On gesetzt.
Auto Shutter Schaltet die automatische Verschlussfunktion ein bzw. aus.
On / Off
A.SHT Limit Legt die kiirzeste Belichtungszeit der automatischen
1/100/1/150 / 1/200 / Verschlussfunktion fest.
1/250/1/2000
A.SHT Point Legt den F-Stoppwert der Blende fest, bei dem die
F5.6/F8/F11 automatische Verschlussfunktion einsetzt.
Clip High light Schaltet die Funktion ein bzw. aus, die Uberbelichtungen
On / Off ignoriert, um eine flachere Reaktion bei extremer Helligkeit
zu erzielen.
Detect Window Legt den Belichtungsmesserbereich fest, um die Belichtung
1/2/3/4/5/6 automatisch an die Helligkeit des Motivs anzupassen. (Bei
manueller Belichtung ist diese Einstellung nicht verfiigbar.)
Detect Window Indication Schaltet die Funktion zur Anzeige des Detect Window mittels
On / Off einer Markierung ein/aus.
Color Bars Setting Schaltet die Farbbalken ein bzw. aus.
Einstellungen fiir On / Off
die Farbbalken Type Wiihlt den Farbbalkentyp aus.
ARIB / 100% / 75% / SMPTE
Flicker Reduce Mode Legt den Flimmerkorrekturmodus fest.
Einstellungen fiir Auto / On / Off
di‘? Frequency Legt die Frequenz der Stromquelle fest, von der das Licht
Flimmerkorrektur 50Hz/60Hz stammt, welches das Flimmern verursacht.

(NTSC-Bereich: 60.00, PAL-
Bereich: 50.00)

Flash Band Setting Schaltet die Flash Band-Korrektur ein bzw. aus. Dadurch
Reduce On / Off werden iiberstrahlte Spitzlichter an den oberen oder unteren
Einstellungen fiir Rindern des Bilds reduziert, die bei Verwendung eines Blitzes
die Flash Band- fiir Standbildkameras entstehen.
Korrektur
SteadyShot Setting Legt die Bildstabilisierungsfunktion fest.
Einstellungen fiir Active / Standard / Off
die  Hinweis |
Bildstabilisierung « Die Einstellung Active ist in den folgenden Fillen nicht
verfiigbar.
— Wenn Video Format auf 3840x2160 eingestellt ist
— Wiihrend Aufnahme mit Zeitlupe und Zeitraffer
Handle Zoom  Setting Legt die Geschwindigkeit des Zoomhebels fest.
Geschwindigkeits-  Off / Low / High / Variable
einstellungen fiir  pjop Legt die Zoomgeschwindigkeit des Zooms am Griff fest,
den Zoom am 1 bis 8 (8) wenn die Geschwindigkeit High ausgewihlt ist.
Griff FETITIY -
m Low Legt die Zoomgeschwindigkeit des Zooms am Griff fest,
1 bis 8 (3) wenn die Geschwindigkeit Low ausgewihlt ist.

76



Camera

Option Unteroptionen und
Einstellungen

Beschreibung

Speed Zoom  Setting
Einstellungen fiir On / Off

Schaltet die Geschwindigkeitszoom-Funktion ein bzw. aus.

den Geschwindig-

keitszoom

Auto Black Auto Black Balance Fiihrt den automatischen Schwarzabgleich durch.
Balance Execute / Cancel

Einstellungen fiir
den automatischen
Schwarzabgleich

« Kann nicht wihrend der Aufzeichnung oder der
Farbbalkenanzeige festgelegt werden.

» Kann nicht in den Modi fiir Intervallaufzeichnung,
Einzelbildaufzeichnung oder lange Verschlusszeit festgelegt
werden.

Video Light Video Light Set

Set Power Link / Rec Link / Rec

Einstellungen fiir Link + Stby
die Videoleuchte

Legt die Beleuchtungskontrollmethode der am Multi-

Interface-Schuh angeschlossenen Videoleuchte fest.

Power Link: Videoleuchte wird zusammen mit der
Stromversorgung des Camcorders ein- bzw. ausgeschaltet.

Rec Link: Videoleuchte wird beim Aufzeichnungsbeginn bzw.
-ende ein- bzw. ausgeschaltet.

Rec Link + Stby: Videoleuchte wird beim
Aufzeichnungsbeginn eingeschaltet und beim Ende in
Bereitschaft geschaltet.

Paint-Menii
Option Unteroptionen und Beschreibung
Einstellungen
HDR Paint HLG Type Legt den HLG-Typ fest, wenn Shooting Mode auf HDR
Setting HLG/HLG1/HLG2/HLG3 gesetzt ist.
Moduseinstellun- HLG: Zu ITU-R BT.2100 édquivalente Einstellung.
gen fiir den Dyna- HLG1: Einstellung mit stirkerer Rauschunterdriickung als
mikbereich HLG2. Der Dynamikbereich fiir die Aufnahme ist jedoch
kleiner.
HLG2: Einstellung mit Gleichgewicht zwischen
Dynamikbereich und Rauschunterdriickung.
HLG3: Einstellung mit groBerem Dynamikbereich als HLG2.
Der Rauschpegel ist jedoch hoher.
HLG1, HLG2 und HLG3 verwenden die gleiche
Gammakurvencharakteristik, jedoch mit unterschiedlichem
Dynamikbereich und anderer Rauschbalance.
HDR Black Offset Legt den HDR-Schwarzabweichwert relativ zur SDR-

—95 bis +103 (x0)

Einstellung (Master Black) fest, wenn Shooting Mode auf
HDR gesetzt ist.

HDR Knee Schaltet die Kniekorrekturfunktion fiir das HDR-Signal ein
On/ Off oder aus, wenn Shooting Mode auf HDR gesetzt ist.

HDR Knee Point Legt den Kniepunkt fiir HDR-Signale fest, wenn HDR Knee
—99 bis +99 (x0) auf On gesetzt ist.

HDR Knee Slope Legt die Kompressionsrate fiir HDR-Signale fest, wenn HDR
-99 bis +99 (x0) Knee auf On gesetzt ist.
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Option Unteroptionen und Beschreibung
Einstellungen
White Preset White Passt die voreingestellte Farbtemperatur an, wenn eine
WeiBwerteinstel- 10000K bis 2100K (3200K)  Voreinstellung fiir den WeiBabgleich-Modus ausgewihlt ist.
e  Hinweis |
* Eine Anderung der Einstellung ist auch bei Anderung der
Einstellung fiir Preset White auf dem Bildschirm nicht zu
sehen, wenn fiir den WeiBabgleich-Modus keine
Voreinstellung ausgewihlt ist.
Color Temp <A> Zeigt die in Speicher A gespeicherte Farbtemperatur des
50000K bis 1500K (3200K)  WeiBabgleichs.
Color Temp Balance <A> Legt die in Speicher A gespeicherten Verstiarkungswerte des
-99 bis +99 (+0) WeiBabgleichs (an die Verstirkung der R- und B-Signale
gekoppelt) fest.
R Gain <A> Legt den in Speicher A gespeicherten R-Verstarkungswert fiir
—-99 bis +99 (x0) den Weilabgleich fest.
B Gain <A> Legt den in Speicher A gespeicherten B-Verstirkungswert fiir
—99 bis +99 (x0) den Weilabgleich fest.
Color Temp <B> Zeigt die in Speicher B gespeicherte Farbtemperatur des
50000K bis 1500K (3200K) WeiBabgleichs an.
Color Temp Balance <B> Legt die in Speicher B gespeicherten Verstarkungswerte fiir
-99 bis +99 (+0) den Weilabgleich (an die Verstirkung der R- und B-Signale
gekoppelt) fest.
R Gain <B> Legt den in Speicher B gespeicherten R-Verstirkungswert fiir
—99 bis +99 (x0) den Weilabgleich fest.
B Gain <B> Legt den in Speicher B gespeicherten B-Verstiarkungswert fiir
-99 bis +99 (x0) den Weilabgleich fest.
White Setting  Shockless White Legt die Reaktionsgeschwindigkeit des WeiBabgleichs beim
Einstellungen fiir Off/1/2/3 Wechsel in den WeiBabgleich-Modus fest.
die Anpassung des Off: Sofortiger Wechsel.
WeilBabgleichs 1 bis 3: Mit zunehmender Zahl verlangsamt sich die
Geschwindigkeit.
ATW Speed Legt die Reaktionsgeschwindigkeit im Modus ATW fest.
1/2/3/41/5 1: Kiirzeste Reaktionszeit
White Switch<B> Wiihlt den Einstellungsmodaus fiir den Weilabgleich, wenn der
Memory / ATW Schalter WHT BAL auf B gestellt wird.
Filter White Memory Schaltet die Funktion, die den WeiBabgleich-Speicherbereich
On / Off fiir die einzelnen ND-Filter festlegt, ein bzw. aus.
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Option Unteroptionen und Beschreibung
Einstellungen
Offset White  Offset White <A> Legt fest, ob dem WeiBabgleich in Speicher A ein
Einstellungen fiir On / Off Abweichwert hinzugefiigt werden soll (On) oder nicht (Off).
die W§i13wert- Warm Cool <A> Wenn Offset White <A> auf On gesetzt ist, wird hierdurch der
Abweichung —-99 bis +99 (x0) Abweichwert (als Farbtemperatur) angegeben, welcher dem
WeiBabgleich in Speicher A hinzugefiigt werden soll.
(Beachten Sie, dass der Fehler mit hoheren Abweichwert-
Farbtemperaturen zunimmt. Beobachten Sie das tatsdchliche
Bild wihrend der Anpassung.)
Warm Cool Balance <A> Legt eine prizisere Farbtemperatur fiir den Fall fest, dass mit
—99 bis +99 (x0) der Einstellung Warm Cool <A> kein zufriedenstellendes Bild
erzielt wird.
Offset White <B> Legt fest, ob dem Weilabgleich in Speicher B ein
On / Off Abweichwert hinzugefiigt werden soll (On) oder nicht (Off).
Warm Cool <B> Wenn Offset White <B> auf On gesetzt ist, wird hierdurch der
-99 bis +99 (+0) Abweichwert (als Farbtemperatur) angegeben, welcher dem
WeiBabgleich in Speicher B hinzugefiigt werden soll.
(Beachten Sie, dass der Fehler mit hoheren Abweichwert-
Farbtemperaturen zunimmt. Beobachten Sie das tatsdchliche
Bild wihrend der Anpassung.)
Warm Cool Balance <B> Legt eine prizisere Farbtemperatur fiir den Fall fest, dass mit
—-99 bis +99 (x0) der Einstellung Warm Cool <B> kein zufriedenstellendes Bild
erzielt wird.
Offset White<ATW> Legt fest, ob dem ATW-Weilabgleich ein Abweichwert
On / Off hinzugefiigt werden soll (On) oder nicht (Off).
Warm Cool<ATW> Legt den zum ATW-Weilabgleich hinzugefiigten
—-99 bis +99 (x0) Abweichwert als Farbtemperatur fest, wenn Offset
White<ATW> auf On gesetzt ist.
Warm Cool Balance<ATW> Legt eine prizisere Farbtemperatur fiir den Fall fest, dass mit
—99 bis +99 (x0) der Einstellung Warm Cool<ATW> kein zufriedenstellendes
Bild erzielt wird.
Black Setting Schaltet die Schwarzwertkorrektur ein bzw. aus.
Schwarzwertein- On / Off
stellungen Master Black Legt den Master-Schwarzpegel fest.
-99 bis +99 (+0)
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Option Unteroptionen und Beschreibung

Einstellungen
Gamma Setting Schaltet die Gammakorrektur ein bzw. aus.
Einstellungen fiir On / Off

die
Gammakorrektur

Master Gamma
-99 bis +99 (+0)

Legt den Master-Gammapegel fest.

Gamma Category
STD/HG

‘Wihlt Standard-Gamma (STD) oder HG aus.

Gamma Select

Wenn Gamma Category auf STD

gesetzt ist:

STD1 DVW /STD2 x4.5 /
STD3 x3.5 / STD4 240M /
STD5 R709 / STD6 x5.0

Wenn Gamma Category auf HG

gesetzt ist:
HG1 3250G36 /
HG2 4600G30 /
HG3 3259G40 /
HG4 4609G33

Wihlt die Gammatabelle fiir die Gammakorrektur.

Knee
Einstellungen fiir
die Kniekorrektur

Setting
On/ Off

Schaltet die Kniekorrektur ein bzw. aus.
(Diese Option ist aktiviert, wenn Gamma >Gamma Category
auf STD gesetzt ist.)

Auto Knee
On / Off

Zum Ein-/Ausschalten der automatischen Kniefunktion.

Point
75% bis 109% (90%)

Legt den Kniepunkt fest.

Slope
—99 bis +99 (x0)

Legt die Kompressionsrate fest.

Knee Saturation
On / Off

Aktiviert bzw. deaktiviert die Kniesittigungseinstellung
(regelt die Farbgebung iiber dem Kniepunkt).

Knee Saturation Level
-99 bis +99 (+0)

Legt den Pegel fiir die Farbgebung iiber dem Kniepunkt
(Kniesittigung) fest.

White Clip

Einstellungen fiir

die WeiB3-Amplitu-
denkorrektur

Setting Schaltet die Funktion zur Weill-Amplitudenbegrenzung ein
On/ Off bzw. aus.
Level Legt den Weill-Amplitudenbegrenzungspegel fest.

90.0% bis 109.0%

80



Option Unteroptionen und Beschreibung
Einstellungen
Detail(QFHD) Manual Setting Schaltet die Detailanpassung ein bzw. aus.
Einstellungen fiir On / Off
die Level Legt die Detailstufe fest.
Detailanpassung ~99 bis +99 (+0)
(QFHD) - — —
Frequency Stellt die Mittelfrequenz fiir Details ein. (Eine hohere
-99 bis +99 (+0) Einstellung der Mittelfrequenz verringert die Details.)
Knee Aperture Schaltet die Knie6ffnungskorrektur ein bzw. aus.
On / Off
Knee Aperture Level Legt den Knie6ffnungspegel fest.
—99 bis +99 (x0)
White Limit Passt den Weifidetail-Begrenzer an.
99 bis +99 (x0)
Black Limit Passt den Schwarzdetail-Begrenzer an.
99 bis +99 (x0)
V Detail Creation Legt die (aus dem R-Signal oder aus dem G-Signal oder aus
NAM/Y/G/G+R dem B-Signal) Signalquelle des V-Signals auf NAM, Y, G,
oder G+R fest, je nachdem welches Signal den héchsten Pegel
hat.
Detail(HD) Manual Setting Schaltet die Detailanpassung ein bzw. aus.
Einstellungen fiir On / Off
die ) Level Legt die Detailstufe fest.
Detailanpassung ~99 bis +99 (+0)
HD
(HD) Frequency Stellt die Mittelfrequenz fiir Details ein.
—99 bis +99 (x0) (Eine hohere Einstellung der Mittelfrequenz verringert die

Details.)

Knee Aperture

Schaltet die Knie6ffnungskorrektur ein bzw. aus.

On / Off
Knee Aperture Level Legt den Knie6ffnungspegel fest.
-99 bis +99 (x0)
White Limit Passt den Weifidetail-Begrenzer an.
—-99 bis +99 (x0)
Black Limit Passt den Schwarzdetail-Begrenzer an.
99 bis +99 (x0)
V Detail Creation Legt die (aus dem R-Signal oder aus dem G-Signal oder aus
NAM/Y/G/G+R dem B-Signal) Signalquelle des V-Signals auf NAM, Y, G,

oder G+R fest, je nachdem welches Signal den hdchsten Pegel
hat.
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Option Unteroptionen und Beschreibung
Einstellungen
Detail(SD) Manual Setting Schaltet die Detailanpassung ein bzw. aus.
Einstellungen fiir On / Off
die Level Legt die Detailstufe fest.
Detailanpassung ~99 bis +99 (+0)
SD —
D) Frequency Stellt die Mittelfrequenz fiir Details ein.
-99 bis +99 (+0) (Eine hohere Einstellung der Mittelfrequenz verringert die
Details.)
Knee Aperture Schaltet die Kniedffnungskorrektur ein bzw. aus.
On / Off
Knee Aperture Level Legt den Knie6ffnungspegel fest.
—99 bis +99 (x0)
White Limit Passt den Weifidetail-Begrenzer an.
—99 bis +99 (x0)
Black Limit Passt den Schwarzdetail-Begrenzer an.
—99 bis +99 (x0)
V Detail Creation Legt die (aus dem R-Signal oder aus dem G-Signal oder aus
NAM/Y/G/G+R dem B-Signal) Signalquelle des V-Signals auf NAM, Y, G,
oder G+R fest, je nachdem welches Signal den hochsten Pegel
hat.
Skin Detail Setting Schaltet die Oberflichenfarbdetailkorrektur ein bzw. aus.
Einstellungen fiir On / Off
die Ober.'ﬂ;'ichen- Area Detection Ermittelt die fiir die Oberflichenfarbdetailkorrektur
farbdetailkorrektur  Execute / Cancel verwendete Farbe.
Execute: Funktion ausfiihren.
Area Indication Schaltet die Zebramusteranzeige in dem Farbbereich ein bzw.
On / Off aus, in dem die Detailkorrektur fiir Hautténe vorgenommen
werden soll.
Level Legt den Oberflichenfarbdetailpegel fest.
-99 bis +99 (x0)
Saturation Legt die Sittigung der Farbe fest, die von der
-99 bis +99 (x0) Oberflichenfarbdetailkorrektur anvisiert wird.
Hue Legt den Farbton der Farbe fest, die von der
0 bis 356 Oberflichenfarbdetailkorrektur anvisiert wird.
Width Legt den Farbtonbereich der Farbe fest, die von der
0 bis 90 (40) Oberflichenfarbdetailkorrektur anvisiert wird.
Aperture Setting Aktiviert bzw. deaktiviert die Offnungskorrektur (verbessert
Einstellungen fiir On/ Off die Auflésung durch Hinzufiigen von Hochfrequenz-
die Offnungssignalen zum Videosignal, um Verschlechterungen
Offnungskorrektur auszugleichen, die durch die Hochfrequenzeigenschaften
entstehen).
Level Legt den Blendenoffnungspegel fest.
—99 bis +99 (x0)
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Option Unteroptionen und Beschreibung
Einstellungen
Matrix Setting Schaltet die Matrixkorrektur ein bzw. aus.
Einstellungen fiir On/ Off
die Adaptive Matrix Schaltet die adaptive Matrixkorrektur ein bzw. aus.
Matrixkorrektur On / Off
Preset Matrix Schaltet die voreingestellte Matrixkorrektur ein bzw. aus.
On/ Off
Preset Select Wihlt eine voreingestellte Matrix aus.
1:SMPTE 240M /

2:ITU-709 / 3:SMPTE Wide /
4:NTSC/5:EBU / 6:PAL

Maintenance
Wartungseinstel-
lungen

Test Saw
On / Off

Schaltet das Test-Saw-Signal ein bzw. aus.

Audio-Menii

Option

Unteroptionen und
Einstellungen

Beschreibung

Audio Input
Einstellungen fiir

CH2 EXT Input Select
INPUT1 /INPUT2

Wiihlt die Eingabe fiir die Aufzeichnung auf Kanal 2 aus. Ist
nur aktiviert, wenn die Audioquelle EXT ausgewihlt ist.

die Einspeisung
der Audiosignale

CH3 Input Select
Off / INPUT1 / Internal MIC /
Shoe CH1

Wihlt die Eingabe fiir die Aufzeichnung auf Kanal 3 aus.

CH4 Input Select
Off /INPUT1 / INPUT2 /
Internal MIC / Shoe CH2

Wihlt die Eingabe fiir die Aufzeichnung auf Kanal 4 aus.

INPUT1 MIC Reference
-80dB /-70dB / -60dB /
—50dB / —40dB / -30dB

Zum Auswihlen des bei Einstellung des Schalters INPUT 1
auf MIC verwendeten Referenzeingangspegels.

INPUT2 MIC Reference
-80dB /-70dB / —60dB /
-50dB / -40dB / -30dB

Zum Auswihlen des bei Einstellung des Schalters INPUT2
auf MIC verwendeten Referenzeingangspegels.

Internal MIC Level
—-12dB / -6dB / 0dB / +6dB /
+12dB

Zum Auswihlen des Pegels des eingebauten Mikrofons. Sie
konnen den Pegel unabhiéngig von der Stellung des Reglers
AUDIO LEVEL auswihlen.

Line Input Reference
+4dB /0dB / -3dB / EBUL

Zum Auswihlen des bei Einstellung des Schalters INPUT1/
INPUT?2 auf LINE verwendeten Referenzeingangspegels.

Reference Level
—20dB /-18dB / -16dB /

Wihlt den Aufnahmepegel des 1-kHz-Referenztons aus.

—12dB / EBUL
CH1 Wind Filter Schaltet den Windgerduschfilter fiir die Aufnahme auf
On / Off Kanal 1 ein/aus.

83



Option Unteroptionen und Beschreibung
Einstellungen
Audio Input CH2 Wind Filter Schaltet den Windgeriuschfilter fiir die Aufnahme auf
Einstellungen fiir On / Off Kanal 2 ein/aus.
die Einspeisung - CH3 Wind Filter Schaltet den Windgerauschfilter fiir die Aufnahme auf
der Audiosignale On / Off Kanal 3 ein/aus.
CH4 Wind Filter Schaltet den Windgeréuschfilter fiir die Aufnahme auf
On / Off Kanal 4 ein/aus.
CH3 Level Control Wihlt automatische/manuelle Anpassung des Eingangspegels
Auto / Manual fiir die Aufnahme auf Kanal 3 aus.
CH4 Level Control Wiihlt automatische/manuelle Anpassung des Eingangspegels
Auto / Manual fiir die Aufnahme auf Kanal 4 aus.
CH3 Input Level Legt den Eingangspegel fiir die Aufnahme auf Kanal 3 fest,
0 bis 99 (49) wenn manuelle Anpassung ausgewihlt ist.
CH4 Input Level Legt den Eingangspegel fiir die Aufnahme auf Kanal 4 fest,
0 bis 99 (49) wenn manuelle Anpassung ausgewahlt ist.
Limiter Mode Wihlt die Begrenzercharakteristik (Sattigungspegel) fiir den

Off /-6dB / —9dB / -12dB /
—-15dB /-17dB

Fall aus, dass bei manueller Einstellung des
Audioeingangspegels laute Signale eingespeist werden.

CH1&2 AGC Mode
Mono / Stereo

Wiihlt den Modus fiir die automatische Pegelanpassung fiir
Aufzeichnung auf Kanal 1 und Kanal 2 aus. Wenn Stereo
ausgewihlt wird, ist die AGC beider Kanile verkniipft.

CH3&4 AGC Mode Wiihlt den Modus fiir die automatische Pegelanpassung fiir
Mono / Stereo Aufzeichnung auf Kanal 3 und Kanal 4 aus. Wenn Stereo
ausgewihlt wird, ist die AGC beider Kanile verkniipft.
AGC Spec Wiihlt die AGC-Charakteristik (Sattigungspegel) fiir den Fall
—6dB /-9dB /-12dB / aus, dass bei automatischer Einstellung des
—-15dB /-17dB Audioeingangspegels laute Signale eingespeist werden.

1kHz Tone on Color Bars
On / Off

Schaltet das 1-kHz-Referenzsignal beim Anzeigen von
Farbbalken ein bzw. aus.

Audio Output
Einstellungen fiir
die Audioausgabe

Monitor CH ‘Wiihlt die an die Kopfhorerbuchse und den integrierten
CH1/CH2/ CH3/CH4 /MIX  Lautsprecher auszugebenden Audiokanile aus.
ALL/CH1/CH2/CH3/CH4

Headphone Out Legt fiir den Kopfhorerausgang Mono oder Stereo fest.

Mono / Stereo

Alarm Level

Zum Einstellen der Alarmlautstirke.

0 bis 7 (4)

HDMI Output CH ‘Wiihlt die Kombination der Audiokandle am HDMI-Ausgang
CH1/CH2 / CH3/CH4 aus.

Analog Output CH Wihlt die Kombination der Audiokanile am analogen Audio-
CH1/CH2 / CH3/CH4 Ausgang fest.
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Video-Menii

Option Unteroptionen und
Einstellungen

Beschreibung

Output On/Off SDI
Einstellungen fiir On / Off

Schaltet die SDI-Ausgabe ein bzw. aus.

die Videoausgabe HpmI
On/Off

Schaltet die HDMI-Ausgabe ein bzw. aus.

Output Format SDI
Einstellungen fiir

das Ausgabeformat

* Nihere

Zum Einstellen der Auflosung des SDI-Ausgangs.
SET: Funktion festlegen.

Informationen zu
den Einstellungen
erhalten Sie unter

HDMI

,, Videoformate und
Ausgangssignale*

Zum Einstellen der Auflosung des HDMI-Ausgangs.
SET: Funktion festlegen.

(Seite 109).
Output Display SDI/HDMI Zum Auswihlen der Einblendung von Menii oder Status in
Einstellungen fiir On / Off das SDI/HDMI-Ausgangssignal.

das Ausgangssignal

SDI/HDMI Rec  Setting
Control On / Off
Einstellungen zur

Steuerung extern

Schaltet den Aufzeichnungsstart und -stopp eines extern
angeschlossenen Geriits per SDI-/HDMI-Ausgangssignal ein
bzw. aus.

angeschlossener

Geriite

Down Down Converter Stellt den Ausgabemodus (Bildformat) fiir SD-Signale ein.
Converter Edge Crop / Letter Box / Edge Crop: Beschneidet ein 16:9-Bild an den Seiten zur

Betriecbsmodusdes ~ Squeeze
Abwirtskonverters

Ausgabe als 4:3-Bild.

Letter Box: Deckt den oberen und unteren Bereich des 4:3-
Bildes ab und zeigt ein 16:9-Bild in der Mitte des
Bildschirms an.

Squeeze: Staucht das 16:9-Bild horizontal zur Ausgabe als
4:3-Bild.

LCD/VF-Menii

LCD/VF

Option Unteroptionen und Beschreibung
Einstellungen
LCD Setting  Brightness Zum Einstellen der Helligkeit des LCD-Bildschirms.
Einstellungen fiir -99 bis +99 (x0)
den LCD-
Bildschirm
VF Setting Brightness Stellt die der Helligkeit des Sucherbilds ein.
Einstellungen fiir -99 bis +99 (+0)
den Sucher Color Mode Wihlt den Anzeigemodus des Suchers bei der E-E-Anzeige/
Color / B&W Aufnahme aus.
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LCD/VF

Option Unteroptionen und Beschreibung
Einstellungen
Peaking Setting Zum Ein-/Ausschalten der Konturverstirkung.
Einstellung der On / Off
Konturverstirkung Type Wiihlt den Typ der Konturverstirkung aus.
Normal / Color Normal: Normale Konturverstirkung
Color: Konturverstirkung in Farbe
Normal Peaking Frequency Wihlt die normale (Normal) oder die hohe
Normal / High Konturverstirkungsfrequenz (High) aus.
Normal Peaking Level Stellt den normalen Konturverstidrkungswert ein.
0 bis 99 (50)
Color Wihlt die Farbe des Farb-Konturverstarkungssignals aus.
B&W /Red/ Yellow / Blue
Color Peaking Level Stellt den Farb-Konturverstirkungswert ein.
0 bis 99 (50)
Marker Setting Schaltet simtliche Markierungsanzeigen ein bzw. aus.
Einstellung fiir die ~ On/ Off
Markierungsan-  Color Wiihlt die Farbe der Markierungsanzeige aus.
zeige White / Yellow / Cyan / Green
/ Magenta / Red / Blue
Center Marker Schaltet die Mittenmarkierung ein bzw. aus.
1/2/3/4/0ff
Safety Zone Schaltet die Sicherheitszonenmarkierung ein bzw. aus.
On / Off
Safety Area Wihlt die GroBe (Prozentsatz des gesamten Bildschirms) der

80% / 90% / 92.5% / 95%

Sicherheitszonenmarkierung.

Aspect Marker
Line / Mask / Off

Zum Auswihlen der Bildformatmarkierung.
Line: Anzeige als weifle Linien.

Mask: Anzeige von Bereichen aulerhalb des
Markierungsbereichs erfolgt mit abgesenktem
Videosignalpegel.

Off: Keine Anzeige

Aspect Mask
0bis 15 (12)

Wiihlt die Helligkeit des Bilds aulerhalb der
Bildformatmarkierung aus, wenn Aspect Marker auf Mask
gesetzt ist.

Aspect Safety Zone
On/ Off

Schaltet die Bildformat-Sicherheitszonenmarkierung ein bzw.
aus.

Aspect Safety Area
80% /90% / 92.5% / 95%

Wihlt die GroBe (Prozentsatz des gesamten Bildschirms) der
Bildformat-Sicherheitszonenmarkierung aus.

Aspect Select
4:3/13:9/14:9/15:9/
16:9/17:9/1.66:1/1.85:1/
2.35:1/2.4:1

Zum Auswihlen des Seitenverhéltnisses
Bildformatmarkierung.

Guide Frame

Schaltet die Rastermarkierung ein bzw. aus.

On / Off

100% Marker Schaltet die 100%-Sicherheitszonenmarkierung ein bzw. aus.
On / Off

User Box Schaltet die Anzeige des Kasten-Cursors ein bzw. aus.
On / Off

User Box Width Legt wird die Breite des Kasten-Cursors (Abstand von der
40 bis 999 (500) Mitte bis zur linken oder rechten Ecke) fest.
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LCD/VF

Option Unteroptionen und Beschreibung
Einstellungen
Marker User Box Height Legt die Hohe des Kasten-Cursors (Abstand von der Mitte bis
Einstellung fiir die 70 bis 999 (500) zur oberen oder unteren Ecke) fest.
Markierungsan-  “(jser Box H Position Legt die horizontale Position der Mitte des Kasten-Cursors
ze1ge —479 bis +479 (x0) fest.
User Box V Position Legt die vertikale Position der Mitte des Kasten-Cursors fest.
—464 bis +464 (+0)
Zebra Setting Zum Ein-/Ausschalten der Zebrafunktion.
Einstellung des On/ Off
Streifenmusters Zebra Select Wiihlt den Typ des Zebramusters aus (Zebral, Zebra2, Both).
1/2/Both
Zebral Level Legt den Zebral-Anzeigepegel fest.
0% bis 107% (70%)
Zebral Aperture Level Legt den Zebral-Blendenoffnungspegel fest.
1% bis 20% (10%)
Zebra2 Level Legt den Zebra2-Anzeigepegel fest.
0% bis 109% (100%)
Gamma Setting ‘Wiihlt die Funktionseinstellungen des Gamma-
Display Assist HLG—709 (800%) / Off Anzeigeassistenten aus.
Einstellungen des
Gamma-
Anzeigeassistenten
Display On/Off Network Status Zum Auswihlen der Optionen, die auf dem LCD-/

Einstellungen fiir

On / Off

die anzuzeigenden
Elemente

Rec/Play Status
On / Off

Tally
On / Off

Battery Remain
On / Off

Focus Mode
On / Off

Focus Position
Meter / Feet / Off

Focus Macro
On / Off

Face Detection Frame
On / Off

Lens Info
Meter / Feet / Off

Rec Format
On / Off

Frame Rate
On / Off

Zoom Position
Number / Bar / Off

Digital Extender
On / Off

Sucherbildschirm angezeigt werden sollen.
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LCD/VF

Option

Unteroptionen und
Einstellungen

Beschreibung

GPS
On/ Off

SteadyShot
On / Off

Gamma
On / Off

SDI/HDMI Rec Control
On / Off

Gamma Display Assist
On / Off

Proxy Status
On / Off

Focus Assist Indicator
On / Off

Focus Assist Area
On / Off

Media Status
On / Off

Video Signal Monitor
Off / Waveform / Vector /
Histogram

Clip Name
On / Off

White Balance
On / Off

Scene File
On / Off

Auto Exposure Mode
On / Off

Auto Exposure Level
On / Off

Timecode
On / Off

ND Filter
On / Off

Iris
On / Off

Gain
On / Off

Shutter
On / Off

Audio Level Meter
On / Off

Video Level Warning
On / Off

Clip Number
On / Off

Notice Message
On/ Off
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TC/UB-Menii

TC/UB

Option Unteroptionen und Beschreibung

Einstellungen
Timecode Mode Legt den Ausfithrungsmodus fiir den Timecode fest.
Einstellungen fiir Preset / Regen / Clock Preset: Der Timecode beginnt ab einem vorgegebenen Wert.
den Timecode Regen (Regeneration): Der Timecode wird ab dem Timecode

des vorhergehenden Clips fortgesetzt.
Clock: Als Timecode wird die interne Uhr verwendet.
Run Rec Run: Der Timecode lduft nur wihrend der Aufzeichnung.

Rec Run / Free Run

Free Run: Der Timecode lauft immer, und zwar unabhéngig
vom Aufnahmestatus.

Setting Stellt den Timecode auf einen beliebigen Wert ein.
SET: Stellt den Wert ein.
Reset Setzt den Timecode auf 00:00:00:00 zuriick.
Execute / Cancel Execute: Funktion ausfiihren.
TC Format Wihlt das Timecode-Format.
DF / NDF DF: Drop Frame
NDF: Non-Drop Frame
Users Bit Mode Legt den Anwenderdatenmodus fest.
Einstellungen zu Fix / Time Fix: In den Anwenderdaten wird ein beliebiger fester Wert
Anwenderdaten verwendet.
Time: Verwendet das aktuelle Datum und die aktuelle Uhrzeit
in den Anwenderdaten.
Setting Legt die Anwenderdaten auf einen beliebigen Wert fest.

HDMI TC Out  Setting
Einstellungen fiir On / Off
den Timecode-

Ausgang

Legt fest, ob der Timecode zu anderen Zwecken per HDMI an
Gerite weitergegeben werden soll.

Recording-Menii

Option Unteroptionen und
Einstellungen

Beschreibung

S&Q Motion Setting
Einstellungen fiir On / Off

Zum Ein-/Ausschalten von Zeitlupe und Zeitraffer.

den Zeitlupen- &  Frame Rate
Zeitraffermodus 1fps bis 60fps

Zum Einstellen der Bildfrequenz bei der Aufnahme mit
Zeitlupe und Zeitraffer, wenn die Einstellung fiir Zeitlupe und
Zeitraffer auf On gesetzt ist.

Die verfiigbaren Einstellungen hingen von der ausgewihltem
Systemfrequenz, dem Codec und dem Videoformat ab.
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Option Unteroptionen und Beschreibung

Einstellungen
Interval Rec Setting Schaltet den Intervall-Aufzeichnungsmodus ein bzw. aus.
Einstellungen fiir On / Off
den Intervall-Auf- 1peryal Time Legt das Intervall zwischen Aufzeichnungen im Intervall-
zeichnungsmodus 1sec/2sec/3sec/4sec/Ssec/ Aufzeichnungsmodus fest (wenn Interval Rec auf On gesetzt

6sec / 7sec / 8sec / 9sec / 10sec ist).
/ 15sec / 20sec / 30sec / 40sec /
50sec / 1min / 2min / 3min /

4min / Smin / 6min / 7min /

8min /9min / 10min / 15min /
20min / 30min / 40min / 50min

/ 1hour / 2hour / 3hour / 4hour /
6hour / 12hour / 24hour

Number of Frames Legt die aufzuzeichnende Anzahl der Einzelbilder pro
Die Einstellungen variieren in ~ Einstellung im Intervall-Aufzeichnungsmodus fest (wenn
Abhingigkeit zur Einstellung  Interval Rec auf On gesetzt ist).
fiir die Systemfrequenz.

2frames / 6frames / 12frames Wenn die Bildfrequenz des Aufnahmeformats 50P oder

59.94P lautet.
1frame / 3frames / 6frames / ~ Wenn die Bildfrequenz des Aufnahmeformats nicht S0P oder
9frames 59.94P lautet.
Pre-Lighting Zum Einstellen der Zeit in Sekunden, welche die Videoleuchte
Off / 2sec / 5sec / 10sec vor Beginn der Intervallaufzeichnung eingeschaltet wird. Um
die Videoleuchte nicht einzuschalten, wihlen Sie Off aus.
Picture Cache Setting Schaltet den Bildpuffer-Aufzeichnungsmodus ein bzw. aus.
Rec On / Off
Einstellungen fiir ~ Cache Rec Time Legt die Zeit zum Sammeln von Bildmaterial im Bildpuffer
den Bildpuffer- Die Einstellungen variieren in ~ fest (Zeit fiir Aufzeichnung mit Bildpufferfunktion).
Aufzeichnungsmo-  Abhiingigkeit zur Einstellung
dus fiir das Aufnahmeformat.
Clip Setting Zum Ein-/Ausschalten des Modus fiir kontinuierliche
Continuous On / Off Clipaufzeichnung.
Rec Find Mode Wihlt die durch Driicken der Tasten NEXT/PREV ausgeldste
Einstellungen fiir Clip / Rec Start Funktion aus.
den Modus der
kontinuierlichen
Clipaufzeichnung
Simul Rec Setting Zum Ein-/Ausschalten des Modus fiir gleichzeitige Aufnahme
Einstellungen fiir On/ Off und zum Festlegen der Zielmedien.
den Modus fiir Rec Button Set Weist die Aufnahmetasten zur Steuerung der einzelnen
gleichzeitige ) Aufzeichnungsmedien zu.
Aufnahme Rec Button:| A B

Handle Rec Button:[ A |
/ Rec Button:
Handle Rec Button: /
Rec Button: Handle Rec
Button: m
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Option Unteroptionen und Beschreibung
Einstellungen
Proxy Rec Setting Zum Ein-/Ausschalten des Proxy-Aufnahmemodus.
Einstellungen fiir On / Off
den Proxy- Proxy Format Zum Einstellen der BildgroBe fiir die Proxy-Datei.
Aufnahmemodus 1920x1080(9Mbps) / Bei Einstellung auf 1920x1080(9Mbps) und einer
1280x720(9Mbps) / Systemfrequenz von 23.98 wird zur Aufnahme Progressive-
1280x720(6Mbps) / Abtastung verwendet. Bei anderen Systemfrequenzen als
640%x360(3Mbps) / 23.98 wird zur Aufnahme Interlaced-Abtastung verwendet.
480x270(1Mbps) / Bei anderen Einstellungen als 1920x1080(9Mbps) wird
480%270(0.5Mbps) unabhingig von der Systemfrequenz zur Aufnahme stets
Progressive-Abtastung verwendet.
Audio Channel Zum Auswihlen des Audiokanals, der als Proxy-Daten
CH1/CH2 / CH3/CH4 aufgenommen werden soll.
Rec Review Setting Zum Auswiihlen der Wiedergabedauer von soeben
Einstellungen fiir 3sec / 10sec / Clip aufgenommenen Clips zur Priifung.
die Priifung der
Aufnahme
Thumbnail-Menii

Thumbnail

Option Unteroptionen und Beschreibung
Einstellungen
Display Clip Zeigt den Bildschirm ,,Display Clip Properties* an.
Properties
Anzeigen des
Bildschirms
,Display Clip
Properties*
Lock/Unlock  Select Clip Hieriiber wird ein Clip ausgewiihlt und ge- bzw. entsperrt.
Clip Lock All Clips Alle Clips werden gesperrt.
Eézsgilg-giinufzr Unlock All Clips Alle Clips werden entsperrt.
Delete Clip Select Clip Der gewihlte Clip wird geldscht.

Loschen von Clips

All Clips

Alle angezeigten Clips werden geldscht.

Copy Clip Select Clip Kopiert ausgewihlte Clips.

Clips kopieren All Clips Kopiert alle auf dem Medium befindlichen Clips.
Thumbnail Essence Mark Thumbnail Zeigt mit Aufnahmestartmarkierungen markierte Einzelbilder
View All / Rec Start an.

Einstellungen fiir  Clip Thumbnail Zeigt Miniaturbilder aufgezeichneter Clips an.

die Miniaturbil-

danzeige

Customize Thumbnail Caption Andert die Informationen, die unter den Miniaturbildern
View Date Time / Time Code / angezeigt werden.

Einstellungen fiir Duration / Sequential Number

Miniaturbildan-

zeige von Stand-
bildern
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Media-Menii

Das Media-Menii ist nur verfiigbar, wenn ein Medium eingesetzt ist.

Option Unteroptionen und Beschreibung
Einstellungen
Update Media Media(A) Die Verwaltungsdatei auf der Speicherkarte in Einschub A
Aktualisieren von Execute / Cancel wird aktualisiert.
Medien Media(B) Die Verwaltungsdatei auf der Speicherkarte in Einschub B
Execute / Cancel wird aktualisiert.
Format Media Media(A) Zum Formatieren der Speicherkarte in Einschub A.
Formatieren von Execute / Cancel Execute: Funktion ausfiihren.
Medien Media(B) Zum Formatieren der Speicherkarte in Einschub B.
Execute / Cancel Execute: Funktion ausfiihren.
Utility SD/MS Zum Formatieren des Mediums im UTILITY SD/MS-

Execute / Cancel

Einschub.
Execute: Funktion ausfiihren.

UsSB
Einstellungen zum
Kopieren von
Clips von einem in
einen Speicherkar-
teneinschub einge-

Select Folder

Wihlt einen Ordner auf dem USB-Medium aus.
Erstellt einen neuen Ordner auf dem USB-Medium.

View Clip List

Zeigt eine Liste der auf dem USB-Medium befindlichen Clips
an.

Rename Folder

Benennt einen Ordner auf dem USB-Medium um.

setzten Error Check Wihlt aus, ob beim Kopieren von Clips auf ein USB-Medium
Aufnahmeme- On/ Off auf Fehler gepriift werden soll.
dium auf USB- Format USB Formatiert (initialisiert) das USB-Medium.
Medien Execute / Cancel Execute: Funktion ausfiihren.
Copy to USB Wihlt den Zieleinschub fiir das Kopieren von Clips von einer

Media(A) to USB / Media(B)
to USB / Media(A)(B) to USB

Speicherkarte in einen Ordner auf einem USB-Medium aus.

Media Remain

Zeigt den verbleibenden freien Speicherplatz auf dem USB-
Medium an (nur Anzeige).
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Option Unteroptionen und Beschreibung

Einstellungen
Clip Naming  Title Prefix Zeigt den Bildschirm Edit File Name zum Einstellen des
Einstellungen zum nnn_ (nnn=die letzten drei Titelteils (4 bis 46 Zeichen) der Clipnamen an.

Benennen und
Loschen von Clips

Ziffern der Seriennummer)
(max. 7-Stellen-Anzeige)

Struktur des Bildschirms Edit File Name
Zeichenauswahlbereich (3 Zeilen):
Wihlen Sie hier die Zeichen, die im Title Prefix-Bereich an
der Cursorposition eingefiigt werden sollen.
1#$%()+.-.;:=@[ ]"_~0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
Cursorfunktionsbereich (1 Zeile):
Space: An der Cursorposition wird ein Leerzeichen
eingefiigt.
<«—: Der Cursor wird nach links verschoben.
—: Der Cursor wird nach rechts verschoben.
BS: Loscht das Zeichen links vom Cursor.
Title Prefix-Bereich (1 Zeile):
Bereich zum Eingeben des Titels.

So legen Sie den Titel fest

1 Wihlen Sie das an der Cursorposition im Title Prefix-
Bereich einzufiigende Zeichen mithilfe der Tasten 4/¥/4/%
im aus dem Zeichenauswahlbereich aus und driicken Sie den
Regler SEL/SET. (Das ausgewihlte Zeichen wird eingefiigt
und der Cursor nach rechts bewegt.)

2 Wiederholen Sie Schritt 1, um den Titel festzulegen.
(Verwenden Sie bei Bedarf BS.)

3 Nachdem Sie den Titel festgelegt haben, wiihlen Sie Done
aus, um den Bildschirm Edit File Name zu schlieen.

Number Set
0001 bis 9999

Legt die vierstellige numerische Endung des Clipnamens fest.

File-Menii
Option Unteroptionen und Beschreibung
Einstellungen
User File Load Utility SD/MS Lidt eine Benutzerdatei von einer SD-Karte oder einem

Einstellungen fiir Execute / Cancel

Vorginge mit

,.Memory Stick*“-Medium.
Execute: Funktion ausfiihren.

Benutzerdateien  gave Utility SD/MS

Execute / Cancel

Speichert eine Benutzerdatei auf einer SD-Karte oder einem
,.Memory Stick*“-Medium.
Execute: Funktion ausfiihren.

File ID

Zeigt einen Bildschirm zum Bearbeiten der ID von
Benutzerdateien an.

Load Customize Data

Legt fest, ob bei Ausfiihren von Load Utility SD/MS

On / Off benutzerdefinierte Daten fiir das User-Menii geladen werden
sollen.
Load White Data Legt fest, ob bei Ausfiihren von Load Utility SD/MS
On / Off WeiBabgleichdaten geladen werden sollen.
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Option Unteroptionen und Beschreibung
Einstellungen
All File Load Utility SD/MS Lidt eine ALL-Datei von einer SD-Karte oder einem

Einstellungen fiir Execute / Cancel

ALL-Dateien

,.Memory Stick*“-Medium.
Execute: Funktion ausfiihren.

Save Utility SD/MS
Execute / Cancel

Speichert eine ALL-Datei auf einer SD-Karte oder einem
,.Memory Stick*“-Medium.
Execute: Funktion ausfiihren.

File ID

Zeigt einen Bildschirm zum Bearbeiten der ID von ALL-
Dateien an.

Load Network Data
On / Off

Legt fest, ob bei Ausfiihren von Load Utility SD/MS
Einstellungsdaten fiir das Network-Menii geladen werden
sollen.

Scene File Recall Internal Memory Lédt eine Szene-Datei aus dem internen Speicher.
Einstellungen fiir Execute / Cancel Execute: Funktion ausfiihren.
Szene-Dateien Store Internal Memory Speichert eine Szene-Datei im internen Speicher.
Execute / Cancel Execute: Funktion ausfiihren.
Load Utility SD/MS Lidt einer Szenendatei von einer SD-Karte oder einem
Execute / Cancel ,.Memory Stick*“-Medium.
Save Utility SD/MS Speichert eine Szenendatei auf einer SD-Karte oder einem
Execute / Cancel ,.Memory Stick*“-Medium.
File ID Zeigt einen Bildschirm zum Bearbeiten der ID von
Szenendateien an.
Scene White Data Es wird festgelegt, ob beim Laden von Szene-Dateien die
On / Off WeiBabgleichdaten angewendet werden sollen.
Network-Menii
Option Unteroptionen und Beschreibung
Einstellungen
Access User Name Legt den Benutzernamen fiir die Zugriffsauthentifizierung

Authentication

fest.

Authentifizierungs password
einstellungen

Legt das Passwort fiir die Zugriffsauthentifizierung fest.

Wireless LAN  Setting
Einstellungen fiir
die Wi-Fi- Mode / Off

Access Point Mode / Station

Wiihlt den Betriebsmodus der WLAN-Verbindung aus.

Verbindung WPS

Execute / Cancel

Stellt eine Verbindung mithilfe von WPS (Wi-Fi Protected
Setup) her.
Execute: Funktion ausfiihren.

NFC
Execute / Cancel

Stellt eine Verbindung mithilfe von NFC (Near Field
Communication) her.
Execute: Funktion ausfiihren.

MAC Address

Zum Anzeigen der MAC-Adresse der WLAN-Schnittstelle
des Camcorders (nur Anzeige).
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Option Unteroptionen und Beschreibung
Einstellungen
AP Mode Channel Zum Einstellen des WLAN-Kanals.
Settings Auto(5GHz) / Auto / CH1 / Auto(5GHz) Ist nur beim PXW-Z190V verfiigbar.
Einstellungen fiir CH2/CH3/CH4 / CH5 / CH6
Verbindungen im /CH7/CH8/CH9/CHI10/
Zugangspunktmo- ~ CHII
dus Camera SSID & Password Zeigt die SSID und das Passwort des Camcorders an.
Regenerate Password Erstellt ein neues Passwort.
Execute / Cancel Execute: Funktion ausfiihren.
IP Address Zeigt die IP-Adresse des Camcorders im Zugangspunktmodus
an.
Subnet Mask Zeigt die Subnetzmaske des Camcorders im
Zugangspunktmodus an.
ST Mode Camera Remote Control Legt fest, ob die Fernbedienung von einem per WLAN im
Settings Enable / Disable Stationsmodus mit dem Camcorder verbundenen Geriit aus

Einstellungen fiir

aktiviert werden soll.

Verbindungen im

Connected Network

Zeigt das verbundene WLAN an (Zugangspunkt).

Stationsmodus

Scan Networks

Erkennt WLAN-Netzwerke (Zugangspunkte) und zeigt eine
Liste an.

Wiihlen Sie aus der Liste ein Ziel aus, zu dem die Verbindung
hergestellt werden soll.

Manual Register

Registriert Einstellungen zur manuellen Verbindung mit
einem Zugangspunkt.

SSID Geben Sie die SSID des Ziels ein, zu dem die Verbindung
hergestellt werden soll.

Security Geben Sie die Verschliisselungsart des Ziels ein, zu dem die

None / WEP / WPA Verbindung hergestellt werden soll. Wihlen Sie WPA aus,
falls die Verschliisselungsart des Ziel-Zugangspunkts WPA
oder WPAZ2 ist.

Password Wenn Security nicht auf None gesetzt ist, geben Sie das
Passwort fiir den Zugangspunkt ein, zu dem die Verbindung
hergestellt werden soll.

DHCP Schaltet DHCP ein bzw. aus.

On/ Off

IP Address Geben Sie die IP-Adresse des Camcorders ein, wenn DHCP
auf Off gesetzt ist.

Subnet Mask Geben Sie die Subnetzmaske des Camcorders ein, wenn
DHCP auf Off gesetzt ist.

Gateway Geben Sie das Standard-Gateway des Camcorders ein, wenn
DHCP auf Off gesetzt ist.

DNS Auto Schaltet automatischen Bezug der DNS-Daten ein/aus.

On/ Off

Primary DNS Server

Geben Sie den primidren DNS-Server ein, wenn DNS Auto auf
Off gesetzt ist.

Secondary DNS Server

Geben Sie den sekundiren DNS-Server ein, wenn DNS Auto
auf Off gesetzt ist.

Network Reset

Reset
Execute / Cancel

Zum Zuriicksetzen der Netzwerkeinstellungen.
Execute: Funktion ausfiihren.
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System-Menii

Option Unteroptionen und Beschreibung
Einstellungen
Base Setting  Shooting Mode Wiihlt den Dynamikbereichmodus aus.
Einstellungen des SDR/HDR
Aufnahmemodus
Rec Format Frequency Wihlt die Systemfrequenz aus.
Einstellungen fiir 59.94/50/29.97/25/23.98
das Aufzeich- (NTSC-Bereich: 59.94,
nungsformat PAL-Bereich: 50)

Codec
XAVC-L/DVCAM (MXF)

Wiihlt den Aufnahme- bzw. Wiedergabemodus.

Video Format
Die verfiigbaren Einstellungen
variieren je nach den
Einstellungen fiir Frequency
und Codec.

Legt das Aufzeichnungsformat fest.

SET: Funktion festlegen.

Dateisystem Frequency

Codec

Auswahloptionen

exFAT 59.94

XAVC-L

3840x2160P

1920x1080P 50
1920x1080P 35
1920x1080i 50
1920x1080i 35
1920x1080i 25
1280x720P 50

DVCAM(MXF)

720x480i

50

XAVC-L

3840x2160P

1920x1080P 50
1920x1080P 35
1920x1080i 50
1920x1080i 35
1920x1080i 25
1280x720P 50

DVCAM(MXF)

720x576i

29.97

XAVC-L

3840x2160P
1920x1080P 50
1920x1080P 35

25

XAVC-L

3840x2160P
1920x1080P 50
1920x1080P 35

23.98

XAVC-L

3840x2160P
1920x1080P 50
1920x1080P 35

Aspect Ratio (SD)
16:9/4:3

Zum Einstellen des Seitenverhiltnisses bei DVCAM-

Aufnahmen.
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Option Unteroptionen und Beschreibung

Einstellungen
Assignable <1> bis <8> Weist die belegbaren Tasten Funktionen zu.
Button Off / Push AF/Push MF / Face Push AF/Push MF: Fiihrt Autofokus auf Knopfdruck oder
Einstellungen zur Detection AF / Focus Macro / manuellen Fokus auf Knopfdruck durch.
Funktionszuwei- Auto ND Filter / Push Auto ND Face Detection AF: Zum Ein-/Ausschalten der

sung an belegbare
Tasten

/ Push Auto Iris / Turbo Gain /
AGC / Shutter / Auto Exposure
Level / Spotlight / Backlight /
Flash Band Reduce / Digital
Extender x2 / Handle Zoom /
SteadyShot / Color Bars /
Preset White Select / ATW /
ATW Hold / Marker / Zebra /
Peaking / Video Signal Monitor
/ Focus Magnifier / Lens Info /
LCD/VF Adjust / VF Mode /
Gamma Display Assist /
Display / Rec / S&Q Motion /
Clip Continuous Rec / Picture
Cache Rec / Proxy Rec Start/
Stop / Rec Review / Last Clip
Delete / Thumbnail / NFC /
Direct Menu / User Menu /
Menu

Gesichtserkennung-AF-Funktion.

Focus Macro: Zum Ein-/Ausschalten des Makro-Modus.

Auto ND Filter: Zum Ein-/Ausschalten der Auto ND Filter-
Funktion.

Push Auto ND: Fiihrt voriibergehend die Auto ND Filter-
Funktion durch.

Push Auto Iris: Fiihrt die Funktion Blendenautomatik auf
Knopfdruck durch.

Turbo Gain: Zum Ein-/Ausschalten von Turbo Gain.

AGC: Zum Umschalten der Funktion zur automatischen
Verstiarkungsregelung.

Shutter: Zum Umschalten zwischen automatischem und
manuellem Verschluss.

Auto Exposure Level: Zum Einstellen des Pegels fiir die
automatische Belichtung.

Spotlight: Zum Umschalten des automatischen
Belichtungsmodus auf Spotlight.

Backlight: Zum Umschalten des automatischen
Belichtungsmodus auf Backlight.

Flash Band Reduce: Zum Ein-/Ausschalten der Flash Band-
Korrektur.

Digital Extender x2: Zum Ein-/Ausschalten der
Bildschirmvergroferung (x2).

Handle Zoom: Zum Umschalten der Bedienung des Zooms
am Griff.

SteadyShot: Wechselt die Bildstabilisierungsfunktion.

Color Bars: Zum Ein-/Ausblenden der Farbbalken.

Preset White Select: Zum Umschalten des Werts fiir den
Voreinstellungsmodus des Weilabgleichs.

ATW: Zum Ein-/Ausschalten von ATW.

ATW Hold: Zum voriibergehenden Aussetzen der ATW-
Funktion.

Marker: Zum Ein-/Ausschalten der Markierungsfunktion.

Zebra: Zum Ein-/Ausschalten der Zebrafunktion.

Peaking: Zum Ein-/Ausschalten der Konturverstirkung.

Video Signal Monitor: Zum Umschalten des
Videosignalmonitors (z. B. Histogramm).

Focus Magnifier: Zum Ein-/Ausschalten der Fokuslupe.

Lens Info: Zum Umschalten der Schirfentiefenanzeige.

LCD/VF Adjust: Zeigt die Pegelbalken zum Einstellen der
Helligkeit des LCD-/Sucherbildschirms an.

VF Mode: Zum Umschalten zwischen Farb- und Schwarz-
Weil-Anzeige im Sucher.

Gamma Display Assist: Zum Umschalten der Gamma-
Anzeigeassistentenfunktion.

Display: Zum Ein-/Ausschalten der
Monitorbildschirmanzeigen.

Rec: Startet oder stoppt die Aufzeichnung.
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Option Unteroptionen und Beschreibung
Einstellungen
Assignable S&Q Motion: Zum Ein-/Ausschalten des Zeitlupen- und
Button Zeitraffer-Modus und Anzeigen des Bildschirms zur
Einstellungen zur Einstellung der Bildfrequenz.
Funktionszuwei- Clip Continuous Rec: Zum Ein-/Ausschalten des Modus fiir
sung an belegbare ) die kontinuierliche Clipgufnahme.
Tasten Picture Cache Rec: Zum Ein-/Ausschalten des
Bildpuffermodus.
Proxy Rec Start/Stop: Startet/stoppt unabhéngige Proxy-
Aufzeichnung.
Rec Review: Startet die Aufnahmeriickschau.
Last Clip Delete: Fiihrt die Funktion zum Loschen des letzten
Clips durch (Take wiederholen).
Thumbnail: Zum Ein-/Ausschalten der Miniaturbildanzeige.
NFC: Fiihrt die NFC-Funktion durch.
Direct Menu: Zeigt das Direktmenii an.
User Menu: Zeigt das User-Menii an.
Menu: Zeigt das Einstellmenii an.
Tally Front Zum Ein-/Ausschalten der Aufnahme-/Tally-Anzeige (vorn).
Einstellungen fiir On/ Off
die Aufnahme-/  Regar Zum Ein-/Ausschalten der Aufnahme-/Tally-Anzeige (hinten).
Tally-Anzeigen On/ Off
Language Select Legt die Sprache fest.
Spracheinstellun- SET: Funktion festlegen.
gen
Clock Set Time Zone Stellt den Zeitzonen-Unterschied zu UTC in Schritten von

Einstellungen fiir
die innere Uhr

UTC -12:00 bis UTC +14:00

30 Minuten ein.

Date Mode ‘Wiihlt das Anzeigeformat fiir das Datum aus.
YYMMDD / MMDDYY / YYMMDD: Jahr, Monat, Tag
DDMMYY MMDDY'Y: Monat, Tag, Jahr
DDMMYY: Tag, Monat, Jahr
12H/24H Wihlt den Anzeigemodus fiir die Uhrzeit aus.
12H / 24H 12H: 12-Stunden-Format
24H: 24-Stunden-Format
Date Legt das aktuelle Datum fest.
SET: Stellt den Wert ein.
Time Stellt die aktuelle Uhrzeit ein.
SET: Stellt den Wert ein.
Hours Meter Hours(System) Zeigt die Gesamtbetriebsstunden an (kann nicht zuriickgesetzt
Einstellungen fiir werden).
die Hours(Reset) Zeigt die Gesamtbetriebsstunden an (kann zuriickgesetzt
Stundenanzeige werden).
Reset Zum Zuriicksetzen der Hours(Reset)-Anzeige auf den Wert 0.
Execute / Cancel Execute: Funktion ausfiihren.
GPS GPS Schaltet die GPS-Funktion ein bzw. aus.
GPS-Einstellungen ~ On / Off

Battery Alarm
Einstellungen fiir
die
Benachrichtigung
bei niedriger
Akku-Spannung

Low Battery

5% 110% / 15% / ... 1 45% /

Legt fest, dass bei dieser Restspannung eine Benachrichtigung
iiber eine geringe Akku-Restspannung angezeigt wird (in

50% Schritten von 5%).
Battery Empty Legt fest, dass bei dieser Restspannung eine Warnmeldung
3% bis 7% iiber einen leeren Akku angezeigt wird (Schritte von 1%).
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Option Unteroptionen und Beschreibung

Einstellungen
DC Voltage DC Low Voltagel Legt die Spannung fest, bei der eine Warnmeldung iiber eine
Alarm 11.2V bis 14.0V (11.3V) geringe DC IN-Eingangsspannung angezeigt wird (Schritte
Einstellungen fiir von 0.1V).
die DC Low Voltage2 Legt die Spannung fest, bei der eine Warnmeldung iiber eine
Benachrichtigung 11.0V bis 14.0V DC IN-Unterspannung angezeigt wird (Schritte von 0.1V).

bei niedriger
DC IN-Spannung

Menu Settings Direct Menu with <SET>

Meniieinstellungen ~ On / Off

Legt fest, ob durch Driicken der Taste SET die
Direktmeniifunktion gestartet werden soll.

« Bei Einstellung auf On ist die Erkennung von registrierten
Gesichtern mittels der Gesichtserkennung-AF-Funktion
nicht mehr verfiigbar. Auerdem wird das aktuell registrierte
Gesicht geloscht.

User Menu Only
On / Off

Legt fest, ob nur das User-Menii angezeigt werden soll (On)
oder die Meniiliste (Off) angezeigt werden soll, wenn der
Camcorder das Menii anzeigt.

User Menu with Lock
On / Off

Legt fest, ob die Meniianzeige gesperrt und nur das User-
Menii angezeigt werden soll.

* Beim Betrieb mit normaler Meniianzeige wird diese Option
nicht angezeigt. Niheres zur Funktion der Meniianzeige
finden Sie unter Seite 70.

Fan Control Setting
Einstellungen fiir
die

Geblisesteuerung

Auto / Minimum / Off in Rec

Wihlt den Geblisesteuerungsmodus aus.

All Reset Reset
Zuriicksetzen auf Execute / Cancel

Werkseinstellun-

Zum Zuriicksetzen des Camcorders auf den werkseitigen
Status.
Execute: Funktion ausfiihren.

gen Reset without Network
Execute / Cancel

Setzt die Mentieinstellungen aufier den Einstellungen des
Network-Meniis auf die Werkseinstellungen zuriick.
Execute: Funktion ausfiihren.

Version Version Number Zeigt der Software-Version des Camcorders an.
Anzeige der X.XX

Camcorder- Version Up Fiihrt ein Upgrade fiir den Camcorder durch.*
Version

Execute / Cancel

Execute: Funktion ausfiihren.
* Diese Funktion aktualisiert die Software des Camcorders.
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Wichtige Hinweise zum Betrieb

Verwenden des Camcorders im
Ausland

Stromversorgung

Mithilfe des Netzteils BC-U1A (mitgeliefert)
oder des gesondert erhiltlichen Ladegerits BC-
U2A konnen Sie den Camcorder in allen
Lindern/Regionen verwenden, die eine
Stromversorgung mit 100 V bis 240 V
Wechselspannung bei 50 Hz/60 Hz anbieten.

Zeitzonen-Korrekturfunktion
Stellen Sie im Ausland Clock Set >Time Zone
(Seite 98) im System-Menii ein.

Verwendung und Aufbewahrung

Gerdét vor heftigen Stdfen schiitzen
Der interne Mechanismus kann beschidigt

werden oder das Gehéduse konnte sich verformen.

Wahrend des Betriebs nicht abdecken
Wenn das Gerit mit einem Tuch o. A. abgedeckt
wird, kann sich im Gerit ein Wirmestau bilden.

Nach dem Gebrauch

Stellen Sie den Schalter ON/STANDBY stets auf
STANDBY, bevor Sie die Stromversorgung
trennen.

Vor langerer Nichtverwendung
Nehmen Sie den Akku ab.

Den Camcorder nicht mit auf die Sonne
gerichtetem Objektiv ablegen

Direkte Sonneneinstrahlung kann durch das
Objektiv eindringen, im Camcorder gebiindelt
werden und Feuer verursachen.

Das Objektiv keinen Strahlen wie Laserstrahlen
aussetzen

Der Bildsensor kann beschédigt werden und es
konnen Fehlfunktionen der Kamera verursacht
werden.

Transport

* Nehmen Sie die Speicherkarten heraus, bevor
Sie das Gerit transportieren.
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* Wenn Sie das Gerit per Lkw, Schiff, Flugzeug
oder einem anderen Transportsystem
versenden, verpacken Sie es im
Originalverpackungsmaterial.

Der Akku
So laden Sie den Akku

¢ Sie miissen den Akku laden, bevor Sie den
Camcorder in Betrieb nehmen.

So verwenden Sie den Akku effektiv

* Die Akkuleistung nimmt bei einer

Umgebungstemperatur von 10 °C und darunter

ab und die Betriebsdauer des Akkus wird

kiirzer. Sie haben in diesem Fall folgende

Mbglichkeiten, um den Akku linger nutzen zu

konnen.

—Stecken Sie den Akku zum Erwérmen in eine
Jacken- oder Hosentasche und bringen Sie
ihn erst unmittelbar vor dem Starten der
Aufnahme am Camcorder an.

—Verwenden Sie einen Akku mit hoher
Kapazitit.

Achten Sie darauf, dass Sie den Schalter ON/

STANDBY auf STANDBY stellen, wenn Sie

den Camcorder nicht zur Aufnahme oder

Wiedergabe nutzen. Dem Akku wird auch dann

Strom entzogen, wenn sich der Camcorder im

Aufnahmebereitschaftsmodus oder in der

Wiedergabepause befindet.

Halten Sie Ersatzakkus fiir das 2- bis 3-Fache

der erwarteten Aufnahmedauer bereit und

machen Sie vor der eigentlichen Aufnahme eine

Probeaufnahme.

¢ Schiitzen Sie den Akku vor Wasser. Der Akku
ist nicht wassergeschiitzt.

Aufbewahrung des Akkus

* Wenn der Akku lange Zeit nicht verwendet
wird, laden Sie ihn einmal im Jahr vollstdndig
auf und entladen ihn dann mit dem Camcorder,
damit er funktionstiichtig bleibt. Nehmen Sie
den Akku zum Aufbewahren vom Camcorder
ab und lagern Sie ihn kiihl und trocken.

* Wenn Sie den Akku im Camcorder vollstindig
entladen mochten, lassen Sie den Camcorder im
Aufnahmebereitschaftsmodus, bis er sich
ausschaltet (Seite 17).



Lebensdauer des Akkus

» Die Akkukapazitit nimmt im Laufe der Zeit
und mit wiederholtem Gebrauch ab. Wenn sich
die Betriebsdauer des Akkus erheblich verkiirzt,
sollten Sie ihn gegen einen neuen austauschen.

* Die Akkulebensdauer hidngt von den Lager-,
Betriebs- und Umgebungsbedingungen ab.

Laden des Akkus
¢ Laden Sie ausschlieBlich die angegebenen
Akkus mit dem Ladegerit (mitgeliefert) auf.
Wenn Sie andere Akkutypen aufladen, besteht
die Gefahr, dass diese auslaufen, iiberhitzen,
platzen oder einen elektrischen Schlag
verursachen und es dadurch zu Verbrennungen
und anderen Verletzungen kommt.
¢ Nehmen Sie den aufgeladenen Akku aus dem
Ladegerit heraus.
« Die Ladeanzeige des mitgelieferten Ladegeriits
blinkt auf die folgenden zwei Arten:
Schnelles Blinken...Die Anzeige schaltet sich
im Abstand von ca. 0,15 Sekunden ein und aus.
Langsames Blinken...Die Anzeige schaltet sich
im Abstand von ca. 1,5 Sekunden ein und aus
und bleibt dann ca. 1,5 Sekunden lang aus.
Diese Abfolge wird wiederholt.
Wenn die Ladeanzeige schnell blinkt, nehmen
Sie den aufzuladenden Akku heraus und setzen
Sie ihn dann fest wieder ein. Wenn die
Ladeanzeige weiterhin schnell blinkt, ist der
Akku moglicherweise beschddigt oder Sie
verwenden einen nicht geeigneten Akkutyp.
Vergewissern Sie sich, dass Sie einen Akku des
geeigneten Typs verwenden. Ist dies der Fall,
nehmen Sie ihn heraus und setzen Sie einen
ganz neuen Akku bzw. einen erwiesenermafien
funktionsfahigen Akku ein, um zu iiberpriifen,
ob das Ladegerit richtig funktioniert.
Funktioniert das Ladegeriit richtig, dann ist der
Akku moglicherweise beschidigt.
Wenn die Ladeanzeige langsam blinkt, befindet
sich das Ladegerit im Bereitschaftsmodus und
der Ladevorgang ist unterbrochen. Wenn die
Umgebungstemperatur nicht im geeigneten
Temperaturbereich liegt, unterbricht das
Ladegerit automatisch den Ladevorgang und
wechselt in den Bereitschaftsmodus. Wenn
wieder eine geeignete Umgebungstemperatur
erreicht ist, setzt das Ladegerit den
Ladevorgang fort und die Ladeanzeige leuchtet
wieder. Es empfiehlt sich, den Akku bei einer
Umgebungstemperatur zwischen 10 °C und
30 °C zu laden.
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Umgang mit dem Camcorder

Betrieb und Pflege

* Lagern und verwenden Sie den Camcorder und

das Zubehor nicht an folgenden Orten.

—Orte mit extremen Temperaturen.

Setzen Sie den Camcorder und das Zubehor
nie Temperaturen von iiber 60 °C aus, wie
sie z.B. in direktem Sonnenlicht, in der Nihe
von Heizungen oder in einem in der Sonne
geparkten Auto auftreten konnen.
Andernfalls kann es zu Fehlfunktionen
kommen oder Teile konnen sich verformen.

—In der Nihe von starken Magnetfeldern oder
mechanischen Erschiitterungen.

Andernfalls kann es am Camcorder zu
Fehlfunktionen kommen.

—In der Nihe von starken Radiowellen oder
Strahlung.

Andernfalls ist eine einwandfreie Aufnahme
mit dem Camcorder unter Umstinden nicht
moglich.

—In der Nidhe von AM-Empfingern und
Videogeriten.

Andernfalls kann es zu Interferenzen
kommen.

— An Sandstrdnden oder in staubiger
Umgebung.

Wenn Sand oder Staub in den Camcorder
gelangt, kann es zu Fehlfunktionen kommen.
Unter Umstidnden kann das Gerit irreparabel
beschédigt werden.

—In Fensterndhe oder im Freien, wo der LCD-
Bildschirm, der Sucher oder das Objektiv
direktem Sonnenlicht ausgesetzt ist.
Dadurch werden innere Bauteile des Suchers
oder LCD-Bildschirms beschadigt.

— An Orten mit hoher Luftfeuchtigkeit.

Verwenden Sie fiir den Betrieb mit Gleich- oder

Netzstrom das in dieser Bedienungsanleitung

empfohlene Zubehor.

Schiitzen Sie den Camcorder vor Nisse wie z.

B. Regen oder Meerwasser. Wenn der

Camcorder nass wird, kann es zu

Fehlfunktionen kommen. Unter Umstéinden

kann das Gerit irreparabel beschédigt werden.

Sollten Fremdkorper oder Fliissigkeiten in das

Gehiuse gelangen, trennen Sie den Camcorder

von der Netzsteckdose und lassen Sie ihn von

einem Sony-Héndler iiberpriifen, bevor Sie ihn
wieder benutzen.



¢ Gehen Sie sorgsam mit dem Gerit um, zerlegen
und modifizieren Sie es nicht und schiitzen Sie
es vor StoBen, lassen Sie es nicht fallen und
treten Sie nicht darauf. Bitte behandeln Sie das
Objektiv mit besonderer Sorgfalt.

Verformte oder beschidigte Akkus diirfen nicht
verwendet werden.

Belassen Sie den Schalter ON/STANDBY in
der Position STANDBY, wenn Sie den
Camcorder nicht verwenden.

Wickeln Sie den Camcorder wihrend des
Betriebs nicht in ein Tuch o. A. ein. Andernfalls
kann sich im Inneren des Gerits ein Wirmestau
bilden.

Ziehen Sie zum Trennen des Netzkabels immer
am Stecker und nicht am Kabel.

Achten Sie darauf, das Netzkabel nicht zu
beschédigen. Stellen Sie beispielsweise keine
schweren Gegenstinde darauf.

Halten Sie die Metallkontakte sauber.
Bewabhren Sie die drahtlose Fernbedienung und
die Knopfbatterie aulerhalb der Reichweite von
Kindern auf. Falls eine Batterie verschluckt

wird, wenden Sie sich umgehend an einen Arzt.

Wenn die Batteriefliissigkeit ausgelaufen ist:

—Wenden Sie sich an den autorisierten Sony-
Kundendienst vor Ort.

—Waschen Sie die Fliissigkeit ab, falls sie mit
der Haut in Beriihrung gekommen ist.

—Wenn die Fliissigkeit in Thre Augen gelangt
ist, waschen Sie sie mit viel Wasser aus und
suchen Sie einen Arzt auf.

Wenn Sie den Camcorder lange Zeit nicht

benutzen

 Schalten Sie den Camcorder etwa einmal im
Monat ein und lassen Sie Bilder aufnehmen
bzw. wiedergeben, damit er lange Zeit in
optimalem Zustand bleibt.

 Entladen Sie den Akku vollstindig, bevor Sie
ihn aufbewahren.

Feuchtigkeitskondensation

Wird der Camcorder direkt von einem kalten an
einen warmen Ort gebracht, kann sich im
Camcorder Feuchtigkeit niederschlagen und es
kann zu Fehlfunktionen am Camcorder kommen.

Wenn sich Feuchtigkeit niedergeschlagen hat

Warten Sie etwa 1 Stunde, bevor Sie den
Camcorder einschalten.

Hinweis zur Feuchtigkeitskondensation
Feuchtigkeit kann sich niederschlagen, wenn Sie
den Camcorder von einem kalten an einen
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warmen Ort bringen (oder umgekehrt) oder den

Camcorder in folgenden Situationen benutzen:

* Wenn Sie den Camcorder von einer Skipiste in
einen beheizten Raum bringen.

¢ Wenn Sie den Camcorder von einem
klimatisierten Auto oder Raum in die Hitze
draufen bringen.

¢ Wenn Sie den Camcorder nach einem Gewitter
oder Regenschauer benutzen.

* Wenn Sie den Camcorder an einem heiflen und
feuchten Ort benutzen.

So vermeiden Sie Feuchtigkeitskondensation
Wenn Sie den Camcorder von einem kalten an
einen warmen Ort bringen, stecken Sie ihn in eine
Plastiktiite und verschlieBen Sie diese sorgfiltig.
Nehmen Sie den Camcorder aus der Tiite heraus,
sobald die Lufttemperatur in der Tiite der
Umgebungstemperatur entspricht. Das dauert
etwa 1 Stunde.

LCD-Bildschirm

¢ Driicken Sie nicht zu stark auf den LCD-
Bildschirm. Andernfalls kann er beschadigt
werden.

* Wenn Sie den Camcorder in einer kalten
Umgebung benutzen, kann ein Nachbild auf
dem LCD-Bildschirm zu sehen sein. Dies ist
keine Fehlfunktion.

* Beim Betrieb des Camcorders kann sich die
Riickseite des LCD-Bildschirms erwidrmen.
Dies ist keine Fehlfunktion.

So reinigen Sie den LCD-Bildschirm

Die Oberflidche des LCD-Bildschirms ist

beschichtet. Wenn Sie die Oberfliche zerkratzen,

kann sich die Beschichtung 16sen.

Beachten Sie beim Reinigen und im Umgang mit

dem LCD-Bildschirm Folgendes:

* Wenn Fingerabdriicke (Fette) oder Handcreme
langer auf dem Bildschirm bleiben, kann sich
die Beschichtung leichter ablosen. Entfernen
Sie solche Verunreinigungen moglichst bald.

* Die Beschichtung kann zerkratzt werden, wenn
Sie den Bildschirm mit einem Papiertuch o. A.
abwischen.

* Entfernen Sie vor dem Abwischen Staub und
Sand mit einem Staubbliser o. A.

* Reinigen Sie den LCD-Bildschirm behutsam
mit einem weichen Tuch (z. B. einem
Brillenputztuch).

Pflege des Gehéduses
* Wenn das Gehéduse des Camcorders
verschmutzt ist, reinigen Sie es mit einem



weichen Tuch, das Sie leicht mit Wasser

angefeuchtet haben. Wischen Sie das Gehiduse

anschlieBend mit einem weichen Tuch trocken.

Vermeiden Sie Folgendes, damit das Gehduse

nicht beschidigt wird.

—Verwenden Sie keine Chemikalien wie
Verdiinner, Benzin, Alkohol, keine chemisch
imprignierten Reinigungstiicher, keine
Repellents (Insektenabwehrmittel), keine
Insektizide und keine Sonnenschutzmittel.

— Beriihren Sie das Gehéuse nicht mit den oben
genannten Substanzen an den Handen.

— Achten Sie darauf, dass das Gehiuse nicht
ldngere Zeit mit Gummi- oder
Vinylmaterialien in Beriihrung kommt.

Pflege und Aufbewahrung des Objektivs

* Reinigen Sie die Objektivlinse in folgenden
Fillen mit einem weichen Tuch:

— Wenn sich Fingerabdriicke auf der
Objektivlinse befinden.

—In heiBer oder feuchter Umgebung

—Wenn das Objektiv in salzhaltiger
Umgebung, wie z. B. am Meer, verwendet
wird.

* Bewahren Sie das Objektiv an einem Ort mit
guter Luftzirkulation und moglichst wenig
Staub oder Schmutz auf.

¢ Damit sich kein Schimmel bilden kann,
reinigen Sie das Objektiv regelmiBig wie oben
beschrieben.

Laden des werkseitig installierten Akkus

Der Camcorder verfiigt {iber einen
vorinstallierten Akku, um Datum, Uhrzeit und
andere Einstellungen auch dann zu speichern,
wenn der Schalter ON/STANDBY auf
STANDBY gesetzt ist. Der werkseitig installierte
Akku wird immer geladen, solange der
Camcorder iiber das Netzteil an eine
Netzsteckdose angeschlossen oder der Akku am
Camcorder angebracht ist. Nach etwa drei
Monaten ist der werkseitig installierte Akku
vollstdndig entladen, wenn Sie den Camcorder in
dieser Zeit weder iiber das Netzteil noch iiber den
Akku mit Strom versorgt haben. Laden Sie den
werkseitig installierten Akku, bevor Sie den
Camcorder verwenden.

Aber auch wenn der werkseitig installierte Akku
nicht geladen ist, konnen Sie den Camcorder
problemlos verwenden, solange Sie nicht das
Datum aufnehmen wollen.
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So verhindern Sie elektromagnetische
Interferenzen durch traghare Telefone,
drahtlose Gerdte usw.

Die Verwendung von tragbaren Telefonen,
drahtlosen Geriten usw. in der Nihe dieses
Geriits kann zu Fehlfunktionen und Interferenzen
mit Audio- und Videosignalen fiihren.

Es empfiehlt sich, solche Gerite in der Nihe
dieses Gerits auszuschalten.

Der LCD-Bildschirm

¢ Achten Sie darauf, den LCD-Bildschirm nicht
direktem Sonnenlicht auszusetzen, da der LCD-
Bildschirm andernfalls beschidigt werden
konnte.

¢ Driicken Sie nicht zu fest auf den LCD-
Bildschirm, wischen Sie nicht zu fest dariiber
und legen Sie keine Gegenstinde darauf ab, da
es andernfalls zu Fehlfunktionen wie
BildunregelmifBigkeiten usw. kommen kann.

* Der LCD-Bildschirm kann sich wihrend des
Betriebs erwidrmen. Dies ist keine Fehlfunktion.

Pixelfehler

Der LCD-Bildschirm/der organische EL-
Bildschirm dieses Gerits wird mit
Hochprizisionstechnologie hergestellt und die
Anzahl der funktionsfihigen Pixel liegt bei
mindestens 99,99%. Ein sehr geringer Anteil von
Pixeln kann jedoch eventuell , hdngenbleiben®,
entweder immer aus (schwarz), immer an (rot,
griin oder blau), oder blinkend. Dariiber hinaus
konnen solche ,,Pixelfehler” aufgrund der
physischen Eigenschaften eines
Fliissigkristallbildschirms oder organischen EL-
Bildschirms nach langer Nutzungsdauer auch
spontan auftreten. Diese Fehler stellen keine
Fehlfunktion dar und werden nicht auf dem
Aufnahmemedium aufgezeichnet.

Die Anzeige auf dem organischen EL-
Bildschirm

Aufgrund der physischen Eigenschaften des
organischen EL-Bildschirms konnen Bilder
einbrennen und unter Umsténden ist die
Helligkeit gering.

Solche Probleme stellen keine Fehlfunktion dar
und behindern nicht den problemlosen Betrieb
des organischen EL-Bildschirms.



Wenn Sie Thre Blickrichtung im Sucher dndern,
werden ggf. einige Grundfarben sichtbar. Dies ist
jedoch keine Fehlfunktion.

Diese Farben werden nicht auf die Speicherkarten
aufgenommen.

VerschleiBteile

« Liifter und Batterie des Gerits sind
Verbrauchsmaterialien, die regelméfig ersetzt
werden miissen.

Wenn das Geriit bei Raumtemperatur betrieben
wird, sollten die Teile ca. alle 5 Jahre ersetzt
werden.

Diese Ersatzfristen stellen jedoch nur eine
allgemeine Richtlinie und keine Garantie der
Lebensdauer dieser Teile dar. Weitere
Informationen zum Austausch von
Komponenten erhalten Sie bei Ihrem Hindler.
Die Lebensdauer des Netzteils und des
Elektrolytkondensators betrigt bei normalen
Betriebstemperaturen und normaler
Verwendung etwa 5 Jahre (8 Stunden pro Tag;
25 Tage pro Monat). Falls die Nutzung die
normale Nutzungshiufigkeit iiberschreitet, ist
die Lebensdauer ggf. entsprechend geringer.
Der Batteriekontakt dieses Geriits (der
Anschluss fiir Akkus und Netzteile) ist ein
Verbrauchsteil.

Das Gerit wird moglicherweise nicht richtig
mit Strom versorgt, wenn die Stifte des
Batteriekontakts durch Stofe oder Vibrationen
verbogen oder deformiert sind, oder wenn sie
aufgrund lingerer Verwendung im Freien
korrodiert sind.

RegelmiBige Kontrollen werden empfohlen,
um richtige Funktion und lange Lebensdauer
des Gerits sicherzustellen.

Wenden Sie sich fiir weitere Auskiinfte iiber
Kontrollen am Gerit an Thren Sony-
Kundendienst oder -Héndler.

Hinweis zur Anzeige

* Wenn Sie die folgenden Funktionen ausfiihren,
ist das Bild auf dem LCD-Bildschirm und auf
dem Sucherbildschirm moglicherweise
verzerrt:

—Wechseln des Videoformats
— Starten der Wiedergabe iiber die
Miniaturbildanzeige
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Dateifragmentierung

Wenn keine ordnungsgemife Aufnahme/
Wiedergabe moglich ist, versuchen Sie, das
Aufnahmemedium zu formatieren. Wenn Sie
iiber einen lingeren Zeitraum ein Medium
wiederholt fiir die Aufnahme bzw. Wiedergabe
verwenden, kann es zu einer Fragmentierung der
Dateien auf dem Medium kommen, was die
ordnungsgeméle Aufnahme/Wiedergabe
verhindert. Erstellen Sie in diesem Fall
Sicherungskopien der Clips auf dem Medium und
formatieren Sie das Medium dann mit Format
Media (Seite 92) im Media-Menti.

Hinweise zur Sicherheit im Internet

* Verwenden Sie den Camcorder hinter einer
Firewall mit geeigneten Sicherheitsfunktionen.
Verbinden Sie den Camcorder nicht mit einem
Netzwerk, mit dem nicht vertrauenswiirdige
Gerite eine Verbindung herstellen konnen.

+ SONY KANN KEINE HAFTUNG FUR

SCHADEN JEDER ART DURCH

UNTERLASSENE GEEIGNETE

SICHERHEITSMASSNAHMEN AN

UBERTRAGUNGSGERATEN, DURCH

UNVERMEIDBARE DATENPREISGABE

AUFGRUND DER

UBERTRAGUNGSSPEZIFIKATIONEN

ODER DURCH SICHERHEITSPROBLEME

JEGLICHER ART UBERNEHMEN.

Je nach Betriebsumgebung konnen unbefugte

Dritte im Netzwerk unter Umsténden auf dieses

Gerit zugreifen. Achten Sie beim Verbinden

des Gerits mit dem Netzwerk darauf, dass das

Netzwerk gut abgesichert ist.

Der Kommunikationsinhalt kann von

unautorisierten Dritten in der Nihe des Signals

abgefangen werden, ohne dass Sie es merken.

Wenn Sie die WLAN-Kommunikation nutzen,

implementieren Sie geeignete

SicherheitsmaBnahmen, um den

Kommunikationsinhalt zu schiitzen.

Vom Sicherheitsstandpunkt sollten Sie

unbedingt iiber einen Webbrowser auf das

Steuerfenster zugreifen und die werkseitig

eingestellten Werte fiir die

Zugriffseinschriankung dndern, wenn das Geriit

mit dem Netzwerk verbunden ist (Seite 94).

Es wird auch empfohlen, das Passwort

regelmiBig zu dndern.



* Rufen Sie keine andere Website im
Webbrowser auf, wihrend Sie Einstellungen
vornehmen oder nachdem Sie Einstellungen
vorgenommen haben. Da der Anmeldestatus
beim Webbrowser gespeichert bleibt, schliefen
Sie den Webbrowser, wenn Sie die
Einstellungen abgeschlossen haben, um zu
verhindern, dass unautorisierte Dritte das Gerét
nutzen oder schidliche Programm ausfiihren.

GPS

Beim GPS-System (Global Positioning System)
kann mithilfe hochst préziser US-
Weltraumsatelliten eine geografische Position
berechnet werden. Das heif3t, mit diesem System
konnen Sie Ihre genaue Position auf der Erde
feststellen.

Die GPS-Satelliten umkreisen die Erde in
20.000 km Hohe auf sechs Erdumlaufbahnen.
Das GPS-System besteht aus mindestens 24 GPS-
Satelliten. Uber einen GPS-Empfinger werden
Funksignale von den Satelliten empfangen, aus
denen sich auf der Grundlage der Bahndaten der
Satelliten (Almanach-Daten) und der
Signallaufzeit usw. die aktuelle Position des
Empfingers berechnen lisst.

Die Positionsbestimmung erfolgt mithilfe der
,»Triangulation*. Ein GPS-Empfinger kann den
Breitengrad und Lingengrad einer Position
anhand der Signale von mindestens 3 Satelliten
bestimmen.

* Da die Positionen von GPS-Satelliten stindig
wechseln, kann die Positionsbestimmung
langere Zeit dauern. Je nachdem, wo und wann
Sie den Camcorder verwenden, kann der
Empfinger die Position moglicherweise gar
nicht bestimmen.

* Mit dem GPS-System lidsst sich die

geografische Position durch die Triangulation

der Funksignale von GPS-Satelliten
bestimmen. Verwenden Sie den Camcorder
dazu moglichst nicht an Orten, an denen

Funksignale blockiert oder reflektiert werden,

z. B. an einer von Gebéduden oder Baumen usw.

umgebenen Stelle im Schatten. Verwenden Sie

den Camcorder unter freiem Himmel, wo nichts
den Empfang stort.

An folgenden Orten bzw. in folgenden Fillen

konnen unter Umsténden keine Positionsdaten

aufgenommen werden, weil der Camcorder
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keine Funksignale von den GPS-Satelliten

empfangen kann.

—1In Tunnels, in Gebduden oder im Schatten
von Gebduden.

—Zwischen hohen Geb#uden oder in engen
StraBenschluchten.

— An unterirdischen oder von dichten Baumen
umgebenen Orten, unter hohen Briicken oder
an Orten, an denen Magnetfelder erzeugt
werden, z. B. in der Niihe von
Hochspannungskabeln.

—In der Nihe von Geriiten, die Funksignale im
vom Camcorder genutzten Frequenzbereich
erzeugen, also in der Nihe von
Mobiltelefonen usw. im 1,5-GHz-
Frequenzbereich.

Wenn Sie Bilder, die bei Einstellung von GPS

auf On aufgenommen wurden, hochladen oder

teilen, kann der Aufnahmeort im Internet
aufgedeckt werden, selbst wenn dies nicht Thre

Absicht ist. Wenn Sie die Positionsdaten nicht

aufzeichnen wollen, setzen Sie GPS auf Off

(Seite 98).

Abweichungen bei der Triangulation
* Wenn Sie sich unmittelbar, nachdem Sie GPS
im Menii auf On gesetzt haben, an einen
anderen Ort begeben, braucht der Camcorder
unter Umstidnden mehr Zeit, die Triangulation
zu starten, als wenn Sie am gleichen Ort
bleiben.
* Abweichung aufgrund der Position von GPS-
Satelliten
Der Camcorder nimmt automatisch eine
Triangulation Ihrer aktuellen Position vor,
wenn der Camcorder die Funksignale von
mindestens drei GPS-Satelliten empfangt. Bei
der Triangulation mithilfe der Signale von den
GPS-Satelliten kann es zu einer Abweichung
von etwa 10 m kommen. Je nach der Umgebung
der Position kann die Abweichung auch hoher
ausfallen. In diesem Fall entspricht Ihre aktuelle
Position unter Umstidnden nicht der anhand der
GPS-Daten berechneten Position auf der Karte.
AuBerdem unterstehen die GPS-Satelliten dem
Verteidigungsministerium der USA und die
Genauigkeit wird unter Umsténden absichtlich
reduziert.
Abweichung wihrend des
Triangulationsvorgangs
Der Camcorder empfangt wihrend der
Triangulation regelméBig Positionsdaten.



Einschrankungen beim Gebrauch von GPS
Verwenden Sie GPS je nach Situation und in
Ubereinstimmung mit den Vorschriften der

Liander bzw. Regionen, in denen Sie es einsetzen.

Das geografische Koordinatensystem
Verwendet wird das geografische
Koordinatensystem ,, WGS-84.
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Videoformate

Aufnahmemedien

Aufnahmemedien und kompatible Formate

M Normale Aufnahme

SDXC
Video Format Klasse 10 Klasse 10 Klasse 10
UHS-1U3 UHS-1 U1
XAVC-L exFAT 3840%x2160 @] - -
1920x1080 O O O
1280x720 O O O
DVCAM exFAT O O O
O: Kompatibel
—: Nicht kompatibel
M Zeitlupe und Zeitraffer
SDXC
Video Format Klasse 10 Klasse 10 Klasse 10
UHS-1 U3 UHS-1 U1
XAVC-L exFAT 3840x2160 O - -
19201080 O @]

O: Kompatibel
—: Nicht kompatibel

Spezialaufnahmemodi und kompatible Formate

XAVC-L DVCAM
exFAT
Intervallaufnahme @] -
Kontinuierliche Clipaufnahme |O -
Aufnahme mit Bildpuffer O -
Zeitlupe und Zeitraffer O -
Simultanaufzeichnung in 2 O -
Einschiiben

O: Kompatibel
—: Nicht kompatibel

107



Maximale Aufnahmedauer fiir einen Clip

Aufzeichnungsformat Kontinuierliche Aufnahmedauer Maximale Aufnahmedauer bei
(je Medium) kontinuierlicher Aufzeichnung*

XAVC-L ca. 6 Stunden ca. 13 Stunden

DVCAM

* Maximale Aufnahmedauer bei kontinuierlicher Aufzeichnung unter Verwendung von Medien mit bis zu sechs Stunden
Aufnahme je Medium
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Ausgabeformate und Beschrankungen

Videoformate und Ausgangssignale

Ausgabeformate fiir den Anschluss SDI OUT

Einstellung fiir das Aufnahmeformat Einstellung fiir die SDI-| Ausgangssignal/
Ausgabe Konvertierungsmethode
Rec Format Rec Format >Video |Output Format >SDI | Ausgangssignal

>Frequency im
System-Menii

Format im System-
Menii

im Video-Menii

59.94 3840x2160P 1920x1080P (Level A) 19201080 59.94P Level-A
1920x1080P (Level B) 19201080 59.94P Level-B
1920x1080i 1920x1080 59.94i

1920x1080P 1920x1080P (Level A) 1920x1080 59.94P Level-A
1920x1080P (Level B) 1920x1080 59.94P Level-B
1920x1080i 19201080 59.94i
720x486i1 720%x486 59.94i

1920x1080i 1920x1080i 19201080 59.94i
720x486i 720x486 59.94i

1280x720P 1280x720P 1280x720 59.94P
720x486i 720x486 59.94i

720x486i 720x4861 720%x486 59.94i

29.97 3840x2160P 1920x1080PsF 19201080 29.97PsF

1920x1080P 1920x1080PsF 19201080 29.97PsF
720x486i 720x486 59.94i (PsF)

1280x720P 1280x720P 1280x720 59.94P (2-2RP)
720x486i 720x486 59.94i (PsF)

23.98 3840x2160P 1920x1080PsF 1920%x1080 23.98PsF
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)

1920x1080P 1920x1080PsF 1920x1080 23.98PsF
1920x1080i (2-3PD) 19201080 59.94i (2-3PD)
720x486i (2-3PD) 720x486 59.94i (2-3PD)

1280x720P 1280x720P (2-3PD) 1280x720 59.94P (2-3PD)

720x486i (2-3PD)

720x486 59.94i (2-3PD)
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Einstellung fiir das Aufnahmeformat Einstellung fiir die SDI-| Ausgangssignal/

Ausgabe Konvertierungsmethode
Rec Format Rec Format >Video |Output Format >SDI | Ausgangssignal
>Frequency im Format im System- |im Video-Menii
System-Menii Menii
50 3840x2160P 1920x1080P (Level A) 1920x1080 50P Level-A
1920x1080P (Level B) 1920x1080 50P Level-B
1920x1080i 1920x1080 50i
1920x1080P 1920x1080P (Level A) 1920x1080 50P Level-A
1920x1080P (Level B) 1920x1080 50P Level-B
1920x10801 19201080 50i
720x576i 720x576 50i
1920x10801 1920x1080i 19201080 50i
720x5761 720x576 50i
1280x720P 1280x720P 1280x720 50P
720x5761 720x576 50i
720x5761 720x576i 720x576 50i
25 3840x2160P 1920x1080PsF 1920x1080 25PsF
1920x1080P 1920x1080PsF 1920x1080 25PsF
720x576i 720x576 50i (PsF)
1280x720P 1280x720P 1280x720 50P (2-2RP)
720x576i 720x576 50i (PsF)

Ausgabeformate fiir den Anschluss HDMI OUT

Einstellung fiir das Aufnahmeformat Einstellung fiir die Ausgangssignal/
HDMI-Ausgabe Konvertierungsmethode
Rec Format Rec Format >Video |Output Format >HDMI | Ausgangssignal
>Frequency im Format im System- |im Video-Menii
System-Menii Menii
59.94 3840x2160P 3840x2160P 3840x2160 59.94P
1920x1080P 1920%x1080 59.94P
1920x10801 1920x1080 59.94i
1920x1080P 1920x1080P 1920%x1080 59.94P
1920x1080i 1920x1080 59.94i
720x4801 720x480 59.94i
1920x10801 1920x1080i 1920x1080 59.94i
720%x4801 720%x480 59.941
1280x720P 1280x720P 1280x720 59.94P
720%x4801 720x480 59.941
720x486i 720%x4801 720x480 59.941
720x480P 720x480 59.94P
29.97 3840x2160P 3840x2160P 3840x2160 29.97P
1920x1080i 1920x1080 59.94i (PsF)
1920x1080P 1920x10801 1920x1080 59.94i (PsF)
720%x4801 720x480 59.94i (PsF)
1280x720P 1280x720P 1280%720 59.94P (2-2RP)
720x480i 720x480 59.94i (PsF)
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Einstellung fiir das Aufnahmeformat

Einstellung fiir die

Ausgangssignal/

HDMI-Ausgabe Konvertierungsmethode
Rec Format Rec Format >Video |Output Format >HDMI | Ausgangssignal
>Frequency im Format im System- |im Video-Menii
System-Menii Menii
23.98 3840x2160P 3840x2160P 3840x2160 23.98P
1920x1080P 1920x1080 23.98P
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)
1920x1080P 1920x1080P 1920x1080 23.98P
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)
720x480i (2-3PD) 720%480 59.94i (2-3PD)
1280x720P 1280x720P (2-3PD) 1280x720 59.94P (2-3PD)
720x480i (2-3PD) 720%480 59.94i (2-3PD)
50 3840x2160P 3840x2160P 3840x2160 50P
1920x1080P 1920x1080 50P
1920x1080i 1920x1080 50i
1920x1080P 1920x1080P 1920x1080 50P
1920x10801 1920x1080 50i
720x576i 720x576 50i
1920x1080i 1920x1080i 19201080 50i
720x576i 720x576 50i
1280x720P 1280x720P 1280x720 50P
720x576i 720x576 50i
720x576i 720x5761 720x576 50i
720x576P 720x576 50P
25 3840x2160P 3840x2160P 3840x2160 25P
1920x1080i 1920x1080 50i (PsF)
1920x1080P 1920x1080i 1920x1080 50i (PsF)
720x576i 720x576 50i (PsF)
1280x720P 1280x720P 1280x720 50P (2-2RP)
720x5761 720%x576 50i (PsF)

« Falls die BildgroBe des Wiedergabeclips kleiner als die unter Output Format >SDI oder HDMI im Video-Menii
konfigurierte ist, wird das Videosignal nicht an diesem Anschluss ausgegeben.

Beschrankungen zwischen Aufnahmefunktionen

Recording-Menii S&Q Interval Picture Clip Continuous |Simul |Proxy Rec
Motion |Rec Cache Rec |Rec Rec
S&Q Motion - X x X X X
Interval Rec X - X X X x
Picture Cache Rec  |x X - X X X
Clip Continuous Rec |x X X - X @)
Simul Rec X X X X _ X
Proxy Rec X X X e} X _

O: unterstiitzt, x: nicht unterstiitzt
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Fehlerbehebung

Stromversorgung

Symptom

Ursache

Losung

Der Camcorder kann nicht
eingeschaltet werden.

Es ist kein Akku angebracht und es
liegt keine Spannung am Anschluss
DC IN an.

Bringen Sie einen Akku an (Seite 16) oder
schlieBen Sie das Gerit iiber ein Netzteil
(Seite 17) an die Netzstromversorgung an.

Der Akku ist vollstindig entladen.

Tauschen Sie den Akku gegen einen vollstandig
geladenen aus (Seite 16).

Die Stromversorgung wird
im Betrieb unterbrochen.

Der Akku ist entladen.

Tauschen Sie den Akku gegen einen vollstdndig
geladenen aus (Seite 16).

Der Akku ist sehr schnell
entladen.

Die Umgebungstemperatur ist sehr
niedrig.

Dies geschieht aufgrund der Akkueigenschaften
und ist kein Defekt.

Der Akku ist unzureichend geladen.

Laden Sie den Akku auf (Seite 16).

Falls der Akku schon bald entladen ist, nachdem
Sie ihn vollstindig geladen haben, hat er
moglicherweise das Ende seiner Lebensdauer
erreicht. Ersetzen Sie ihn durch einen neuen.

Aufnahme/Wiedergahe

Symptom

Ursache

Losung

Die Aufnahme beginnt
nicht, wenn Sie die
Aufnahmetaste driicken.

Die Speicherkarte ist schreibgeschiitzt.

Entfernen Sie den Schreibschutz oder ersetzen
Sie die Karte durch eine nicht geschiitzte
Speicherkarte.

Die Speicherkarte ist voll.

Karte durch neue mit ausreichend Speicherplatz
ersetzen.

Die Speicherkarte muss
wiederhergestellt werden.

Stellen Sie die Speicherkarte wieder her
(Seite 21).

Audioaufnahme ist nicht
moglich.

Der Audio-Aufnahmepegel ist auf sein
Minimum eingestellt.

Passen Sie den Audio-Aufnahmepegel an
(Seite 30).

Der aufgenommene Ton
ist verzerrt.

Der Audiopegel ist zu hoch.

Passen Sie den Audio-Aufnahmepegel an
(Seite 30).

Der aufgenommene Ton
besitzt einen hohen
Rauschpegel.

Der Audiopegel ist zu niedrig.

Passen Sie den Audio-Aufnahmepegel an
(Seite 30).

Wenn Sie ein externes Mikrofon auswihlen,
passen Sie zusitzlich die Einstellung INPUT
MIC Reference unter Audio Input im Audio-
Menii an (Seite 83).

Clips konnen nicht
wiedergegeben werden.

Der Clip wird gerade bearbeitet.

Je nach Status des Camcorders werden Fehler
oder Warnungen ggf. nicht angezeigt. Dies ist
keine Fehlfunktion.

Der Clip wird gerade auf einem
anderen Gerit aufgezeichnet.

Clips konnen nicht wiedergegeben werden, wenn
Sie Dateinamen oder Ordner geédndert haben oder
der Clip auf einem Computer in Verwendung ist.
Dies ist keine Fehlfunktion.
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Externe Gerate

Symptom

Losung

Der Camcorder wird vom
Computer nicht erkannt.

Trennen Sie das USB-Kabel vom Computer und schlieBen Sie es erneut ordnungsgemaf
an.

Trennen Sie das USB-Kabel vom Computer, starten Sie den Computer neu und fiihren Sie
die Schritte erneut in richtiger Reihenfolge durch.

Clips konnen nicht auf den
Computer geladen werden.

Trennen Sie das USB-Kabel vom Computer, starten Sie den Camcorder neu und schlieien
Sie ihn erneut an.

Um Clips auf den Computer zu laden, muss Anwendungssoftware installiert werden
(Seite 64).

WLAN-Verbindung

Die Kommunikation zwischen Camcorder und WLAN-Zugangspunkt oder Terminal-Geriit kann durch Hindernisse,

elektromagnetische Stérungen und die Betriebsumgebung (Wandmaterialien) in der Reichweite eingeschrinkt oder
ganz verhindert werden. Verlegen Sie den Camcorder in diesen Fillen an einen anderen Standort oder verringern Sie
seinen Abstand zum Zugangspunkt/Terminal-Gerit, und priifen Sie danach die Verbindung und den

Kommunikationsstatus.

Symptom

Losung

Ein Terminal-Gerit kann
nicht auf den Camcorder
zugreifen.

« Priifen Sie die WLAN-Verbindung (IP-Adresse usw.).

» Die Kommunikationseinstellungen von Zugangspunkt und Client sind moglicherweise
nicht aufeinander abgestimmt. Niheres finden Sie in der Bedienungsanleitung des
Zugangspunkts.

Anmeldung am
Camcorder ist nicht
moglich.

Priifen Sie den von Ihnen festgelegten Benutzernamen und das Passwort.

Die Web-Fernbedienung
wird nicht angezeigt.

Uberpriifen Sie die eingestellte IP-Adresse.
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Fehler-/Warnanzeigen

Der Camcorder informiert Sie mithilfe von Meldungen auf dem Sucherbildschirm, der Aufnahme-/Tally-
Anzeige und einem Warnton iiber Situationen, in denen eine Warn- oder Vorsichtsmeldung vorliegt oder
eine Funktionspriifung erforderlich ist.

Der Warnton wird iiber den integrierten Lautsprecher oder den an die Kopfhorerbuchse angeschlossenen
Kopfhorer ausgegeben.

Fehleranzeigen

Bei den folgenden Anzeigen wird der Camcorder angehalten.

Fehleranzeige auf Warnton Aufnahme-/ Ursache und Mafinahme

LCD-/ Tally-
Sucherbildschirm Anzeige
E + der Fehlercode Kontinuierl Schnell Weist auf eine Storung beim Camcorder hin. Die
ich blinkend Aufzeichnung wird angehalten, auch wenn im Sucher ,,@Rec*
angezeigt wird.
Schalten Sie den Camcorder aus, und priifen Sie die
angeschlossenen Gerite, Kabel und Datentriger. Falls der
Fehler nach dem erneuten Einschalten weiterhin auftritt,
wenden Sie sich an die zustindige Sony
Kundendienstvertretung.
(Wenn das Gerit nicht ausgeschaltet werden kann, indem Sie
den Schalter ON/STANDBY auf STANDBY schalten,
entnehmen Sie den Akku und/oder trennen Sie die DC IN-
Quelle.)
Je nach Status des Camcorders werden Fehler oder
Warnungen ggf. nicht angezeigt.
Warnanzeigen
Wenn eine der folgenden Meldungen auftritt, befolgen Sie die angezeigten Anweisungen.
Warnanzeige auf LCD-/ Warnton Aufnahme- Ursache und Mainahme
Sucherbildschirm [Tally-
Anzeige
Battery Near End Zeitweilig  Blinkt Der Akku ist bald leer.
Laden Sie den Akku schnellstmdoglich auf.
Battery End Kontinuier-  Schnell Der Akku ist leer. Die Aufnahme ist nicht moglich.
lich blinkend Halten Sie den Camcorder an, und wechseln Sie
den Akku.
Temperature High Zeitweilig  Blinkt Die Innentemperatur ist zu hoch.

Schalten Sie den Camcorder aus, und warten Sie,
bis die Temperatur sinkt.

Voltage Low Zeitweilig  Blinkt Die DC IN-Spannung ist zu niedrig (Stufe 1).
Priifen Sie die Stromversorgung.
Insufficient Voltage Kontinuier-  Schnell Die DC IN-Spannung ist zu niedrig (Stufe 2). Die
lich blinkend Aufnahme ist nicht moglich.

Schliefen Sie eine andere Stromversorgung an.
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Warnanzeige auf LCD-/ Warnton Aufnahme- Ursache und Mainahme

Sucherbildschirm [Tally-
Anzeige

Media Near Full Zeitweilig  Blinkt Auf der Speicherkarte ist nicht mehr genug
Speicherplatz frei.

Ersetzen Sie sie schnellstmoglich durch eine
andere.

Media Full Kontinuier-  Schnell Auf der Speicherkarte ist kein Speicherplatz mehr

lich blinkend frei. Die Aufnahme sowie das Kopieren und Teilen
von Clips sind nicht moglich.
Ersetzen Sie die Speicherkarte.

Clips Near Full Zeitweilig  Blinkt Die Anzahl weiterer Clips, die auf der
Speicherkarte aufgezeichnet werden konnen, sinkt
ab.

Ersetzen Sie sie schnellstmoglich durch eine
andere.

Clips Full Kontinuier-  Schnell Die Hochstanzahl von Clips, die auf einer

lich blinkend Speicherkarte aufgezeichnet werden kénnen, ist
erreicht.
Es ist nicht moglich, weitere Clips aufzunehmen
oder zu kopieren. Ersetzen Sie die Speicherkarte.

Last Clip Recording Zeitweilig  Blinkt Der gegenwiirtig aufgenommene Clip ist der letzte,
der aufgezeichnet werden kann, da die
Hochstanzahl Clips erreicht wurde.

Bereiten Sie eine neue Speicherkarte vor.

Media(A) Near Full" Zeitweilig  Blinkt Bei Verwendung der Funktion zur gleichzeitigen
Aufnahme

Media(A) Full” Kontinuier- ~ Schnell Bei Verwendung der Funktion zur gleichzeitigen

lich blinkend Aufnahme

Media(A) Clips Near Full) Zeitweilig  Blinkt Bei Verwendung der Funktion zur gleichzeitigen
Aufnahme

Media(A) Clips Full" Kontinuier-  Schnell Bei Verwendung der Funktion zur gleichzeitigen

lich blinkend Aufnahme

Media(A) Last Clip Rec!) Zeitweilig  Blinkt Bei Verwendung der Funktion zur gleichzeitigen
Aufnahme

1)..Media(B)* fiir die Karte in Einschub B.

Warn- und Funktionsmeldungen

Auf dem Bildschirm konnen folgende Warn- und Funktionsmeldungen erscheinen. Befolgen Sie die
angezeigten Anweisungen, um das Problem zu beheben.

Meldung im Sucher Ursache und Manahme

Battery Error Es wurde ein Fehler beim Akkusatz festgestellt.

Please Change Battery Der Akku muss dann durch einen normalen Akku ersetzt werden.

Unknown Media(A)" Eine partitionierte Speicherkarte oder eine, die eine hohere Anzahl

Please Change aufgezeichneter Clips enthilt als fiir diesen Camcorder zuléssig ist, ist
eingesetzt.

Die Karte kann nicht in diesem Camcorder verwendet werden und muss
ersetzt werden.

Cannot Use Media(A)" Es wurde eine Speicherkarte mit fremdem Dateisystem oder eine
Unsupported File System unformatierte Speicherkarte eingesetzt.
Die Karte kann nicht in diesem Camcorder verwendet werden und muss
ersetzt oder vom Camcorder formatiert werden.
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Meldung im Sucher

Ursache und Mafinahme

Media Error
Media(A) Needs to be Restored!

Ein Speicherkarten-Fehler ist aufgetreten. Die Karte muss
wiederhergestellt werden.
Stellen Sie die Speicherkarte wieder her.

Media Error
Cannot Record to Media(A)l)

Die Speicherkarte ist moglicherweise defekt und kann nicht mehr fiir die
Aufzeichnung verwendet werden.

Die Wiedergabe ist ggf. moglich. Es wird empfohlen, eine Kopie zu
erstellen und die Speicherkarte zu ersetzen.

Media Error
Cannot Use Media(A)] )

Die Speicherkarte ist moglicherweise defekt und kann nicht mehr fiir
Aufzeichnung oder Wiedergabe verwendet werden.

Die Karte kann nicht in diesem Camcorder verwendet werden und muss
ersetzt werden.

Media(A) Error!
Recording Halted
Playback Halted

Die Aufzeichnung und die Wiedergabe wurden angehalten, weil beim
Zugriff auf die Speicherkarte ein Fehler aufgetreten ist.
Sollte das Problem fortbestehen, muss die Speicherkarte ersetzt werden.

Media Reached Rewriting Limit
Change Media(A)”

Die Speicherkarte hat das Ende ihrer Lebensdauer erreicht.

Erstellen Sie eine Sicherheitskopie, und ersetzen Sie die Karte. Wenn Sie
diese Karte weiterhin verwenden, funktionieren Aufzeichnung bzw.
Wiedergabe eventuell nicht ordnungsgemaf.

Einzelheiten dazu finden Sie in der Bedienungsanleitung der
Speicherkarte.

Invalid setting value was reset:

Media/Clip Naming/Camera Position

Please save All File again

Die Einstellung fiir das Clip Naming-Format wurde zuriickgesetzt, weil
eine ungiiltige ALL-Datei geladen wurde.

Konfigurieren Sie die gewiinschten Formateinstellungen, und versuchen
Sie, die ALL-Datei erneut zu speichern.

The specified address is invalid.

Die angegebene Adresse ist ungiiltig.
Vergewissern Sie sich, dass die Einstellung korrekt ist.

Failed Dieser Fehler tritt moglicherweise auf, wenn DHCP auf On gesetzt ist
und keine Adresse bezogen werden kann.
Priifen Sie die Einstellungen beziiglich des DHCP-Servers.
<SSID>Not found. Es wurde kein Netzwerk (Zugangspunkt) mit der angegebenen <SSID>

gefunden.
Vergewissern Sie sich, dass die Einstellung korrekt ist.

<SSID>Authentication Failed

Die Authentifizierung beim Netzwerk (Zugangspunkt) mit der
angegebenen <SSID> ist fehlgeschlagen.

Vergewissern Sie sich, dass das Passwort und andere Einstellungen
korrekt sind.

1), Media(B)* fiir die Karte in Einschub B.
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Blockschaltbilder

Erginzende Informationen siehe unter ,, Festlegen der aufzunehmenden Audiosignale “ (Seite 30) und

,,Liste der Elemente im Einstellmenii* (Seite 73).

Audio Input (CH1&2)

INPUT1

Internal
MIC

Il‘r—

|
Q
|
- —

[CH2 EXT Input Select]

INPUT1
INPUT2

14 N
| |
I
| |
| |
- -7 - TN TN |
| 1 I I | 1 1 [ !
L (%)L I [ !
AT o TR DAY [
I o [ I M I P !
I I | I | | I I | [ !
I I I I | I | | | (I !
I o I I I I I I 1ol “
1 1 1 1 [ 1 1 1 1 [
- - - - | Lo |
<CH1 INPUT SELECT> [CH1 Wind Filter] <CH1 LEVEL CONTROL> <CH1 INPUT LEVEL> | | |
INT on AUTO 0-10 | |
EXT off MAN | 1|
MI SHOE | o |
; M| 1
I . “
l (.
J— J— - J— | [ !
\ 14 \ 14 I \ | Lo |
o o I ro Lo I
O O L (%)L _ — 1
(I I I I | % Lo I
| o o [ P Lo |
| I | | | | | I | Lo |
| | 1 | 1 | | | | Pl |
| | | | | | | | | Pl |
| | | | | | | | |
-__ -__ - __ -__ \__/ ‘___
<CH2 INPUT SELECT> [CH2 Wind Filter] <CH2 LEVEL CONTROL> <CH2 INPUT LEVEL> [Limiter Mode] [CH182 AGC Mode]
INT On AUTO 0-10 Off, —6dB Mono
EXT off MAN —9dB, —12dB Stereo
MI SHOE —15dB, —17dB

°1

-
[Color Bar]

[1kHz Tone on Color Bar]

eines oder beides
aktiviert
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Audio Input (CH3&4)

4
|
|
| |
| |
4 A T TN ¢ N | |
FF - =
o | I I | I I | [ ! ! N
t t L ()L 1 [ !
LTI 0\ A A [ A
INPUTA | o o [ N [ _ _ |
I o o I I I I . ! ! |
INPUT2 I o o I I I I [ ! ! |
I (I o I I I I P | ! \
| | | | I | | | I [ | “ |
- - - - o
[CH3 Input Select] ~ [CH3 Wind Filter] ~ [CH3 Level Control] [CH3 Input Level] ! | | ] | I
Internal L off On Auto 0-99 | | | |
MIC L 4 INPUT1 off Manual 1 [
R Internal MIC | o | I !
Shoe CH1 ) ! 1 | | |
j | | I
| [ | |
| | | |
_ _ _ | | 1 | | |
14 N 14 N | Pl | | |
| | | | | | | Pl | | |
'
t . 1 ® 1 _ — 1 S
o) 4, o o I I . I O AT
[ [ I A ! Lo I X I
| | | | | | | | | )l | | |
| | | | | | | | | ;o | | |
| | | | | | | | | P! | | |
| | | | | | | | | |
- - - - [ .
[CH4 Input Select]  [CH4 Wind Filter] ~ [CH4 Level Control] [CH4 Input Level] [Limiter Mode] [CH3&4 AGC Mode] [Color Bar]
Off On Auto 0-99 Off, —6dB Mono [1kHz Tone on Color Bar]
INPUT1 off Manual —9dB, —12dB Stereo eines oder beides
INPUT2 —15dB, —17dB aktiviert
Internal MIC
Shoe CH2
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CH1
CH2

!

:
A 4

CH3

CH4

Audio Output

v

A 4

-
7/
A

&

9

L)
[HDMI Output CH]
CH1/CH2,CH3/CH4 M - =N
\ I\ﬁ -/

[Analog Output CH]
CH1/CH2,CH3/CH4

[E——-
[Monitor CH]
CH1,CH2,CH3,CH4,
CH1/CH2,CH3/CH4,

MIX ALL

SDI OUT

| —
.

HDMI OUT

| —

N

Analog OUT

| —

- — =

[Headphone Out]
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Technische Daten

Allgemeines

Gewicht

ca. 2,3 kg (nur Gehiuse)

ca. 2,8 kg (mit Gegenlichtblende (1),
Augenmuschel (1), Akku BP-U30 (1),
Speicherkarte (1))

Abmessungen (Breite / Hohe / Tiefe)

190,0 mm x 202,0 mm X 419,7 mm
Maximalabmessungen. Die Tiefe bezeichnet
die Linge von der Vorderseite der
Gegenlichtblende bis zur groien
Augenmuschel.

Aufzeichnungsformat (Video)

XAVC Long

XAVC-L QFHD-Modus: VBR, max. 150 Mbit/s,
MPEG-4 H.264/AVC

XAVC-L HD 50-Modus: VBR, max. 50 Mbit/s,
MPEG-4 H.264/AVC

XAVC-L HD 35-Modus: VBR, max. 35 Mbit/s,
MPEG-4 H.264/AVC

XAVC-L HD 25-Modus: VBR, max. 25 Mbit/s,
MPEG-4 H.264/AVC

DVCAM
CBR, 25 Mbit/s

Proxy

AVC/H.264 Main Profile, 4:2:0 Long GOP, VBR

1920%x1080/9 Mbit/s, 1280x720/9 Mbit/s,
1280x720/6 Mbit/s, 640x360/3 Mbit/s,
480x270/1 Mbit/s, 480x270/500 kbit/s

Betriebsspannung
12V DC (11 V bis 16,5 V)

Leistungsaufnahme

ca.24 W
bei Aufnahmen mit ausgeschaltetem LCD-
Bildschirm, eingeschaltetem Sucher, kein
externes Gerit angeschlossen
ca.36 W
bei Aufnahmen mit eingeschaltetem LCD-
Bildschirm, eingeschaltetem Sucher, mit
HD SDI, HDMI und externem Gerit
ca.36 W
beim Kopieren auf ein USB-Medium

Aufzeichnungsformat (Audio)
XAVC Long

XAVC-L-Modus: LPCM, 24 Bit, 48 kHz,
4 Kanile

DVCAM
LPCM, 16 Bit, 48 kHz, 4 Kaniile

Proxy
AAC-LC, 128 kbit/s, 2 Kanile

Betriebstemperatur
0 °C bis 40 °C

Lagertemperatur
—20 °C bis +60 °C

Betriebszeit im Dauerbetrieb

Bei Verwendung des Akkus BP-U90:
ca. 3 Stunden 15 Minuten

Bei Verwendung des Akkus BP-U60:
ca. 2 Stunden 10 Minuten

Bei Verwendung des Akkus BP-U30:
ca. 1 Stunde 5 Minuten

(bei Aufnahmen mit ausgeschaltetem LCD-
Bildschirm, eingeschaltetem Sucher, kein
externes Gerit angeschlossen)

Bildrate bei der Aufzeichnung

XAVC Long

XAVC-L QFHD 150-Modus: 3840x2160/
59.94P, 50P, 29.97P, 23.98P, 25P

XAVC-L HD 50-Modus: 1920x1080/59.94P,
50P, 59.94i, 50i, 29.97P, 23.98P, 25P
1280%x720/59.94P, 50P

XAVC-L HD 35-Modus: 1920x1080/59.94P,
50P, 59.94i, 50i, 29.97P, 23.98P, 25P

XAVC-L HD 25-Modus: 1920x1080/59.94i, 50i

DVCAM
720x480/59.94i, 29.97PsF
720x576/50i, 25PsF




Aufnahme-/Wiedergabezeit

XAVC Long
XAVC-L QFHD 150-Modus
Bei Verwendung einer 128-GB-Speicherkarte:
ca. 88 Minuten
XAVC-L HD 50-Modus
Bei Verwendung einer 128-GB-Speicherkarte:
ca. 240 Minuten
XAVC-L HD 35-Modus
Bei Verwendung einer 128-GB-Speicherkarte:
ca. 320 Minuten
XAVC-L 25-Modus
Bei Verwendung einer 128-GB-Speicherkarte:
ca. 445 Minuten

DVCAM
Bei Verwendung einer 128-GB-Speicherkarte:
ca. 425 Minuten

* Die Aufnahme- bzw. Wiedergabezeit kann
aufgrund der Nutzungsbedingungen und
Speichereigenschaften schwanken.

Objektiv

Objektivgewinde
Fest

Zoomverhiltnis
25%

Brennweite

3,7 mm bis 92,5 mm
(35-mm-Aquivalent zu 28,8 mm bis 720 mm)

Fokusbereich

AF/MF/Full MF auswiéhlbar

800 mm bis e (Makro OFF)

10 mm bis e (Makro ON, Weitwinkel)
800 mm bis e (Makro ON, Tele)

Kamera

Bildgebungsgeriit
CMOS-Bildsensor ExmorR 3, 1/3 Zoll

Effektive Bildelemente
3840 (H) x 2160 (V)

Optisches System

Prismensystem, F1.6

Eingebaute Filter

ND-Filter

CLEAR: Loschen

1: 1/4ND

2: 1/16ND

3: 1/64ND

Linear variabler ND-Filter (ca. 1/4 ND bis 1/128
ND)

Empfindlichkeit (2000 Ix, 89,9% Reflexion)
F11 (typisch, 1920x1080/59.94P,
Hochempfindlichkeitsmodus)

F12 (typisch, 1920x1080/50P,
Hochempfindlichkeitsmodus)

Mindestbeleuchtung
0,01 Ix (typisch, 1920x1080/59.941) (F1.6,
+30 dB Hochempfindlichkeitsmodus, mit
Akkumulation von 64 Vollbildern)

Rauschverhiiltnis
57 dB (Y) (typisch)

Horizontale Auflosung
Mindestens 2000 Fernsehzeilen (Modus
3840x2160P)
Mindestens 1000 Fernsehzeilen (Modus
1920x1080P)

Verschlussgeschwindigkeit
1/24 bis 1/8000 s

Zeitlupe und Zeitraffer
XAVC Long

Iris 2160P: 1 bis 60 fps
automatisch/manuell auswéhlbar 1080P: 1 bis 60 fps
F1.6 bis F11 und C (Schlieen) 720P: 1 bis 60 fps
Bildstabilisierung WeiBabgleich
ON/OFF auswihlbar, Shift Lens Preset-Modus (3200K)
Filterdurchmesser Memory A-Modus, Memory B-Modus, ATW-

M82 mm, 0,75 mm Steigung

Makro
ON/OFF auswihlbar
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Modus

Gain
-3,0,3,6,9, 12, 15, 18 dB, 30 dB (Turbo Gain
aktiviert), AGC

Gammakurve
Wihlbar




WLAN

Anzeige

Unterstiitzte Standards
IEEE 802.11a/b/g/n/ac

Frequenzbiinder

2,4 GHz
5,2/5,3/5,6 GHz (nur PXW-Z190V)

Sicherheit

WEP/WPA-PSK/WPA2-PSK
konform zu NFC Forum Type 3 Tag

Ein-/Ausgédnge

Audioeingang
XLR-Typ, 3-polig (2), Buchse, LINE/MIC/
MIC+48V umschaltbar
LINE: +4dBu/0dBu/-3dBu (/EBUL)/ 10 kQ
MIC: -80dBu bis —30dBu / 3 kQ
(Referenzeingangspegel 0 dBu=0,775 Vrms)

Audioausgang
Multi/Micro USB

SDI-Ausgang
BNC-Typ (1), 3G/HD/SD auswihlbar

Timecode-Eingang
BNC-Typ (1), umschaltbar mit Anschluss TC
ouT
0,5V bis 18 Vp-p, 3,3 kQ

Timecode-Ausgang

BNC-Typ (1), umschaltbar mit Anschluss TC IN
1,0 Vp-p, 75 Q

USB-Anschluss

Multi/Micro USB (1)
Host: USB 3.0/2.0 Typ A (1), USB 2.0 Typ A
(1) (durch zukiinftiges Upgrade unterstiitzt)

Kopfhorerausgang

Stereominibuchse (1)
—16 dBu, 16 Q

Lautsprecherausgang

Mono
Ausgangsleistung: 500 mW

Gleichstromeingang

Gleichstrombuchse

HDMI-Ausgabe
HDMI-Anschluss (Typ A)

Anschluss REMOTE
Stereo-Mini-Minibuchse (2,5 mm)

Anschluss fiir verkabeltes LAN

RJ-45 (1), I000BASE-T, 100BASE-T, 10BASE-
T (durch zukiinftiges Upgrade unterstiitzt)
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Sucher
Bildschirmgrofe: 1,0 cm (0,39 Zoll)
Effektive Pixelanzahl: ca. 2,36 Millionen Punkte

LCD-Bildschirm

Bildschirmgrofe: 8,8 cm (3,5 Zoll)
Effektive Pixelanzahl: ca. 1,56 Millionen Punkte

Internes Mikrofon

Internes Mikrofon

Ungerichtetes Stereo-Elektret-
Kondensatormikrofon

Medieneinschiibe

Typ
SD (2), SD/MS (1)

Im Lieferumfang enthaltenes
Zubehor

Akku (1)

Netzteil/Ladegerit (1)

USB-Kabel (1)

Gegenlichtblende (1)

Grofie Augenmuschel (1)

CD-ROM mit Bedienungsanleitung (1)
Vor Verwendung dieses Geriits (1)
Garantieunterlagen (1)

Software-Downloads

Wenn das Gerit mit einer PC-Verbindung
verwendet wird, laden Sie benétigte Treiber,
Plugins und Anwendungssoftware von der
folgenden Website herunter.

Sony-Website fiir professionelle Produkte:
USA http://pro.sony.com
Kanada http://www.sonybiz.ca
Lateinamerika http://sonypro-latin.com
Europa, Naher Osten und Afrika
http://www.pro.sony.eu
Japan http://www.sonybsc.com
Asiatisch-pazifischer Raum
http://pro.sony-asia.com

Korea http://bp.sony.co.kr



China

http://pro.sony.com.cn

Die Daten zu den Aufnahmen werden zwar auf
mehrere Dateien und Ordner verteilt gespeichert,
aber mit der dedizierten Anwendungssoftware
konnen Sie die Clips problemlos handhaben,
ohne die Daten- und Verzeichnisstruktur zu
beriicksichtigen.

Wenn Sie Funktionen wie das Kopieren von Clips auf
einer Speicherkarte mit dem Explorer (Windows) oder
Finder (Macintosh) ausfiihren, gehen die in den Clips
enthaltenen erginzenden Daten moglicherweise
verloren.

Bauart und Spezifikationen konnen ohne
Vorankiindigung geidndert werden.
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Hinweise

¢ Fiihren Sie immer eine Probeaufnahme aus,
und bestitigen Sie, dass die Aufnahme
erfolgreich war.

SONY KANN KEINE HAFTUNG FUR
SCHADEN JEDER ART,
EINSCHLIESSLICH ABER NICHT
BEGRENZT AUF KOMPENSATION ODER
ERSTATTUNG, AUFGRUND VON
FEHLFUNKTION DIESES GERATS ODER
SEINER DATENTRAGER, EXTERNEN
SPEICHERSYSTEMEN ODER
JEGLICHEN ANDEREN
DATENGRAGERN ODER
SPEICHERSYSTEMEN ZUR AUFNAHME
VON INHALTEN JEDER ART
UBERNEHMEN.

Bestitigen Sie vor dem Gebrauch immer, dass
das Gerit richtig arbeitet. SONY KANN
KEINE HAFTUNG FUR SCHADEN JEDER
ART, EINSCHLIESSLICH ABER NICHT
BEGRENZT AUF KOMPENSATION ODER
ERSTATTUNG, AUFGRUND VON
VERLUST VON AKTUELLEN ODER
ERWARTETEN PROFITEN DURCH
FEHLFUNKTION DIESES GERATS ODER
AUS JEGLICHEM ANDEREN GRUND,
ENTWEDER WAHREND DER
GARANTIEFRIST ODER NACH ABLAUF
DER GARANTIEFRIST, UBERNEHMEN.
SONY KANN KEINE HAFTUNG FUR
ANSPRUCHE JEDER ART VON DEN
BENUTZERN DIESES GERATS ODER VON
DRITTER SEITE UBERNEHMEN.

SONY KANN KEINE HAFTUNG FUR
VERLUST, RETTUNG ODER
WIEDERHERSTELLUNG VON DATEN IM
INTERNEN SPEICHERSYSTEM, AUF
AUFZEICHNUNGSMEDIEN, EXTERNEN
SPEICHERSYSTEMEN ODER ANDEREN
MEDIEN BZW. SPEICHERSYSTEMEN
UBERNEHMEN.

SONY KANN KEINE HAFTUNG FUR DIE
BEENDIGUNG ODER EINSTELLUNG
VON DIENSTLEISTUNGEN BEZUGLICH
DIESES GERATS GLEICH AUS
WELCHEM GRUND UBERNEHMEN.




Marken

* XDCAM ist eine Marke der Sony Corporation.

* XAVC und sind eingetragene Marken
der Sony Corporation.

¢ Microsoft, Windows, Windows Vista und

Windows Media sind Marken oder

eingetragene Marken der amerikanischen

Microsoft Corporation in den USA und anderen

Léndern.

Mac und Mac OS sind eingetragene Marken

von Apple Inc. in den USA und anderen

Léndern.

Die Begriffe HDMI, HDMI High-Definition

Multimedia Interface sowie das HDMI-Logo

sind Marken oder eingetragene Marken von

HDMI Licensing Administrator, Inc. in den

Vereinigten Staaten und anderen Landern.

Adobe, das Adobe-Logo und Adobe Acrobat

sind eingetragene Marken oder Marken von

Adobe Systems Incorporated in den USA und/

oder anderen Lindern.

,Memory Stick®, ,,Memory Stick Duo®,

,,Memory Stick PRO Duo*, ,,Catalyst Browse*,

,,Content Browser Mobile* und das ,,Content

Browser Mobile*“-Logo sind Marken oder

eingetragene Marken der Sony Corporation.

Das SDXC-Logo ist eine Marke von SD-3C,

LLC.

i0S ist eine eingetragene Marke oder Marke

von Cisco Systems, Inc. und/oder seinen

Tochtergesellschaften in den USA und

bestimmten anderen Lindern.

Android, Google Play sind Marken von Google

Inc.

Wi-Fi, das Wi-Fi-Logo und Wi-Fi

PROTECTED SETUP sind Marken oder

eingetragene Marken der Wi-Fi Alliance.

» Die N-Markierung ist eine Marke oder
eingetragene Marke von NFC Forum, Inc. in
den USA und anderen Lindern.

Alle weiteren Firmen- und Produktnamen sind

eingetragene Marken oder Marken ihrer

jeweiligen Eigentiimer. Geschiitzte Objekte sind
in diesem Dokument nicht durch ™ oder ®
gekennzeichnet.

Lizenzen

DIESES PRODUKT WIRD UNTER DER AVC
PATENT PORTFOLIO LICENSE FUR DEN
PRIVATEN UND NICHT KOMMERZIELLEN
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GEBRAUCH DURCH DEN BENUTZER
LIZENZIERT, UND ZWAR ZUM

(i) CODIEREN VON VIDEODATEN IN
UBEREINSTIMMUNG MIT DEM AVC-
STANDARD (,,AVC-VIDEO*“) UND/ODER
(ii) DECODIEREN VON AVC-VIDEODATEN,
DIE VON EINEM BENUTZER IM PRIVATEN
UND NICHT KOMMERZIELLEN RAHMEN
CODIERT WURDEN UND/ODER VON
EINEM VIDEO-ANBIETER STAMMEN, DER
UBER EINE LIZENZ ZUM ANBIETEN VON
AVC-VIDEOS VERFUGT.

FUR JEGLICHE ANDERE VERWENDUNG
WIRD KEINE LIZENZ ERTEILT, DIES
WEDER AUSDRUCKLICH NOCH IMPLIZIT.
WEITERE INFORMATIONEN SIND BEI
MPEG LA, L.L.C., ERHALTLICH. SIEHE
HTTP://WWW .MPEGLA.COM

Auf der Grundlage von Lizenzvertrigen
zwischen Sony und den Software-
Rechteinhabern verwendet dieses Produkt freie
Software. Um den Anforderungen der Software-
Rechteinhaber gerecht zu werden ist Sony
verpflichtet, Sie iiber den Inhalt dieser Lizenzen
informieren.

Zugriff auf Software, fiir welche die GPL/LGPL
gilt

Dieses Produkt verwendet Software, fiir welche
die GPL/LGPL gilt. Dies bedeutet, dass Sie
berechtigt sind, auf Quellcode fiir diese
Softwareprogramme unter den Bedingungen von
GPL/LGPL zuzugreifen, ihn zu modifizieren und
zu verbreiten.

Der Quellcode ist im Internet verfiigbar.
Verwenden Sie die folgende URL, und befolgen
Sie die Anweisungen zum Herunterladen.
http://www.sony.net/Products/Linux/common/
search.html

Bitte sehen Sie nach Moglichkeit davon ab, sich
beziiglich des Inhalts des Quellcodes mit uns in
Verbindung zu setzen.

Lizenzen (in englischer Sprache) sind im internen
Speicher Ihres Gerits gespeichert.

Stellen Sie eine Massenspeicherverbindung
zwischen dem Gerit und einem Computer her,
um die Lizenzen im Ordner ,,PMHOME"* -

L LICENSE® zu lesen.
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Auto Black Balance 77
Auto Exposure 75
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Color Bars 76
Content Browser Mobile 48
Customize View 91

D

Datum und Uhrzeit 18

Delete Clip 91

Detail (HD-Modus) 81

Detail (SD-Modus) 82

Detail (QFHD) 81

Digitales Tele 12

Display Clip Properties 59, 91
Display On/Off 87

Down Converter 85

E

Einstellmenii 67, 69, 73
Externer Monitor 63
Externes Audiogerit 31

F

Fehleranzeigen 114
File-Menii 93

Flicker Reduce 76
Fokuslupe 26
Fokussierring 25

Format 26, 40

Format Media 92
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Belegbare Tasten 36 Gamma 80

Gamma-Anzeigeassistent 12, 41
Gammakorrektur 80

Benutzerdateien 42, 93
Bildstabilisierung 33
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Blendenring 27 Gesichtserkennung-AF 11, 34
GPS 45, 98, 105
C
Camera-Menii 74 H
Clip 24, 57,58, 64,93 HDD 65
Clip Continuous Rec 90 HDMI TC Out 89
Clipname 24 HDR 41
Clock Set 98 HLG 41

Codec 26 Hours Meter 98
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| Output On/Off 85

Inhaltsmarkierung 61 P

Internes Mikrofon 7, 31, 83
Paint-Menii 77

K Peaking 86

Knee 80 Proxy-Aufnahme 46
Kondensation 102 Proxy-Aufnahmemodus 91
Kontinuierliches Aufzeichnen 23 R

Kopfhorerbuchse 26
Rec Format 96

L Recording-Menii 89
Ladegerit 16 Regler SEL/SET 69
LAN 48 s
Language 98
LCD Setting 85 S&Q Motion 89
LCD/VF-Menii 85 Schalter FOCUS 25
LCD-Bildschirm 11 Schalter GAIN 27
Lock/Unlock Clip 91 Schalter INPUT1 30

Schalter INPUT2 30
M Schalter IRIS 27
Maintenance 83 Schalter WHT BAL 29
Makro-Modus 26 Schulterriemen 9
Manuelle Blende 27 SDHC-Speicherkarten 42, 46
Marker 86, 87 SD-Karten 42, 46
Matrix 83 SD-Speicherkarten 42, 46
Media Full 21 SDXC-Speicherkarten 20, 42, 46
Media Near Full 21 Shutter 75
Media-Menii 92 Simul Rec 90
Memory A-Modus 29 Skin Detail 82
Memory B-Modus 29 Software 64, 122
MF-Modus 25 Speicherkarteneinschub 9, 20
Miniaturbildanzeige 56 Stationsmodus 13, 49
Multi/Micro USB-Anschluss 8, 63, 64 SteadyShot 33

Sucher 11
N Dioptrienausgleichsregler 19
ND Filter 74 Systemfrequenz 12, 26
ND-Filter 28 System-Menii 96
Network-Menii 94 Szenendatei 12,42, 94
Netzsteckdose 17 T
Netzteil 17
NFC 6, 48 Taste MENU 69
Nichtlinearer Schnitt 64 Taste PUSH (Entriegelung der

Gegenlichtblende) 18

(o) Taste SLOT SELECT 20
Objektiv 103 Taste WB SET 29
Output Display 85 TC/UB-Menii 89
Output Format 85 Tele 24

Thumbnail View 91
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Thumbnail-Menii 91 Zoomhebel 24

Timecode 33, 59, 89 Zoomhebel am Griff 24
Zoomring 25

V) Zugangspunktmodus 12, 48, 95

Uhr 18

Update Media 92

USB-Kabel 64

USB-Medium 65, 92
USB-WLAN-Modul 48

User-Bits 33

User-Meni 67, 71,73

Users Bit 89

UTC 18

UTILITY SD/MS-Einschub 8, 42, 46

\'}

Variabler Modus 28

Verbleibende Aufnahmezeit 14, 21, 108

Verschlussautomatik 27, 76

Version 99

Verstiarkung 27, 74

Verwenden des Camcorders im Ausland
100

VF Setting 85

Video Light Set 77

Videoformat 109

Video-Menii 85

VOLUME-Tasten 26

Voreinstellungsmodus 28, 29

w

Warn- und Funktionsmeldungen 115
Warnanzeigen 114
Web-Fernbedienung 54
WeiBlabgleich 29
Weitwinkelbereich 24

Werkseitig installierter Akku 103
White 78

White Clip 80

White Switch 78

WPS 49, 50

Z

Zebra 87

Zeitdaten 33
Zeitzone 18

Zoom 24

Zoom am Griff 24, 76
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